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KaAwg nABate oto Photoshop CS6!

To Photoshop cival éva mpoypaupa emeepyaciac ekoOvag. Oewpeital
ETTAYYEAUATIKO EQYAAEIO KAl XONOIUOTTOIEITAI ATTO TO PWTOYPAPEIO TNG YEITOVIAG

pOC Péxpl Ta peyaAa studios Tou Hollywood. KaBnuepiva PAETTouue TO

ATTOTEAEOPATA TOL TTAVTOL, O TIEPIOSIKA, epnuUEQiISES, agiceg OTO SPOUO.
IxebOV OAol ol elkovICOUEVOI ExoLy “peTovoaploTe’” oTo Photoshop amod kartolo
ypaopiota. To iblo PéPaia Oa eiote oe BEon va KAVETE KAl £0€G Ot Aiya

paenuaral

H ékSoon tTnv otmoia Ba SovAtéwoupe eival n CSé, Tou cival n 13n amod TNV apxn
A&ITovpyiag Touv TPoyEAuUatog. To Photoshop avhkel oce pia oIKoyéveld
TpoypauudTtv TNG Adobe® mouv ovoudletal Adobe Creative Suite «kal
epIAapPavel TTooypduPaTa omrwe 1o Photoshop, 1o lllustrator, To InDesign, 1o
Flash, To Dreamweaver, To Adobe Premiere, To Fireworks, To After Effects, 1o
Bridge k.a. To Photoshop éxel TTOAAEG TTAPAAAQYEC pE AYOTEPA 1) TTEQICTOTEQT
XOPOKTNPIOTIKA, AVAAOYd AV AVAPEPETAl O€ EQACITEXVEC N ETTAYYEAUATIES, YIA
mapdadelyua 1o Photoshop Extended, 1o Photoshop Express kTA. To Photoshop
gival éva TPOYPAUPA CLURATO pE OAA TA YVWOTA AETOLPEYIKA ILOTAUATA
LTTOAOYIOT@Y, CLVETTG “Tpéxel” oe Windows, oe Macindows, akoun Kal o€

Linux kGvovTag Xpnon Tou TTpoypduuaToc Wine.

Pixels kat AvaAuon €1kovag

Ta pIkEOTEPA SuvaTd OTOIXEISN KOUMATIA ammd TA OToia CoLVOETOVTAl Ol

elkOveg ovopalovtal pixels. Mmopobue va Ta S0LUE AVOIYOvTag did

Y€ ALTO TO PABNUA:

PpwTOYPpAPia oto Photoshop kal KAvVovTAG TO HeYaAALTEQO SuvaTd zoom in
Pixels kai AvaAvon . ) . . i ) . )
EIKOVAC weeeeeeeeeeeeeees 2 mavw TNG (Ekova 1). Ta pixels eival auTd Ta PIKPA TETPAYWVAKIA TTOL PAETTOLE
XPWUATIKG HOVTEAQ.......4 oav yneideg Tave otny elkova. H ALEn pixel Tpoépxetal ammod TG Aé€eig picture

MepiBAMov epyaoiag...6 (eikdva) kal element (oToixeio). Ta pixels Sev ummopoLY va aANafouy ueyebog,

TO PEYEDOG TOLC gival OTABEPA KAl §€ UTTOPOLPE VA ETTEUPOLIE OE ALTA.

AKOUN, éva AAAO PaoIKO XAPAKTNPIOTIKO TV pixels eivar o1 opilovv TNV

avaivon NG eikovag. H avaluon piag eikdvag vrtoAoyiletal ye paon Tov TOTTO:

AvaAvon eikovag = MAaTog (width) eikovag x 'Yyocg (height) eikdvacg
o¢ pixels o¢ pixels o¢ pixels

‘Oco XaunAoTEPN gival N avaAvon pIag eikovag, dnAadr 6co HIKpOTEPOC eivall
O APIBUOG TV pixels TToL CLVBETOLY TNV EIKOVA, TOCO AlyOTEPN TTANPOPOPIa

LTTAPXEI, APA EXOLUE PIKPOTEPN ELKPIVEIA OTNV EIKOVA. ATTO TNV AAAN TTAELPJ,



Eikova 1: Eikova pe peyalo
zoom in - BAETToLE Ta pixels
TTOL TN CLVBETOLV.
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000 XauNAOTEPN €ival N avaALvon HIAC EKOVAG, TOOO UIKPOTEQO Eival Kal TO

pEYEBOG apxeioL TNG eIkOVAG, SNAASH N eikdOva aTmoTeAeiTal atrod AlyoTepa bytes.

MOANEG POPEC ATTOONKELOLPE TNV iSIa elKOVA Pe TTOANEG avaALoeg. Av, yia
TTAPAdElyud, BEAOLUE VA EKTUTTOOOLHE TNV €lKOVa Ba emAéEoLUEe TNV €kSoon
TNG TTOL €XEl TN PEYAALTEON AvAALon. Av BEAOLUE VA OTEIAOLUE TNV £KOVA O€
éva @iho pag pe email 4 va T dnuoocieboovpe oTo AladikTuo, TOTE Od
emAEEoLUE Wia pIKPOTEPN AVAALON TNG EIKOVAC WOTE VA £XEl HIKOO PEYEBOG Kal
va yivel o ypriyopa n heta@opd TnG. Katd tn SIdpKeia TNG atmtoOnKeLONG PIAC
EIKOVAG I0WG pag {NTNBei va opicovpe TO PABUO CLUTTIEONS TOL VEOL APXEIOL.

O BaBuog cuuTtieEoNS apxEioL LITOACYIZETAI ATTO TOV AKOAOLOO TOTTO:

MéyeBog apxikov apxeiov
MéeyeB0oG TEAIKOU APXEIOL PETG TN CLUTTIEON

BaBuog cuuttieong apyxeiov =

amo OTToL PaiveTal OTI OCO PEYAALTEQOC gival O PABUOS cvuTtieong TOCO

MEYAADTEQO €ival TO Apxeio.

To Photoshop éxel wg Paocikrh) Aecitovpyia TNV eme€epyaaoia Twv pixels. Maipvel
pia TEpIoXN TNG elkOvacg kal aAAadlel Ta pixels TNG. Toug aAAdalel TO XPWUA, TN
Beon, TN PWTEVOTNTA, TNV AVTIOEON KAl TEAIKA AvaTTpocapuodel KAl CLVOETE! £K
VEOL TNV eKOva oTnv 0Bovn. To Photoshop éxel akoun tn duvvatodtnTa va

SnNUIoLPYNAOEI Pixels ae TTEPIOXES TTOL SV LTTAPXOLV.

AOCKNOEIG:

(1] Avoi€Te TNV eKOva ‘Leopard.jpg’ oto Photoshop kal eépapuooTe TO PEYIOTO
suvaTtd zoom in TMAVG OTNV ekova. MNapatneEnoTe Ta pixels amd Ta oTToid
aTToTeAEITAI N €IKOVA.

@ Acite TV avaavon TG ekovac ‘Leopard.jpg’ pEca amo To pevod Image >
Image Size. Mooa pixels eival To TAAGTOC (Width) TnG ekdvag kal TOca To LYWOG
(height); Me moia Tpagn Ba vmoAoyioeTe TNV AavAALon TNG eIKOVAG; Molo eival
TO UEYEBOG TTOL EXEl TO APXEIO PE TNV TOEXOLO A CLUTTIEDN;

© AMGETE TV avaluon NG ekovag ‘Leopard.jpg’ opiloviag vEo TIAATOC
(width) Ta 800 pixels (SilatnpvTag ‘kAeldwuéves' TIC avaloyieg). Molo eival To
VEO LEYEDOC TOL APXEIOL;

O Opiote vio TMAGTOC (width) Ta 320 pixels (SI0TNEGVTAC ‘KAEISWUEVES' TIC
avaAoyieg). EpapuooTe 1O péyioTo SuvaTd zoom in TMAVG OTNV &KOVA, T

OAANQYEG TTAPATNPEITE OTNY ELKPIVEID TNG EIKOVAG;

L R EEEEEa



» - »
s  XOs LCD 4

Eikova 2: O Xo®uUATIoUOI
TV pixels TV oBovov
Baaoifovral oTo XOWUATIKO
povTéAo RGB.
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XpwHATIKA HOVTEAQ

O 6poc¢ XpwUATIKA JOVTEAD €ival O £MOTAPOVIKOG TPOTTOGC YIA VA TTOLHE ATTAA
‘TC KaTtaAaPaivel 0 LTTOAOYICTAG TO XPWUA' N ‘TS va SWOOLUE OTOV
OTTOAOYIOTH VA KATAAARE TI Xoua BEAOLHE VA SOLAEWOLE'.

To TPOPRANUa Eekivael pe To OTI To Photoshop eival mpoypauua kail 8¢ utropei va
KATOAGREl TO XpWuaTa OTIWS o avBpwrtrol. ‘ETol &€ ummopoLue va §WOOLLE
EVTOAN o€ &vav LToAoYIOT va {wypagicel pye To PmAe xpwpal ‘Ouwg ol
LTTOAOYIOTEG KATAAQRAiIVOLY TTOAD KAAAG ApIOUNTIKEC TIUES, KAl ALTOC €ival O
TOOTIOC HE TOV OTIOIO  ETTIKOIVGVOULUE. TO XPWHATIKO POVTEAO TO OTIOIO
XPNOIUOTIOIOVHE CLXVOTEQRA OTAV SOLAELOLUE e OBOVEG, €ival TO XPWUATIKO
pHovTéAo RGB atmd ta apxikd TV Aé€ewv Red (kokkivo), Green (pdoivo), Blue
(uTTAg).  Av  koitafoupe amod  KOVTA  OTTOIASATIOTE 0BOVN, ULTTOAOYIOTH,
TNAEOPACNC ) AKOUN KAl KIVATOL TNAEPGVOL, Ba SoLue Wia eikdva cav auTh
ToL TTapovoiadletal oTnv Eikova 2. Kabe pixel, SnAaér), amoTeAeital amo 1a 1pia
TTOOAVAPEPOEVTA XPWHUATA, TO KOKKIVO, TO TIPACIVO KAl TO UTTAE. AVAAOYQ UE
TNV &viaon ToL €xel To kaBéiva amd autd TA EMPEPOLS XPWUATA ©
LTTOAOYIOTAG SNUIOLEYE TO TEAIKO XPWUa TTOL PAETTOLUE TNV 008OVN. ETOI KAl
oT10 Photoshop, €meibr) SovAebovpe og 00OVN LTTOAOYOITH KAl TO ATTOTEAECUA
NG SoLAEIAC pac Ba mPoPANBel oxeddv TAvTa ce 0BOVN LTTOAOYIOTH,
XPNOIUOTIOIOVHE TO POVTEAO RGB wOTe va LTTAPXE APECN OXEoN METALL TWV

TIUGV TTOL SiVOULLE KAI TV XPWHATWY TTOL PAETTOLHE OTNYV 0BOVN.

To €DPOC TWV TIHWV OTO XPWHATIKO JovTEAO RGB cival amd 10 0 € 1o 255. Kai
yiati 255; Tati 255 cival n péyiotn Tipr TToL pTTopsl va €xel éva byte. ESw,
S0LAgLOLUE pE PABOC xppaTog 8 bit kal 8 bit = 1 byte (To PABOG xpwUATOG
Ba 10 £€nynoovpe TO AvaALTIKA OTn ouvéxela). To 0 énAwvel atrouaoia

XPWPATOG, £V TO 255 SNAGVEI TN PEYIOTN TIUMA TOUL.

DLOIKA, LTTAPXOLY KAl AANG XPWHATIKA JOVTEAQ OTTWC TO HSB, atmo TIc ALEeig
Hue (ammoxpwon), Saturation (kopeoudg) kar Brightness (pwTteivotnTa), Kail 1o
Lab, amd ™ AéEN Luminosity (éviaon @oTtevotntag), a kar b evar svo

TTAPAUETPOI, TO Lab xpnoiuyotoleital TToAL oTravia.

AKOUN, TO XPWUATIKO HoVTEAO CMYK TO XPoNOIUOTTOIOVHE KLPIWS OTAV £XOLUE
va KAVOLUE PE EKTLUTTOEG. Edv SOKIUAOOLUE VA EKTUTTIOOOLUE OE £vav

EKTUTTATA HE TO XPWHATIKO povTéAo RGB Ba mmapatnernooupe OTI LTTAPXOLY



Cyan

Green

Yellow

Eikova 3: KOKAOI XpWUATV.

Color Picker (Foreground Color)
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Eikova 4: EmA\oyéag
XpwuaTog.

ATTOKAEICEIC OTA XPWUATA TNG EKTOTIWONG Ot OXEON HE TA XPWHATA TNG
0BovnG. ALTO cLPPAIvVEl YIATI OAOI Ol EKTUTTWTEC XPNOIUOTTIOIOLY TO HOVTEAO
CMYK. AANG yiaTi va £xoupe AANO XPWUATIKO HOVTEANO OTIC 0BOVEC KAl AANO

OTOLG EKTUTTWTEG; TO TTOPOPRANUA TTOOKOTITEl ATTO TO YEYOVOG OTI AV TA UEAGVIA

| TOL EKTUTIGTH NTAV YEUATA PE KOKKIVO, TIOACIVO KAl UTTAE KAl TIPOCTIABOLCApE

VA EKTLTTOCOLE YIA Va avapeifovpe avtd Ta PACIKA XPWUATA KAl VA TTAQOLE
AAAOLG CLVELACHOVLG XPWHATWY, TTAVTA OTO XAPETI Ba TTaipvape TO PALPO
xpopa. Kar autd 8101 av avakatebOoLV SVO OTTOIASATIOTE XPWUATA TOL
XPWHATIKOL povTéAoL RGB oT0o xapTi, TO amoTtéAecpa eival TTAVTA TO PALPO
Xpopa. 'ETOl, O KATAOKELAOTEG EKTOTTOTQV OKEPTNKAV  MIA  SIAQOPETIKN
TTEOCEYYION, KAl AVTi VA XPNOIUOTTOINCOLY TA XPWHATA KOKKIVO, TIPACIVO KAl
UTTAE, XoNOIJoTTIoINCAav Ta Xpwuata Cyan (kuavo f yaldadio), Magenta (Uwp)
kar To Yellow (kitpivo) (Eikova 3). Ta LmOAOITTA XPWOUATA PTTOPOoLY vda
SnuiovLpyNBoLY TALOV HE TO CLVESLACHO TWV TPIWY ALTOV XPWUATWY.
MEOKOUTITEl, OPWGS, KAl TTAAI TO €EAG TTPOPRANUA, OTTOI0 CLVELACHO XPWHATOG
KAl va KAvouLue &€ PTTOpOoLPE va TTAPOLHE TTAEOV TO HALPO XPwua. Ta va
ADOOLV KAl ALTO TO TTPORANUA, Ol KATAOKELACTEG EKTLUTTTAWYV TTPOCOETAY KAl
Eva TETAPTO PEAGVI, TO pavpo. Mhpayv, Aoitoyv, To ypduua K ammo tn Aé€n Black

(MAVPO), KAl £€TC1 OVOUACAY TO XOWHATIKO HovTeEAo CMYK.

EmAoyéac Xpouarog

ITNV €PYQAEIOONKN OTa aploTepd TNG 0oBovng Tou Photoshop Ppiocketal o

EmAoyéag Xpopatog (Eikova 3). ES, OIS Aéel KAl TO OVOUA TOL, UTTOPOLLE

) va emAEEOLIE TO XPWUA PE TO OTTOI0 BEAOLE va SOLAEWOLE. H TTEPIOXN WE Ta

. YPAUUATA, Ta COUROAC KAl TOL APIBUOLC eival TO CNUEIO OTTOL ETTIAEYOLUE TO

XPWUA TTOL €TMIOLUOLUE KABE POPJ, EXOVTAG TN SLVATOTNTA VA TO SNAOCOLE

UE TEOOEPA SIAPOPETIKA XOWHATIKA LUOVTEAC.

AOCKNOEIG:

(1] Avoite TNV elkova ‘Peacock.jpg’ oT1o Photoshop kal mapatnpnoTte tTnv
kKapTéda Info. Av n kapTtéda Sev eupaviletal oTo e pEPOC TNG 0BdvVNG Cag,
eMAEETE aTTO TO PACIKO pevoL Window = Info (Eikova 5). H kaptéAa Info Sivel
TTANPOPOPIEC YIa TO pixel TTou &cixvel KABe Popd O SeiKTNG TOL TTOVTIKIO.
Metakivhote 1O SeikTn TOL TTOVTIKIOL TTAVG OTNV €KOVA, Tl TTAPATNPEEITE O€
oxéon Je TIC TIWES RGB; MeTtakivAoTe TO S€IKTN TOL TTOVTIKIOL O€ Wia TTEPIOXN
UTTAE XPWMUATOG, Tl TTAPATNEEITE YIa TIC TIWEG RGB; Kavte 10 i8I0 KaI YIia pia

I
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I
I
I
TTEPIOXM) HALPOL XPWHATOG, TI TTAPATNEEITE (BLUNBEITE: ATTOLOIA XPWUATOG!); I
=1



Click and drag to move layer or selection. Use Shift and
Alt for additional apbons.

Eikova 5: H kapTtéAa Info.

Photoshop CS6 - EmiuéAeia: KaAéroou EuTuxia m

@O Avoitte Tov EmMAOYEQ XPOUATOS aTIO TNV EQYAAEIOONKN OPIOTEDA TNG
0BovVNG 0aG. AWOTE TIG AKOAOLOEC TIUEC YIA TO XPWHATIKO povTéAo RGB kal

ONUEIOTE TTOIO XPWUA TTOOKLTITEl KOBE popa:

MepiBaAlov gpyaociag

Ye ALTO TO onueio Ba UIANCOLE YIa To TTEPIBAANOY epyaciag Tou Photoshop
Kal Ba e€oIKeIBOOLE e TA PEVOD, TIC KAPTEAEG KAl TIG €TMAOYEC ToL. Edv ol
UTTAPEC  €PYOAAEIV, Ol KOPTEAEG KAl YeVIKOTEPA TO  TIEPIRAANOV  TOUL
TTPOYPAPUATOC &ival SIAPOPETIKO atd avTd TToL gugaviletal otnv Ekova 6,
UTTOPOVLE VA TO E£TAVAPEOOLUE OTIC APXIKES TOL PLBUIcES. ATTO TO Baoiko
Mevol (Eikdva 6-1) oto TAve MPEPOG TNG 0Bovng, emAéyovus Window->
Workspace = Essentials (Default). H Aé€n workspace onuaivel repIBAAAOV
€QYQTIAg KAl gival KATI YETARANTO, ApoL TTPOCTAPUOLETAl EDKOAA OTIC AVAYKEG

KAl TIG EpYATIieG TTOL EXOLUE VA KAVOULLE.

‘Ocov apopd 10 Baoikd Mevoy, ¢ Ba TTETel va pag Teopddel o OYKOG TV
emAoyav! Mol cbvToua Ba yvwpilovue TToL PpickeTal N KABE emAoyr OTAV TN
xpelalopaoTe, yiati N Adobe Ta £xel TOTTOBETACE OAD €KEl AKPIPGG TTOL TTRETTE
va civall MahioTa, oTmapxel Pia Aoyikr Kal opadotroinon Tiow amd KAbe
emAoyn. MMapatneoLue, emiong, OTI O TIEPICOOTEPES  ETAOYES  cival
QATTEVEQYOTTOINUEVES. ALTO CLUPAIVEL YIOTE YIA VA AEITOLPYACOLY Ol ETTIAOYEG

xpeialovral Sedopéva, kal dedopeva oto Photoshop eival ol eikdveg.

Eikova é: To TiepIPAAOV epyaaciag Touv Photoshop.
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1
|
(1) Avoi€Te TNV ekova ‘Squirrel.jpg’ oto Photoshop kal petapeite 010 UEVOL :
I
I
I

Image. NMapartnenoTe 0TI TTAEOV OAEC Ol ETTIAOYEG €ival EVEQYOTTOINUEVEG.

ITnv EpyaheioBrkn (Ekova 6-2) Ppiokovial OAa Ta gpyaiea 1ouv Ba

XPNOIUOTIOINCOLUE YIa TNV emme€epyacia TV eKOVWY Pag. Avaloya pe Tnv
avaivon TNG 0BovNG pag N TG Pag PoAedel va gpyalopacTe KAALTEPQ,

UTTOPOLUE VA TTAPATAEOLUE TA €QYAAEIa pag o€ pia ) 800 OTAAEC KAVOVTAG

KAIK OTO KOULWTT ﬂ oTNV TAV® APIoTEP YVvid. AV TTAPATNEANCOLE KAADLTEQA
Ba SoLpE OTI OXedOV Ot KABE £pYAAEIO LTTAPXEI EVA PIKPO AELKO TRIYWVO OTNV
KATG 6e€IG yoovia, OTTWC yia TTapadelyua 5w ALTO SnNAcvel OTI ATTO KATW
BpiokovTal kal AAAa gpyaAcia kpLpéva. MNa va doLuE Ta KpLUEVA epyaAeia Ba
= . Brush Tool TTEETTEl VA KAVOLME APIOTEPRO KAIK TTATNUEVO YIA UIOO SeLTEQOAETITO TTAVE OF

# Pencil Tool
E e — KATTOIO TETOIO EPYAAEiO. Na TTAPASEIYUA, KOATWVTAG TTATNUEVO TO APICTERO KAKK
E

&/ Mixer Brush Tool
-

TTAVE OTO pYaAeio Brush Tool epgavifovtal Ta gpyaicia 0TS gpaivovtal oTny

Eikéva 7:Ta epyardang  EkOva 7. ITA TIEQICOOTEQA EOYOAAEID QAVTIOTOIXEl KAl KATIOIO TIARNKTOO
opddag Brush Tool.

oLVTOPELONG, YIa TTAPAdelyua oTo Brush Tool cival To ypduua B. Edv BéAovue

VA EQYACTOVWE PE TO TTANKTPOAOYIO, TTATGVTAC TO YRAUUA B Ba £xovue emmAEEE

TO Brush Tool, yia va TTpoxwEnooLUE OTA eTTOUEVA €PYAAEid TNG opdsdag,

KoaTAUE TTATNUEVO TO TTANKTEO Shift kKal TO Ypduua TTOL AVTIOTOIXEI OTO eyaAeio

ToL BéAovpe va emAe€ovpe. Mataue TO cLVSLACUO TOOEC QOPEC WOTE VA

PTACOLE OTO EMOLUNTO EPYAAEIO.

‘Otav emAéyouue KATIOIO gpyaAeio amd TNV EpyaAeioBnkn, ol €mMAOYEC TTOL
eupavidovral oTn Pmapa 1TToL PPIcKETAl KATW ATt TO BaAoikd Mevold aAAdalouvv
(Exkdva  6-3). ALTO  ovuPaivel  yiati kKABe epyaleio  éxel  SIAPOPETIKES
TTOPAUETOOLG, KAl O€ ALTA TN WTAPA eugaviovrial kKABe @opd ALTOI Ol
SIQQOPETIKOI  TTAPAUETPOI.  AgiTe TNV evaAAayn oOTn JITApa  HETAEL TV

TTapAuETPWY Brush Tool kail Text Tool 0mrwg eugavifovral otny Eikodva 8.

Eikova 8: O urapeg mTapapéTewy TV Brush Tool kai Text Tool.

Y1a 66§14 TNG 0BOVNC (EikOVa 6-4) LTTAPXOLY SIAPOPES KAPTEC N AANIRG talbs,
TTOL YIO OIKOVOMUIa XWEOoL Ppiokovial N pia SimAa otnv AAAn, Kail eival
opadoTtroinuéveg o€ panels. EmMmAéoy, av katd AGBog xabei katTola KapTéAd
UTTOPOULUE VA TNV €MAvVAQEOOLUE EOKOAA aTtd To pevoL Window. 'OAec ol
KAPTEAEG MTTOPOLV va aAAafouv Béon mApa TOAD €OKOAQ, ApPKel va

KOQATACOLPE YIA AlyO TTATNUEVO TO APICTEPO TTANKTOO TOUL TTOVTIKIOL KAl va
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OVPOLPE TNV KAPTEAD OTN BECN TTOL ETTIOLHOLE. Me TOV 510 TPOTTO O KAPTEAES

History

- i ‘Wedding.jpg

uTTOPOLY va Pyadivouv Kal €€ atmd To panel cav fexwploTd Tapdbupa. Me

B open - TNV i81a AoyIKR utTropoLE va aAAalovpe To PEyeBog kal Tn BEon TV panels.
‘h_ Crop
= Hue/Ssturstion AV KATTOIA OTIYUR KAVOULUE KATI AdBog 1 BéAovpe atmAd va TTaue éva Prua

& @ @ oW, LTTAPXEI TTAVTA N €TMIAOYM TNG Avaipeong. EmAéyovpe attAd atro TO PeEVOL

Exéva 9:Hkapreaa Bt > Undo 1 evaAAaKTIKG TN cuvTopevon Touv TANKTPOAoYiouv Cirl +Z. Av

History. BEéNoLUE va TTAUE QPKETEC evEQYEIEG TTIOW LTTAPXEl N €TmAoyr Tou History
(loTOPIKO), SNAASH N KAPTEAG HE TNV TTANEN KATAYPAPH OAWY TRV EVEPYEIWDY
TTOL £XOLME KAVEI ATTO TN OTIYWNA TTOL avoifaue To apxeio (Eikova 9). Na va maue

o€ KATTOIA EVEQYEID TTHOW, ATTAA KAVOULE KAIK TTAVG TNG JE TO TTOVTIKI.

Eav éxovpe @TIALel £va e€QTOUIKELUEVO TTEPIBAANOY £0YACIAG TTOL UAC ROAELE

va £pyadleaTe, UTTOPOLUE VA TO aTTOONKELOOLPE WG Eva VEO workspace péca

amo 1o pevob Window=> Workspace - New Workspace... To vio mepiPAAiov

| p—— = B coyaoiag Ba eupavicetal padi ye Ta LITOAOITTA TTPOTEIVOUEVa TNG Adobe péoa

@ Effects amo 10 pevoL Window—=> Workspace kal 6a ummopoLue va emMOoTREWYOLUE OF
Bevel & Emboss

Gradient Overlay avTto Eava OTToTE BEAOLYE.
% Drop Shadow

Layers

Ta Layers cival TUAUATA TNG €IKOVAC TTOL SOLAELOLIE TA OTTOIA PUTTOPOUVLE VA T
ETTECEPYAOTOLE EEXWPIOTA KAl VA T CLVSLACOLPE HE TA LTTOAOITTIA, WOTE VA
OLVOECOLPE TNV TEAIKN €KOVA. T pid eKOVA PUTTOPOLE VA TTOLHE Ao TTOCT
Layers armoTteAeital, ammAd peTpvtac 1a (Eikova 10). Mia TToAD XpAoiun 1810TNTa

TTOL £XOULV TA Layers eival OTI UTTOPOUVE VA TA PETAKIVACOLUE AveEdPTNTA ATTO

TA LTTOAOITTA.
Eikova 10: H kapTéAa

LAy erS. T e |
ACKNOEIG:
(1] AvoitTe TO apxeio ‘Beach.psd’ oto Photoshop. To .psd énAcvel O1i gival éva

apxeio 1oL éxel dnuiovpynBei pe TO Photoshop «kal TepiExel  €MITTAEOV

oBovng cag TNV kapTtéAa Layers. EmAéyoviac 10 Move Tool amd tnv
EQYAAEIOBNKN apIoTEPA UETAKIVAOTE TO Layer TnG PmMAAAG KAl TOL ACTEPIA

aAAAlovTag TN 60N TOLG PECTA OTNYV EIKOVA.

="
 Autrseect:  [Graup = MNa va YETAKIVACOLE Eva Layer B6a TTRETTEl TTPWTA VA TO EXOLUE TIAEEEI! ETTEISN,

I
I
I
I
I
i
|
TTANPOQOPIA YIa TNV &KOVA, OTIWG eival Ta Layers. NMapatnenoTe ota §e€1A TNG :
I
I
I
I
I
I
I
I

Untitrew 2., s @ 100% (RGB/8) * =

TTOMEG POpPEC KaBWG eme€epyalduaoTe eikOveg uttopel va Eaxdoovue va

emAe€ovpe TO Layer TToL BEAOLUE PE ATTOTEAECHUA VA WETAKIVOLPE AAAO Layer

Eikova 11: H emAoyn Auto

Select T0b Move Tool.  9TTO QLTO TTOL Seixvoue Ye TO TTOVTIKI, N Adobe exel ToooBETel ia emAoYn

oTNV UTIAPa We TIC TTAPAPETPOoLS ToL Move Tool, To Auto Select (Eikova 11).
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Me 1o Auto Select emAeypévo (M) e xpeialetal va OKEPTOPAOTE TTPWTA TO
Layer, amAd maTtaue AV TOL PECA OTNV €KOVA KAl TO HETAKIVOLUE. To

Photoshop emmAéyel auToOpaTa yia eudg To 0wWoTO Layer.

(2] EmAéyovriag 1o Move Tool kal ue emmAeypévo To Auto Select petakivAoTe TO
Layer Tou NAIOL Kal TNG PAPKAC AAANACOVTAG TN BECN TOLG PECA OTNYV EIKOVA.
(3) Metakivhote To Layer TNG PTTAAAG TOTTOBETOVTAG TN TTAV® OTNV TTPACIVN

outipéAa kal TTAvw oTo aoTepia. T mapartnpeite; MoTe N UmaAa Ppioketal

PTTPOOTA KAl TTOTE oW atro Ta SV AvTtd Layers;

©a JmopoLoaue va Tapouoldoovpe Ta Layers g Slapaveeg. 'Ooeg
BpiokovTal YnAd eupavifovial OAOKANPES, OCO TTIO KATW TTNYQiVOLE oNnuEia
EKEIVAV TV SIAPAVEIY UTToPEl va KpLRovTal, OTav LTTAPXOLY AAAEG ATTO
emavw. H oeipd TV Layers puoIkA pttopel va aAAagel, apkei va emmIAéEOLIE TO

Layer Tov BEAOLPE KAl VA TO COPOLE TTIPOG TA TTAV N TTPOG TA KATW.

EmmAéov, Ta Layers éxouv ovopata. ‘OTav Ta TPWTOSNUIOLEYOLUE TO
Photoshop Toug Sivel avTdouaTa ovouara, omwg Layer 1, Layer 2, K.o.k. Eivai
onuavTikd va ovoudalovpe Ta Layers avaloya Pe TO TTEPIEXOUEVO ToLC. ‘OTTWC
Ba SoLUe apyoTEPA, LTTAPXOLV TTEPITITAWOEIS TTOL BA SOLAELOLUE HE TTOANG
Layers kal ovopata omwg Layer 15 | Layer 20 &¢ 6a pag ponBave. MNa va
aAAdG€ovue TO Ovoua evog Layer matdue AV OTO TPEXOV OVOUA TOL, TO

aAAAalovpe, kKal OoTn ouvéxela TTataue Enter.

ITa apoTePd KABE Layer cuvABWGS LTTAPXE TO CVUPOAO TOL paTIoL (Eikdva 10).
‘Otav avTtd TO COUPOAO eival euPaveg oe OAa Ta Layers onuaivel o1 OAa TA
Layers eival evepyorroinuéva va edgavidovial péca oTtnv  ekova. Edv
amogacioovue 0TI &€ BEAOLUE va guPaviletal KATTOIO Layer yeéoa oTnv elkova,
apKel va ‘kAgioovpe TO PAT', SNAASK va TTATACOLUE Wi PopPd TTAV® OTO
oLUPBOAO TOL paTIoOL. Me aLTA TNV Kivhon &€ xAveTal ATTOADTWC TITTOTA, OVTE
opryvovtar Sedopéval AuTr) n AeITovpyia xenoIuoTTolEiTal OTAV EXOLUE APKETA
Layers kal BEAOLUE VO ATTOPOVOOLE KATTOIO 1) KATTOIO OLYKEKPIUEVA, OTE
va JTTOPECOLUE VA  €PYACTOLUE O ALTA, VIATI OANG  JTTOPE  va

UTTEQSELOPACTE PE TA SESOUEVA TGV LTTOAOITTV Layers.

Na va emAé€ovpe Av TOL evOG Layer, Ot TTEPITITGON TTOL €ival CLVEXOUEVA OTN
oelpd, KAVOLUE KAIK TTAVER OTO TTPWTO Layer Kal Je TTATNPEVO TO TTANKTEO Shift
KAVOULUE KAIK KAl OTO TEAELTAIO TNG O&IPAG. Me To TTANKTPO Clrl umopoLue va
KAVOULUE PEUOVWUEVES ETTIAOYEC Slapopwy Layers (rmatnuévo 1o Clrl kal KAKK

oTa Siagpopa Layers).
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O MerakiviioTe To Layer TnG PAPKAC KAT® Ao ToL AAIOL. DEPTE TN PAPKA
TTAV®W OTNV TTPACIVN OUTTPEAA. TI TTAPATNEEITE;

O MerovopdoTe Ta Layers NG TTapaAiag oe “beach” kai Tov HAIoL Ce “sun”.

péoa oTNV £KOVA.
(7] EmAe€Te TQLTOXPOVA TA Layers Tov NAIOL KAl TNG UTTAAAG KAl UETAKIVAOTE TA

YECQA OTNV €IKOVA.

i e e o e S S S S S S S S S S S S S S S S S S S S S S S S S S S S

i i
I I
I I
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| |
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! @ AoKIHACTE VO ATTOKPOWETE KAl VA EMTAVEUPAVIOETE Layers TG emAoYAC 0ag !
I I
I I
I I
I I
I I
I I
I I
I I

MNapatnE@vTag TN PIapa TTapapéTpwy Tou Move Tool PAETovue Wia oepd
EQYOAEiV TTOL gival aTrevepyoTToINUEVA. AV OGS  emAé€ovhe SLO N
TePIcoOTEPA Layers 1OTE ALTA TA gpyaAeia evepyortolovvTal (Eikova 12). Ta
gpYaAEia avTa £XoLv va KAVoLY PE TN aToixIon Twv Layers oTnv ekova, KaBwg

Kl pe TN PeTalL Toug amodoTaAoN.

b » W Auto-Select: Group & Show Transform Controls

Eikova 12: Evepyoroinuéva epyaleia urrapag Move Tool.
Na N dnuiovpyia evog véou kevoLd Layer Tatdue oto Layer TTou Ba eugaviletal
AKPIPAOG amrd KAvw ammod To vEo Layer mov Ba SnuiovpynBei kal TTATAPE TO
koot ‘Create new layer’ H (Ekdva 10). To Photoshop &nuiovpyei TO
KalvoLplo Layer §ivovtag Tou avtouaTta £va Ovoud. EVOAAAKTIKG, KAVOLE KAIK
OTO KOLYTTI Enoo Bpioketal TTAVG &e€1A TOL panel TTOL TTEPIEXEI TNV KAPTEAQ

Layers (Eikova 10), kal emAéyovue New Layer...

Na va Sdiaypdyoupe £va N TepiccoTepa Layers, a@oL Ta eMAEEOLUE TTATAUE TO
€IKOVISIO pe Tov KAS0 TToL PpiokeTal KATW SegId E (Eixova 10), evaAAaKTIKA
KAVOLUE KAIK OTO KOLUTTI EKOI emAgyovpue Delete Layers r) akoun pmmopovue
va KAvouLpe Se€i KAIK TTAVG o€ £va atrd Ta emAeyuéva Layers kal va eTmIAEEOLE

kal TN Delete Layers.

Na va ouvééocovpe dVO 1 TEPICCOTEPA Layers petad TOLS, APOL TA
eMAECOLUE TTATAME TO EKOVISIO TNG AALCIda (E|Kc'>vo 10). To eikovidio TNG
alvoidag mAéov eu@aviletal ota Se€IA TV avTioTolxwy Layers yia va pag
oTrevOLuiCel OTI gival ouvdedeuéva. ATTO TN OTIYUN TTOL EXOoLV CLVSEDE O,TI
epapuoleTal oTo éva Layer avtopata 8a epapudletal kal oTa LTTOAoITTA. Tia
ammooLvéeon Twv Layers, pe TNV idla Aoyikn, Ta €MAEYOLUE KAl TTATAPE KAl TTAONI

AV OTNV aAvoida — Ta Layers yivovTal kal TTAAl auTovoua.



EmA£yovtag pépog

& 5e qum) TNV evoTnTa Ba SEifoLUE TIOG EMAEYOLHE TTEQIONES TG EKOVA, Ta

€QYAAEia TTOL LTTAPXOLY KAl TN XPHON TOLG. = 77 Rectangular Marquee Tod M
. Elliptical Marquee Tool M
ReCTanUIOr MOquee TOOl (M) - c=a Single Row Marquee Tool

E Single Column Marques Tool

ALTO  TO  €pyaAeio  Snuiovpyei  opbBoywvia
TTapaAAnAOypaupa (Ekdva 13). H xpnon tou eivail Bicova 1 TSAEquCJEZQTZg
TTOAD QTTAr), KAVOLPE KAIK OTO Onueio OTToL BEAovue va EeKIVAOOLUE Kal
otPVOLPE TO TTOVTIKI. MNa va emMAEEOLUE TETPAYWVEG TTEPIOXES, KABWC TEPVOLLE
TO TIOVTIKI KOATAUE TTAPAAANAQ TTaTNUévo kal To TAAKTPO Shift. 'Omwg
TTAPATNEOLHE, AV KAVOLUE KAIK KATTOL Yia va emAé€ovpe pia opBoyvia
TTAPAANNAOYPAUUN TTEQIOXN, EKEIVO TO ONUEIo YiveTal N TTAVG APICTEPN Y@Vid
TOL OXNUATOG. EGv BEAOLUE, PTTOPOULE EKEIVO TO ONUEIO va TO KAVOLWE TO
KEVTPO TNG ETMAOYNAC. ALTO Yivetral OTAV KABWG CEOPVOULUE TO TTOVTIKI EXOULUE
TTAPAANNAG  TTATNEEVO TO TIARKTPO  Alt.  ITn umdpd TTOPAPETPWY  TOL
Rectangular Marquee Tool (Eikova 14) éxoupe TIG aKOAOLOEC ETTIAOYEC:

- New Selection: 0Tav k&vouue KAIK C€ dia TrepIoxn TNG 0BovNG xaveral OTl
EXOLME ETTIAEEEI NON WEXPI eKEIVN TN OTIVUN KAl Eekivael Pia vEQ ETTIAOYN.

- Add to selection: otav eival evepyoTtoinuévo o S€iKTNG TOL TTOVTIKIOL £XEl Eva +

auTd onuaivel OTI KABe POoPA TTOL ETMAEYOLUE Wia VEQ TTEQIOXN TTPOCBETE TN
€MAOYN OoTNV N&N LTTAPXOLOA — e ALTO TOV TEOTTO UTTOPOLUE VA ETTIAEYOULUE
TALTOXPOVA TTOANEG TTEPIOXEG.

- Subtract from selection: otav eival evepyommoinuévo o SeiKTNG TOL TTOVTIKIOV

Exel &va - auTd onuaivel OTI OTAV ETTIAEYOULUE MiA TTEQIOXN TTOL ETTIKAALTITEN Mid
Ye ALTO TO PABNUA:

N&N LTTAPXOLOA ETNIAEYHEVN, TOTE EKEIVO TO KOUUATI TNG ETMIKAALYWNG AQAIPEITA
EMAEYOVTOG PEPOG...... 11 ammo TNV £MAOYN.
BAOIKEG PETATPOTTEG ....15 - Intersect with selection: eival akpipdc 10 avriBeto 1oL Subtract from

selection — n epIoxr) TTOL €MIKAALTITETAI ATTO TIG SVO TTEPIOXES €ival N LOVASIKN

TTOL Ba TTapapeivel TEAIKA ETTIAEYUEVN.

New Add to Subtract from Intersect with
Selection selection selection selection

il B H A E Feather: O pax Anti-alizs Width: sight: Refine Edge...

Eikova 14: H umrdpa mapapéTpwy Tou Rectangular Marquee Tool.

Te TIEQITITCON TTOL BEAOLUE VA £XOLUE CLYKEKPIUEVES AVAAOYIEC OTNV TTEQIOXN
HUAG UTTOPOLE VA TO KAvVoLE aTTAG aAAalovTac 1o Style amd Normal oe Fixed

Ratio (Eikova 14). Ita media Width kai Height Sivooue T1I¢ avaloyieg TAAGToLg



View

Filter

Al Ctrl+A
Deselect Ctrl+D
Reselect Shift+ Ctrl+D
Inverse Shift+Ctrl+1
All Layers Alt+Ctri+A

Deselect Layers
Find Layers Alt+Shift+Ctrl+F
Color Range...

Refine Mask... Alt+Ctrl+R

Modify L4

Grow

Similar
Transform Selection
Edit in Quick Mask Mode

Load Selection...

Save Selection...
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Window  Hel

Eikova 15: To pevoo Select.

. I:__J' Lasso Tool L

'g_;:] Polygonal Lasso Tool L

*gg Magnetic Lasso Tool L

Eikoéva 16: To Lasso Tool.

Kal byoug, yia mapadeypa av dooovpe Width: 16 kal Height:9 o,m1 emAoyn kai
va kdAvouue Ba éxel avTeC TIC avaloyieg. AANalovTag 1o Style oe Fixed Size
Sivoupe akpIPaG TIC SIaoTACEIC TIG ETMAOYNG HAG o€ pixels, kal & xpeidleTal va
OVOEOLIE TO TTOVTIKI ATTAA KAVOLUE KAIK OTO ONEIO TTOL BEAOLLIE.

ATIO TN OTIYHN TTOL &XOLUE ETIAEEEI pia TTEQIOXN KAl TOTTOBETACOLUE UECA OF
aLTA TO &€iKTN TOL TTOVTIKIOL, TTAPATNEOLUE OTI O &€KTNS AANAAlEl. MTToPOLLE
va COUPOULWE KAl VA UETAKIVAOOLWE ALTH TNV ETTIAEYUEVN TTEQIOXN WECA OTNV
EIKOVA PAG. AV TIPIV EEKIVACOULUE VA OEOVOLE TO TTOVTIKI EXOLUE TTATACEI TO

TTANKTPO Ctrl TOTE UTTOPOVUE VA UETAKIVACOLE TO TTEPIEXOUEVO TNS ETTIAOYNAC.

Elliptical Marquee Tool (M)

loxbouv akpIPOG Ta iSla OTI TTPOAVAPEPAUE OXETIKA pe TO Rectangular

Marquee Tool, pOvo ToOL  avii  va  emAEyoLUE  pE  OpBoymvia

TTAPAAANAOYPAUUA ETTIAEYOULUE e eAAgipelC. Kal TTAAI 1IoxVEl OTI € TTATNUEVO TO

TTANKTPO Shift kal TEEVOVTAG TO TTOVTIKI ETTIAEYOLUE UE KOKAOLG.

Single Row Marguee Tool kai Single Column Marguee Tool

EmAéyoupe pia ypauur maxoug 1 pixel katd pnkog f mAATOS TNG EIKOVAG
avrtioTolxa.

Baoikéc emAoyEC ToL Mevoo Select (Eikdva 15)

- All: EmAoyr) OANG TNC €IkOVAC 1) TA TTEPIEXOUEVA TOL TPEXOVTOCG Layer To otToio
eme€epyalOUAaTE.

- Deselect: AToemmAoyn OAWY TV ETIAEYUEVYV TTEQIOXDV.

- Inverse: AVTIOTREREI TNV TEEXOLO A ETTIAOYN HUAG.

Lasso Tool (L)

H xpnon 1oL Lasso Tool eival TToAD atrAn (Ekdva 16). Apxika KAvouue KAIK O€

Eva ONUEIO TNG €IKOVAC KAl CEPVOLE TO TTOVTIKI, APAVOVTAC TO KAIK TO LAsso
Tool Ba evooel To oNUEio OTTOL EEKIVACAE TNV ETTIAOYH UAG PE TO ONuEio OTToL
OTAUATACAKE, SNUIOLPYWVTAG £TOI WIA KAEIOTA TTEQIOXN. MTTOPOLUE, OTTWG
eidape Kal TIPIv, EiTE va PETAKIVACOLWE TNV €TTIAOYN UAC CEPVOVTAC TNV PE TO
TTOVTIKI €iTe av éxovpe TTatnuévo 1o Cirl Tpiv Eekivijooupe TN pETakivnon va

KAVOLWE ATTOKOTTH) KAl JETAKIVNON TNG ETTIAEYUEVNG TTEPLIOXNG.

Polygonal Lasso Tool (L)

‘O1G Aéel kKal To Ovopa Tov, To Polygonal Lasso Tool Snuiovpyel TTOAVYWVIKEG
emAoYEC. Kavoupe S1IGQopa KAIK € hia TTEQIOXN KAl TO CLYKEKPIUEVO EQYAAEIO
EVAVEl TA onueia TToL EXOLHE ETIAEEEl pE €LBEiEC yYpaupég. Tia va kAsioe n

emAoYn, o€ avTiBeon e 1o Lasso Tool Ba Trpérel ePEIC va YETAKIVNBOLUE TTOOC
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*—\ Magic Wand Tool

Eikdva 18: To Quick
Selection Tool kal ToMagic
Wand Tool.
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TNV apxn TNS €mMAOYNC Pac. ‘Otav couppei avtd Ba sovue Ot SimAa oTo S¢ikTN
TOL TTOVTIKIOU eUPAVIeTAl £vag KOKAOG, ALTO onuaivel OTI Av KAVOLUE APICTERO

KAIK ©a KAgioel n eTTIAOYN.

Magnetic Lasso Tool (L)

To gpyaAeio AvTO €MAEYEl ALTOPATA YIA €UAC. Kavouue atmAd KAIK OTO Onueio
OTTOL B¢AoLPE va EeKIVAOOLPE KAl OTN CULVEXEID OCEQVOLME TO TTOVTIKI.
MNapartnpovue o1 To Magnetic Lasso Tool TmpooBétel autouata onueia yia
EUAC. EAéyxel kOBe @opd TNV aAvTiBeon TOL XPWUATOG TOL CNPEIOL TTOL
BPIoKOUAOTE e TA SITTAAVA TOL, yI' ALTO TO AOYO SOULAELEI TTOAD KAAG O€
ONUEIa TNG €IKOVAC TTOL EXOLY PEYAAN AvTIOeon aTtod Ta SITAAVA TOLG CnuEia n
akopn kal amd 10 @ovro. MNa va kAsicel n emAoyr, 6a mpémea AN va
METAKIVNOOLUE OTNV apPXn KAl a@OoL EUPAVIOTEl O KOKAOG OTO &¢€iKTn TOUL
TTOVTIKIOU, VA KAVOLWE KAIK UE TO TTOVTIKI. EGv n €mAoyr oL éxouue Kavel Sev
gival Kal TOCO KAAR, UTTOPOLE VA AAAGEOLUE KATTOIEG ATTO TIC TTAPAUETOOLG
TOL gpyaAiciov (Eikova 17). To Width dnAcvel péxpl Tola amocTtacn oe pixels
ammo TO oNnueio TToL PpiokeTal o SeikTNG TOL TTOVTIKIOL Ba WAtel yia va eAéyEel
TNV avtiBeon Tou xpNuUaTog. To Contrast dnAdvel To TTOCOOTO TNG SIAPOPAG
oTnV avtiBeon ToL XpwuaTog. To Frequency dnAwvel kKGBe TOCO cuyxva Bad

WAXVEl YIa va TTpooBiTel vEa onueia.

2. 0 @ P E  Fethen opx ¥ Ant-sias  Width: 10px  Conbrast 10%  Frequency: 57

AOCKNOEIG:
(1] Avoifte TNV ekova ‘Elephant.png’ (To apxeio .png onuaivel portable
network graphics, 170 format autd pag emTEéE va ATTOONKELOOLUE KAl
TTANPOPOPIa  SIaPAvelag). MeyaAoTe TNV  €KOVA KAVOVTAG KAIK  OTO
MeyeBuvTikd @ako ammd Tnv Epyaieiobnkn kai pe 6e§i KAIK TTAvV OTnV €KOvVA
eMAECTE Feet on screen (evOAAGKTIKG atmo 1O pevoyw View > Feet on screen).
XpnoiyomoivTtag 10 Polygonal Lasso Tool e€mAEETE TNV elKOVA TOL EAEPAVTA,
AVTIYPAWTE TN KAl EMKOANACTE TN PECA o€ pia véa exkova. MNa va KAveTe
avTiypa®n amod 1o Baoikd Mevoo emAéETe Edit > Copy, yia emkoAAnon Edit -
Paste, yia Snuiovpyia véag eikovag File > New..

(2] Xpnoigotrolevtag To Magnetic Lasso Tool emAEETE TNV eIKOVA TOL TTOLAIOV,

AvVTIYPAWTE TN KAl ETTKOANNOTE TN JECA O€ pia vEa €IKOVa.

i o e e e S S S S S S S S S S S S S S S S S S S S S S S

Magic Wand Tool (W)

Kavovtag kAK o€ éva onueio Tnv eikodvag Pe To Magic Wand Tool, 1o yayiko

paPéi (Ekova 18), emAgyeTal ALTOPATA OAN N TTEQIOXN TNG EIKOVAC TTOL £XEl TO
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Spacing:

Angle:  oF

- Roundness:  100%

Size: | Pen Pressure = f}

Eikova 19: AN\ayn peyéBoug
mvEAOL TOL Quick Selection
Tool.

= 1 Crop Tool
H Perspective Crop Tool
A ¥ Slice Tool
t‘ Slice Select Toal

Eikova 20: H opdda 1wv
Crop Tools kai Slice Tools.
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iI510 XpWUA PE TO ONUEIo OTTOL £yIVE TO TTPWTO KAIK. EQv BéAovuE va KAvVOLE
TIEQICOOTEPES ETTIAOYEC TALTOXOOVA HE TO EQYAAEIO ALTO, ATTO TNV UTTAPA TRV
TTAPAMETOWY TTOL ETMIAEyoLPE Kal TTAAM TO Add to selection, akpipwg O,1

KAvape kal o Tave e To Rectangular Marquee Tool.

I Quick Selection Tool (W)

Me 10 Quick Selection Tool (Eikova 18) ummopoLuE va MAEYOLUE oNUEia TNG
EIKOVAG PE TO i8I0 XpWHA, KAl Ye Kivnon ‘cav va PAPOLUE’ PE Eva TTIVEAO,
O{OVOLHE TO €PYAAEiO KAl Ot AANA péEPN TNG €KOVAG KAl €701 €TMAEyOvTAl
TTEQICTOTEPES ETTNAOYEC. 1A VA HIKOOVOLWE TO HEYEBOC TOL TTIVEAOL ATTO TNV
PTTAPA TWV TTAPAUETOWY TOL EOYAAEIOL PTTOPOLE VA AAAAGEOLUE TN SIAUETPO
(size) TNg PovpToag ToL (EKOVA 19) ) eVAAAQKTIKA aATTO TO TTANKTPOAOYIO
TIATVTAG TNV AykLOAN [ N PoLPTCA PIKPAiVE eV TTATWVTAG TNV AYKLAN ] N
BoLpPToa peyaAnvel. EGv ammopacicoupe 0TI BEAOLUE VO APAIPETOLUE KOUUATI
ammo TNV EMAOYN WAG, HWE TTATNUEVO TO KOLUTT Alt kal e emAeypévo To Quick
Selection Tool cépvouue TOV S€iKTN TOL TTOVTIKIOVL OTNV TTEQIOXH TTOL BEAOLUE Va

APAIPETOLE (TTAPATNEOLE OTI TOV SEIKTN TOL TTOVTIKIOL euPavileTal TO -).

(3] Avoi€Tte TIG eikOveg ‘WhiteBear.jpg’ kal ‘Grass.jpg’. XpnoIUoOToOIQVTAG TO
Quick Selection Tool emAé€Te amO TNV TTPWTN €KOVA TO XIOVI. AOLAEWTE
TTAPAANAG KAl PE TOV MeyeBuvTKO PaAKO OTe va EMMAECETE OWOTA TIG
EMOLUNTEG TTEPIOXEC. AldypAwTe TO XIOVI TIATWVTAG TOo TANKTPO Delete.
Metapeite oTnV elkova ‘Grass.jpg’ emAEETE TN OAN KAl CVETE TN PECT OTNV EIKOVA
‘WhiteBear.jog’'. ANAETE TN celpd TV Layers ooTe n ekOvVa TNG apkoLSdag va

gu@avileTal TAVE atro To XOPTAP!.
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Crop Tool (C)

To Crop Tool (C) cival TO gpyaAEio Ye TO OTTOIO UTTOPOLUE va emAECoLUE Eva

HEPOG TNG EIKOVAG PAG KAl VA AQAIQECOLHE TO LTTOAOITTO KOUPAT (Eikdva 20).
Eival cav va koRouue amrd Tov KApPA TNG eIKOVAC TO KOUUATI TTOL BEAOLE KAl

€701 VA SNUIOLPYEITAI EVAC HIKPOTELOGS KAUPRAG.

Perspective Crop Tool (C)

Me auTO TO £PYTAEIO PUTTOPOLUE VA KPATHOOLUE HOVO TO PEPOC TNG EIKOVAC
TTOL PAG EVOIAPEPE!, APAIPOVTAG TNV LTTOAOITIN, KAl UAAICTA VA SGCOLUE KAl

pia VEQ TTPOOTITIKA) € ALTO TO KOUMATI TNG £IKOVAC TTOL ATTOPEVEL.

Slice Tool (C) kai Slice Select Tool (C)
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Ctri+Z
Shift+Ctri+Z
Al Ctrl-Z

Undo Name Change
Step Forward
Step Backward

Fade... Shift+Ctrl+F

Cut kX
Copy CrlsC
Copy Merged Shift+Cirl+C
Paste Ctrlet
Paste Special ’
Clear

Check Spelling.
Find and Replace Text...

Fill.. Shift+F5
Stroke...
Content-Aware Seale
Puppet Warp

Alt+Shift+Ctri+C

ShiftsCtrl+ T

Lo
Auto-Blend La

Define Brush Preset. Skew

Define Pattern... Distort

Define Custom Shape... Perspective

Wan

Purge » P

Adobe PDF Presets... Rotate 180
Rotate 80° CW.

Presets. b

Rotate 90° CCW.
Remote Connections...

Flip Horizontal
Flip Vertical

Color Settings... Shift-Ctrl+K
Assign Profile..

Convert to Profile.

Keyboard Shortcuts... Alt+Shifts Ctrl-K
Menus... Alt+Shift+ Ctrl-M
Preferences »

Eikova 21: H emAoyn
Transform.
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Ta §Vo avTa gpyalcia eival XPNoIUa OTAV BEAOLUE VA SIAIPECOLHE HIA EIKOVA

o€ HIKPOTEQA TUNUATA, WOTE VA TA XONOIPOTIOINCOLUE O¢ UIa web oeAiba.

BacikEg HETATPOTIEG

Ye ALTA TNV evoTNTa Ba &eifovpe TG PTTOPOLPE VA KAVOLWE KATTOIEG PACIKEG
TooTroTToINCElS (a) ota Layers TnG ekdvag Pag, Omwe eival n heyebovon, n
TTEQICTOPN KAl N AVTIOTEOMN, AAAd KAl TG VA TOLG SivOLUE VEO OXNUA, YECa
amo Tnv emAoyn Transform (Eikova 21), kar (B) otny idia Tnv eikdva (Image) kai
oTov kKapPd (Canvas) 1ou SoLAeLOLWE, OGOV aPopPd Tn HeyéBuvon, TN

TTEQICTOPN KAl TNV AVTIOTPO®N ToLS (Eikdva 22).

Na va ailAdéoupe To péyebog ot £va pegovauevo Layer, apob 1o emAéEoLe
TTNyaivoupue oTo pevoL Edit - Transform - Scale. MAéov yOpw amd TNy eikdva
eupavidovral pIKpd AoTIPA TETPAYWVAKIA, TA Onueia eAEyxoL. MTopoLue va
EMAEEOLE KATTOIO ONUEIO ATTO ALTA KAl VA WIKPVVOLUE 1 VA LEYAADTOLE TO
Layer pe 10 O110i0 SOLALVOULE. Ta VA PNV £XOLUE TTAPAUOPPWON ToL Layer
gival KaAO va KAVOLWE TIC ALEOUEITEIG ALTEC KOATWVTAC TIATNUEVO TO
TANKTPO Shift. ‘OTav oAokAnpwoovue TIC aAAayég Trataue 1o Enter yia va

ATTOONKELTOLV.

Na va mepioTeéwouue éva Layer tnyaivovue oTto pevoyw Edit & Transform -
Rotate. Eugavilovtal kal TaAl Ta onueia eAéyxov. TormoBeTobue Tov Seikth TOL
TTOVTIKIOU pag £€w atrd To TTAQicIo To Layer kal TapatnooLue OTI 0 KEPTOPAC
EXEl TTAPEI TNV LUOPOPN HIAG KAUTTOANG HE SVO REAN. Me apIoTEPO KAIK TTATNWEVO
UTTOPOULUE VA TTIEPIOTPEWOLHE TOPA TO Layer. 'OTAvV OAOKANOWOOLWE TIG
aAAayég Trataue 1o Enter yia va amoBnkevtoLv. H emAoyr) Rotate 180,
TEPIOTPEPEl TO Layer &e€idoTpopa katad 180°. H emAoyry Rotate 900 CW,
meploTpépel To Layer katd 900 cOUPVA PE TOLG SEKTEGC TOL POAOYIOL
(5e€looTpOPa). H emAoyr) Rotate 900 CCW, mepioTpégel To Layer kata 900

avtiBeTa ammd Toug SeikTEG TOL POAOYIOL (APICTEPOCTPOPA).

Na va avaoTpéwouue éva Layer eite oTov opIlOVTIO &iTe OTOV KATAKOPLEPO
afova Tnyaivovus oTo pevoL Edit = Transform kar emAéyoupue Flip Horizontal
yia opiovtia avactpo®n 1800 n| Flip Vertical yia katakdpupn avaotpoon

1800 avricToIxa.

Na mmo yprhyopa armoTeAéouaTta, amd 1o pevolL Edit > Free Transform pag
Sivetal n  duvarotnta va alalovpe TOCOO TO péyeBoc OCO KAl va

TEQIOTPEPOLIE TO Layer KAvovTag xpnon evog HOVO epyaiEiov.
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Na va Soouve £va véo oxnua oto Layer 1rou eme€epyalopacTe amd TO PeEVODL
Edit = Transform ummopoLue va Siaié€ovpe pia ammo TIC emAoyEC Skew (kAion),
Distort (mmapaudppwon), Perspective (mpootmtikA) 1N Warp (oképpwaon).
EugaviCovral kal TGN Ta onueia  €AEyxoL, TA  OTToiA  UTTOPOLUE VA

HUETAKIVACOULE VIO VA KATAPELOLIE TEAIKG TO £TIOLUNTO OXAUA.

MNa va SnNuIoLPYNOCOLUE Eva avTiypapo evog Layer, kavouue §e€i KAIK TTAVE Tou
ammo TNV KAPTEAD TV Layers kal armd TO AavadLOWPEVO PEVOL TTOL EugaVvileTal

emAéyooupe Duplicate Layer.

i AOCKNOEIG:
(1) Avoi€te TNV eikova ‘Vegetables.png’, emAeETe OTTOIO €PYAAEIO ETTIAOYNAG

BéAeTE KAl KOWTE Eva-éva Ta Aaxavikd. (a) Kavre armokomn (Edit >Cut) —

EMKOANNCON (Edit >Paste) mavw oTtnv idia eikdva woTe va SNUIOLPYNTETE £va

véo Layer yia To kaBéva ammo avtd. (B) AnuiovpynoTe Wia véa eKOvVA pe OKOTTO
va TTapeTe OAA TA AAXAVIKA KAl va TA PAAETE oA OTNV VEA elkova. ATTO TO
pevoy File >New... emAégTe MAGTOC (Width) eikovag ta 500 px (pixels) kal bwog
(Height) kal TaAl Ta 500 px kal €MAEETE OTE TO POVTO TNG VEAG €IKOVAG va
givar dompo. (y) EmAEETe OAa Ta Layers Twv AQXAVIK®V amd TNV eKOva

‘Vegetables.png’' kal cOPETE TA e TO TTOVTIKI OAG PYECA OTN VEQ eKOvA (eAv

Image Layer Type Select Filter

EXETE TTATNUEVO TO TTANKTPO Shift kal cbpeTe Ta Layers kevipdpovTal Yéca oTn

Mode L4

Adjustments Y| I véa ekova). (8) MetovoudoTe Ta Layers TNC vEAG €KOVAC CLOUPWVA UE TO
Aute Tene hift G+ L Ovopa Tou KABE Aaxavikol. () ITOXOG pAG &val va SnUIOLEYHCOLUE Evav
Auto Contrast Alt+Shift+ Ctrl+L H X . XOG Hag n PYN H

Auto Color Shift+ Ctrl+B

“ppouTavBpwto”!l AvfoueioTe KATAAANAG Ta Layers TV pPoLTWV TTOL

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
"

Alt+Ctrl+]1 . " 0 0 0 '
Carvas Soe. . P O¢AETE VA XONOIUOTIOINCETE YIA KEPAN, OWUA, AKPA, KTA., AVACTREWTE TA,
I(_”r‘;ser‘mt“’” TIEQIOTEEWTE TA, AANAETE TOLG OXNUA, KAI TOTTOBETHOTE TA KATAANNAG OTO XWPO
D NG €IKOVAG.
Rewveal All _H
Duplicate...
Apply Image... Na va aAAdéoupe To péyeBog piag ekOVAG TTNYaivoLpe atmd To pevoL Image =
Calculations...
o , Image Size... 6TTou eupaviletal To TTAaiolo siaAdyou TnG Eikovag 23.
Variables
Apply Data Set... | S| |
Trap... | Pixel Dimensions: 175,8K
Analysis 4 Width: E] -
k-
Eikéva 22: To pevou Image. Height: 200

Document Size:
Width: 1 Inches

Height: 0,667 Inches

Resolution: 300 Pixels/Inch

[¥] Scale Styles
[¥] Constrain Proportions
[¥] Resample Image:

Bicubic Autormatic

Eikova 23: To pevoL Image.
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Current Size: 175,8K
Width: 1 inch

Height: 0,667 Inches

OK

New Sze: 175,8¢
width: I | Inches
Height: 0,667 Inches
7] Relative
Anchor: [w[£]

- . >

CANIRY

(Canvas extension color: Background

il
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YTO onueio (1) prmopoLue va kabopicouue To veo TTAATOG (Width) n/karl To véo
vwog (Height) TG eikdvag. EAv petalLd Tev VO eyeBwv LTTAPXE TO CLUPOAO
NG aAvoidag -omwg ovuPaivel otnv Ekdva 23- autd onuaivel o1 av
TTPOCTIABNCOLE VA PETARAAOLUE TO £va PEYEBOC auTOPATA Ba PeTAPANBEI Kal
TO AAANO, Kal auTo yiati n emAoyr Constrain Proportions oto onueio (3) cival
ETTAEYUEVN, TIOL LTTOVOEI TO KAEISWUA TWV AVOAOYIQV. Me KAEISWUEVES
avaloyieg, av petaPAAovpe 1O pEyeBog TNG elkodvag, &6 Ba LTTOOTE KATToIA

TAPAPOPPWOoN. MIKOQIVOVTAG 1  PEYOA®VOVTAC TNV e&kova pac Oa

TTAPATNEACOLHE AAAAYN Kal oTO pPEyeBog Pixel Dimensions (1), To otroio uag
Seixvel To pEyeBog oL Ba KataAapPavel TEANIKA TO APXEIO TNG €IKOVAG pag. To
onueio (2) pag &eixvel TO TTAAGTOG KAl TO LYPOS TTOL Ba éxel N eKOva OTav
EKTUTTGOE. AKOUN He TO pEyeBog Resolution pag beixvel Tnv avaivon Tng

€IKOVAG Pag.

Eikova 24: To TTAcicio
Silaoyou Canvas Size.

Na va aAAa€ovue 1O UEyeBOC TOL KAUPA HIAG elKOVAC TTNYAIVOLUE OTO HEVODL
Image = Canvas Size... 6TToL gu@avileral To TTAdiolo SIaAdyoL TNG Eikdvag 24.
KaBopilovpue To veéo TTAGTOG (Width) r/kar To véo bwog (Height) Tou kaupd NG
€IKOVAG Pac kal amo 1o 1medio Anchor kdvoupe KAIK OTO onueio 61Tov BEAOLLE

va SQOCOLUE TN VEQ EKTAON TOL KAUPA.

Rotate Canvas @

Angle: i

lr—"u g"

Cancel

MNa va TTepIoTPEWOLUE Wia elkOva Tnyadivovpe oTo pevoL Image 2> Image
Rotation = Arbitrary... 6TTou eugaviletal To TTAQicIo SlIaAdyoL TNG Eikdvag 25.

Ito Tedio Angle opilovpe TN yovia TepicTpopng. H emAoyrn CW 6a

Eikdva 25: To mAdioio
Slahoyou Rotate Canvas.

TTEQIOTREYE TNV EIKOVA COUPVA e TOLS SEIKTEG TOL POAOYIOL (Se§I6CTPOPA),
eved n emAoyr) CCW Ba Tnv TTepIoTpéWel avTiOeTa amd Toug SEIKTEG TOL
poAoyiob (apIoTePOOTPOMA). EVvaAAakTIKA, ammd 1o pevold Image - Image
Rotation pmmopovue va emAé€ovpe 1800 (Se€iooTpopn TepIoTRo®R), 200 CW R
900 CCW.

MNa va avaoTpéwouue pia ekdva Tnyadivovpe oTo PevoL Image - Image
Rotation kai emAéyovpue Flip Horizontal yia opilovTia avaoTtpogr) 1800 n Flip

Vertical yia katakopugpn avacTtpopr) 1800 avrioToixa.

MNa va SNUIOLPEYACOLUE Eva AVTIYOAPO WHIAG €KOVAG TTNYAIVOLUE OTO PEVOD
Image - Duplicate... JovnBwg, gival KaAd va So0LAELOLUE OTA AVTIYPAPA TWV

EIKOV@YV PAG, KOATWVTAG ETCI TNV APXIKNA EKOVA ¢ backup.

@O Avoitte TV ekova ‘WhiteBearjog' kal GANAETE TO pEyeBdC TG oe Width:

800 pixels kal Height: 600 pixels. 'EmeiTa KAvTie avaoTpopr TNG EKOVAG OTOV

opIfovTIo A€ova Kal amoBnKeLOTE TN YE vEo Ovopa ‘WhiteBearSmall.jog’
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Blending modes
To Photoshop, péow Twv Blending modes (blend onuaivel avakatebw),
. TTAPEXEl HEBOSOLG KAl £pyaAEic Pe TA oOTToid pTTOPOLHE va ocuvdvdalovue

XPWUATA TTOL TTPOEPXOVTAI ATTO AANEG EIKOVEG e OKOTTIO TN SNUIOLPYIA VEOL

XPWUATOG.

ALTO TTOL KAvel TO Photoshop cival otnv ovoia PYaBNUATIKEG TTPAEEIC UETALL
TV XPWUATWY Twv SV0o Layers. H emAoyn blending xpealetal técoepa
TTEAYMATA YIA va AeITovpynoel. Apxikd, xpeddletal éva Layer 1o otoio B6a
xpnoiyotroin®ei w¢ Pacn, dAlo éva Layer mou Ba cival To blending, dnAabdn
avToO TTOL Ba AAANAETISPACOLY TA XPWHATA TOL e TN PACN, akOun TN PEBodo
pE TNV OTToid Ba cLVSLACTOLVE TA XPWUATA TV SLO Layers, kal TEAOG, TNV
emAoyn Tng diagaveag (Opacity) To ToocooTd SNAASK TOL XPWUATOS TOL

evocg Layer mou Ba embpdaacel he TO AANO.

ITnv Eikdva 26 @aivovral ol Sidpopes péBodol Twv Blending modes tou
UTTOPOLY VA €pAPPOOCTOLY TAV oTa Layers. ' OAn auth n Aiota amd Ta
Blending modes &ev gival TiTmote AANO aTmO UaBNUATIKES TTPAEEIC PETALL TV
XPWHATWY TV dVo Layers. Na mapddeyua, To Darker color cuykpivel Ta
Xpwuata TV SVo Layers kal kpatdel POvo TA TMO OKOTevA. To avrtifeto

aKkpPIPWG viveTal otav emAé€ovpe TO Lighter color, 1o omoio cuykpivel Ta

XPpATa TV SLO Layers kal KpaTdel HOvVo TA O PWTEIVA. AKOun, To Multiply

TToAAaTTACoI10lEl Ta xpwuaTa, 1o Difference eival n Slapopd (SnAadr n mpdaén

TNG APaiPESNG), KTA.

Blend Mode Groups

Y& ALTO TO pABNua:

Normal { Homal

Dissolve
Blending modes....... 18 Darken
Multiply
Xpwuarifoviag Darken Color gum
N near surn
ACTIOOUALPEC Darker Color
PRTOYPAPIEG............. 19 Lighten
radient Fill 1 & Screen
Lighten Color Dodge
Linear Dodge (Add)
Lighter Calor
Overlay
Soft Light
Hard Light
Contrast Vivid Light
Linear Light
Pin Light
Hard Mix
Inversion { Difference
Exclusion
H Subtract
Cancelation § = ;o
Hue
Saturation
Component A
Luminosity

Eikdva 27: H opadotoinon
- 2 TwV Blending modes.
Eikova 26: O1 €TMAOYEG TV
Blending modes.
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H opadotroinon 1wv Blending modes avdAoya £dv okovpdaivouy TNV ekoOvda,
N @wTtiovy, TovifoLV TNV AVTIOECN, KAVOLYV AvTICTPOPN 1N AKLPWON

XPWHATWY, PaiveTal oTny Eikdva 27.

ETMAEETE OTTOIO €PYAAEIO €TMAOYAG OéAeTe Kal €mAEETE TO AAoyo padi e 1O
XOPTAPI KAl PEPTE T PECA OTNV ekova ‘Tree jpg’. (a) AANAGETe Tn Slagpaveia

ToL Layer Tov aAoyouv oTnv ekova ‘Tree.jpg’ oe 50%. TI mapaTtnEeite; (B)

Blending modes amd Normal ce Darken. Ti TapaTtnpEite o€ OxEon WE TO
XopTdapl; (Y) AokipdoTe va epapudoete OAA Ta Blending modes mavw oT1o

Layer ToL aAOyoUL Kal TTAPATNEAOCTE TIC AAANAYEC O€ OXEON E TO AAOYO KAl TO

XOPTAP!.

I
I
I
I
I
I
i
I
I
I
I
|
: Emavagépete Tn Siapaveia Tou Layer Tov ahoyouv oto 100% kal aAAalTe Ta
i
I
I
I
I
I
I
I
I
I
I

Xpwpati{ovtag acTpOHAUPES PWTOYPAWPIES
ITNV evoTNTA ALTH cLveXI(oLUE PE Eva TTPAKTIKO TTAPAdeyua Twv Blending
modes, xpnoidotolwvtag 1o Blending mode ‘Color’ yia va XpwuaTioouue

AOTTPOUAVPEG EIKOVEG.

H Aemovpyia Tov Blending modes Sev treplopiletal Opwg Povo ota Layers.
AKOUN KAl OTNV TTEQITITGON TTOL avoifoLue Pia pwToypaAgia oTny oTToia dev
LTTAPXOLYV AKOUN AAAQ Layers, Kal eTTIAEEOLE YIA TTAPASEIYUC TO £EQYAAEIOL TOL
TVEAOL aTmd TNV EpYaAeloBrkn, TTAPATNEOVTAG TTPOCEXTIKOTEQA TNV UTTAPA
TTAPAPETPWY YIa TO TTIVEAO (Eikdva 8) Ba sovue pia emAoyr) Touv Aéyetal Mode.
Edv T@ea TTAThooLPE TO AVTIOTOIXO PEAGKI epgavileTal pyia avadvouevn NioTa,
ammo OTTOL PTTOPOLHE va SoLUE OAa ALTA Ta Modes Ta otoia &idaue Kal TTIo
TAV®. ILVETWG, UTTOPOUVUE VA XONOIUOTTOIOVUE TO XPWUA TOL TTIIVEAOL WG
Blending mode oe¢ cuvévacud pe To base color NG PWTOYEAPIAG KAl va

TTAPAYOLUE £TO1 EVA KAIVOLPIO ATTOTEAECA.

Eav emAé€ovpue ouykekplyéva 1o Color mode amd Tig Modes emmAoyEC Tov
TTIVEAOUL, KAl TTPOCTIABNCOLE VA XPWUATICOLHE Pia TTEPIOXN, 6a SoLuE OTI N
TTEQIOXN QLT &gV ETTIKAADTITETAI TTANPWG HE TO XPWHA TNG ETMAOYAC HAG, AANG
slatnpeital N TANpoPopia TNG eIKOVAG o€ PUeYAAo PaBud. Avtd cuupaivel yiaTi
10 Color mode kpatdel To Luminance (éviacn Tou pwTdg) amod To base color
Kal alalel 1o Hue (xpwuatikn oudda) kal to Saturation (kopeopdg). 'ETol
UTTOPOULUE VA SIATNENOOLPE OAEG TIC OKIEG, TIC TITOXWOEIC, KTA. ATTO TO

TponyoLPEVO Layer kal va aAAGEoupe pOVO TN XPWHATIKA oudda Kal Tov

19



Photoshop CS6 - EmiuéAeia: KaAéroou EuTuxia m

Kopeouo. ETol pmmopoLpe va aAAA{oLue OTTOIOSATIOTE XPWUA, OTTOIOLSATTOTE

QVTIKEIUEVOL O€ EYXPWUES PWTOYPAPIES.

AOCKNOEIG:
O Avoite TV ekdva ‘Flowersjog’ Kal €mMAEETE TO €OYAAEID TOL TTIVEAOU.

AlatnpnoTe ota Modes Tnv emAoyr Normal kail €mAEETE WG XPua ATTd ToV

EmAoyéa Xpwpatog pia Pabia kokkivn amoxpwon. MNpoomabnote va

(2] XpNOIUOTIOIVTAG TNV KAPTEAA ToL History e€AATE TTIOW OTNV QEXIKN

KaTAdoTaon TNG elkovag. Topd opiote ota Modes tnv emAoyr) Color kai
EXOVTAG TO i8I0 XPWHa SOKIUACTE EQVA VA XPWUATIOETE TA TTETAAA TOL TTIO

HEYAAOL AOLAOLSIOL. TI TTAPATNPEITE;

T o o e e e e S S S e e S S S S S S S S S S S S S S S S i —

I
I
I
I
I
I
I
I
I
|

XOWUATIOETE TA TTETAAA TOL TTIO HEYAAOL AOLAOLSIOV. TI TTAPATNEEITE; :
I
I
I
I
I
I
I
I
I
I
I

To TTO €VILTIWOIAKO ATTOTEAECHA, OUWC, TO EXOLUE OTAV SOLAELLOLUE E
AOTIPOUALPEG PWTOYPAPIEG, OTTOL EKE EXOLHE TTANPOPOPIa UOVO OXETIKA HE
N QWTEVOTNTA TNG &KOVAG — EXOLME POVO ATTOXPWOEIS TOL YKpl. ETol
TTOOCBOETOVTAG XPWUA, 6a TTApAUEivEl N TTPONYOLUEVN TTANPOPOPIA ATTA Ol

EIKOVEG YivovTal EyXpweC!

© Avoitte TV ekova ‘Face.jpg’ kal eMAEETE va avoieTe kal GAAN pia TG
EMAOYNC CAG péca amod TN oLAAoyrn Touv Ppicketal oTo @dakedo ‘Old
Cinema’'. Avoifte Ttov EmAoyéa Xp@uaATtog Kal TINyqdivere oTnv  elKOvVa
‘Face.jpg’. MNapatnenoTe OTI ALTOUATA £xel ETTIAEYE TO £pyaAeio Eyedropper
| Tool (I), ye TO OTTOIO KAVTE KAIK O€ OTTOIO ONUEIO TNG EIKOVAC BeWPEITE OTI EXEI
EVA KAAO XPWUA YIA XPOPA SEPUATOG. ADTOUATA O EmAoyéag XpuaTtog Exel
EMAEEEl yIO €0AG ALTO TO XPWPA. LTV ACTIPOPALEN E&KOVA SOKIPACTE va
XPWUATIoETE TO SEpUa TOL TTIPOCWTIOL KATTOIOL NBoTToIcL. TI TTAPATNPEEITE
OXETIKA IE TO ATTOTEAECQ;

O Miocw TNG AvVaiPEoNG 1) TOL ICTOPIKOL TINYTIVETE TTAAI TTIOW OTO ONUEIo

TTPIV apxioeTe va aANACeTe TO XPWHA TOL TIPOCTTIOL TOL NBOTToI0L. OpPioTE

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I 10 Opacity (dlapdveia) oto 55% kal SOKIPACTE KAl TTANI VA XPWUATIOETE TNV
I

: EIKOVA OTO ONUEIO TOL TTPOCWTTOL. TI TTAPATNPEITE TOEA OXETIKA LE TO VEO
I ATTOTENECUQ;

I

: * @0 TAPATNENOCETE OTI €AV EXETE NON XPWUATIOE! Hid TTEQIOXN KAl TTATE TTAOAI va
i N XPWUATIOETE, TTOPOOTIOETAI AiyO TTIO £VTOVO XpwUa. I’ autd gival KaAo va
: Eekivape apxikd pe xaunAd Opacity kal olya olyd va TTPpoCBOETOLUE XPWUA
I
I
I

OIS OEAOLPE YIA VA TETOXOLHE AKPIPWSG TO EMOLUNTO ATTOTEAECHA.

T o e o e e e e S e S S S S S S S S S S S S S S S S S S S S S S S —
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(Chopels % |

Y€ ALTO TO PABNUA:

Hue/Saturation......

Quick Mask, AN\ayi
XPWUATOG HOANIGV

n

23

Hue / Saturation

ITnV evOTNTA aULTA paBaivovpe T gival N XPWUATIKA opdada (Hue) kar o

Kopeouog (Saturation), TmC SoLALLOLY KAl TIWG PTOPOLUE va TA

XPNOIUOTTOINCOLKE YIA VA AAANAEOLE TA XPWUATA O Wia eikova.

B Na va kAvoupe aLTEG TIG OAAAYEG Ot pia ekdva, amo 10 Baoikd Mevoo

emAéyovpe Image = Adjustments = Hue / Saturation... kai eugaviletal 10

TTAQiclo SlaAoyou TNG Eikovag 28.

Preset: Default

Master

Saturation:

i
oL_ightness:
A
[ Colorize
Y,

Preview

Eikova 28: H emAoyn Hue /Saturate.

Ye auTd TO TTAQICIO SIGAOYOL LTTAPXOLY TPIa RACIKA KOLUTTIA eAEyxoL. To Hue
(1) eival n xpwpaTiKh ouada Kal ol TIPES TTOL UTTOPOLE VA SGCOULE gival aTTod -
180 ¢wg +180. To Saturation (2), cival o kopeoudg, SNAASH TTOCO KOPECUEVO
gival To Xpwpa, TTOCO YKPI £XEl JETA TOL, KAl TTaipvel TIWEG aTrd TO -100, OTTOL N
eKOVA TIAEOV YiveTal aoTipopavpn, €wg +100. To Lightness (3), eivar n
PWTEVOTNTA, TTAAI OI TIUEC TTOL UTTOPOLY VA OPICTOLV gival atd -100, OTToL N

€IKOVA YIVETAI HaLPEN -TIARPEC OKOTASI- £€0G +100, OTTOL N EIKOVA YiveTal AeLKN.

AN, TI akpIPXG eival auTég ol TIpEG; OQLOIACTIKA ALTEG Ol TIUEC ToL Hue cival
poipec. H Ekdva 29 mmapouoidlel To XpWUATIKO KOKAO, OTToL ekivael atmo TNy
TIUA 0° kal kKAvovTag évav SeSI0CTPOPO KOKAC KATAAAYEl oTnV TiuA 360°. ‘OTav,
AOITTOV, LUETAKIVOLUE TO KOLWTTI EAéyXOL TOL Hue TTpog Ta §e€idl, TOTE OTNV oLaTia
HETAKIVOLPE TA XPwuaTa &e£IOCTPOMA, €V TO AVTIOETO Yyiverar av 1O
UETAKIVACOLUE TTPOC TA APIOTERA Sivovtiag apvNnTikéG TIWES. OI TIUEG TOL
Saturation gival n aktiva A Tng Eikovag 29, snAadrn oo kovtd 1) TOCOo Pakpid
BPICKOUAOTE OTO KEVTPO TOL KOKAOL. TO + | TO - €ival TO €TTi TIG €KATO TOUL

KOPEOHOL, yia TTapadeyud +70% Kopeouog N -61% KOPETUOG.



Eikova 29:
XPWUATIKOG KOKAOG.
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‘Onwe mapatnEoLuEe, OTav allalovpe TIC TIPEC ToL Hue aAlalouv OAa Ta

XPWUATA TNG €IKOVAG. TIC TIEPICTOTEPES POPES, OUWG, BEAOLIE VA SOLAEWOLIE
0€ OLYKEKPIUEVES XPWMUATIKEG oudadeg, alalovTacg yia mapddeyua povo 1a
XPWUATA TOL OLPAVOL KAl TNG BAAACCAG O¢ Wia elKOva, Kal Oxl TA LTTOAOITTA.
MNatwvtag oTo onueio (4) ekei OTTOL aAvaypd@eTal N AéEn Master -kal TToL
TeQINAPPAVEl OAQ TA XPWUATA- TTAPATNEOLUE Mia avadvopevn AioTa e
XPWHATIKEG Opddeg. 'ETOI, yIa TO TTPONYOLUEVO TTAPGSelyua, Ba emAéyaue Tn
XPWHATIKA ouada Blues. AANalovTag Tn BEon TOL KOLUTTIOL EAEyXOL TOL Hue
TIAEOV AAANGZOLY TA XPWHATA POVO OTIC UTTAE TTIEQIOXEG KAl OXI OTNV LTTOAOITIN
ekova. To islo mAéov 1oxLEl Kal yia TIG emAoyég Saturation kai Lightness,
emneealovTal HOVO TA UTTAE XpwUaTd. MAAIOTA, TPA cugavidovtal Ta onusia
(5) kal (6) emAoyég oL TPV ev LTINPXAV 1 ev ATAV evepyoTToINUEVES. To
onueio (5) Topa TALoV ypapel 1950/2250, attd TO XPWUATIKO KOKAO TNG EIKOVACG
24 TAPATNEOLIE OTI ALTEG Ol POIPEG AVAPEPOVTAI OTIC UTTAE TTEQIOXES, MAANIOTA
aLTO QAIVETAI KAl OXNUATIKA OTO YKPI TTACICIO TTOL gupaviletal oTto onueio (7)
oTNVY AV PTTAPA pAivovTal Ta XOWHUATA TTPIV TNV AAAAyR, OTNY KATW prmdpd
QaivovTal Ta XpwUaTa PETA TNV aAAayn. To onueio (6) pe Ta Tpia Eyedropper
Tools pag &ivel Tn duvaToTNTA VA TTPOCHECOLE ) VA APAIPECOLE XOWUATA
oTNV  TEPIOX ] TOL  XPWMHATIKOL KOKAOL TTOL  S0oLAeLovLpE. 'ETol, oTO
TTOONYOLUEVO TTAPASElyUa Ba prmopoboaue va AAAAEoLUE TA XPWHATA TOL
ovPAvoL Kal Oxl TNG BANACCAG KAl AG €ival KAl TA VO KATW ATTO TN XPWHATIKN
oudda Twv Blues, apkei va kaAvaue KAk Ue To Eyedropper Tool- mavw otn
Balacoa. AvTiBeta, To Eyedropper Tool+ cuumeplAaupavel emmmAéov onueia

oTNV EKOVA YIA VA LTTOCTOLV TIG XPWHATIKEG AAANAYEC.

To onucio (8) Colorize 1O XENOIUOTIOIOLUE CLVABWSG CE ACTIPOUALPES
PWTOYPAPieG. ‘OTAV OUWG EXOLHE MIA EYXOWHN (PWTOYPAPIa, PUTTOPOLUE VA
emAEEOLUE Eva xpwua amd Tov EmAoyéa Xpouatog otnv EpyaieioBrkn kai
gvepyottolvTag 1o Colorize, 10 Xpwua eugavifetal TAvV®D OTNV  ekova,
S1aTNEWVTAC TN PATEVOTNTA TWV XPWHATWY TNG EIKOVAG Kal aAAalovTag OAd
TA XPWUATA Of ekeivo TToL emAé€ape. Eivalr cav va eixaue PAAel karmolov
PWTOYPAPIKO PAKO PTTPOCTA aTrd TN pwToypagia pag! Téhog, To onueio (9)
gival éva ocbvoAo aTmod TTPOKABOPICUEVOLS CLVSLACUOLS TIWWY Hue, Saturate

kai Lightness TTou umopoLuE va XpNOIUOTIOINCOLLIE.

AOCKNOEIG:
(1) Avoifte Tnv ekova ‘Duck.jpog' kal eupaviote 170 TTapdbuvpo Hue /

Saturation. AokipdoTe SIAPOPETIKES TIUES Yia Ta Hue, Saturation kai Lightness

Kal SeiTe TIC AANAYEG OTNYV €IKOVA.
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Quick Mask Options
Color Indicates: —
(@) Masked Areas ok ]
(O Selected Areas

Color

. Opacity: |50 | %

Eikova 30: O1 emAoYEG

TOL Quick Mask.

@O Emiire va aMdere Ta Hue, Saturation kai Lightness povo via
XowUaTikh oudada Yellow. Ti TapaTnEEiTe;

o EmAEETE Eva Xppa atto Tov EmAoyEéa XpuaTog KAl epapUOTTE TO TTAVE
oTnV €KOvVa evepyoTrolwvTag To Colorize. Ti TApATNEEITE;

O AokipaoTe TOLC TTPOKABOPICUEVOLE CLVELACHOLS ATTO TO TTEdIO Preset.

Ta pATIa TOL TMPOCWTIOL. EugavioTte To TTapdBuvpo Hue / Saturation kail
AANGETE TO XPOUA TV UATIWV OE YKOI-UTTAE.

i 1
I I
I I
i i
I I
I I
I I
I I
I I
I I
I I
I I
I I
| |
: O Avoicte TV eikdva ‘Eyes.jpog’ Kal OTTOIO EQYTAEIO EMAOYAG BEAETE ETTINEETE :
I I
I I
I I
I I
: :
: O Me TV i8I0 AovIKA EMAEETE Ta XEIAN -E€QIPEVTAC TA SOVTIA- KAl §COTE ¢va :
I I
I I
I I
I i
I I

Quick Mask, AAAayn XpwHATOG HAAAIWY

MOAANEG POPEC BEAOLE VA KAVOLPE AANAYEC OTO XPWUA LAANIGY AvOO TV
péoa o€ ekdveg mTou eme€epyalopacTte. ‘OUWG, N TIEQIOXN TWV HAANIQYV
oLvNBWG Sev eival pia eviaia TTEPIOXN, AANG pia TTePIOXN UE TTOAANEG e€0oxEG. 'ETO,
TA €PYAAEIQ €MAOYNG TTOL MEXP!I TWPEA Yvwpicaue &¢ pac Ponbouvv va

SOLAEWOLE O€ TETOIEG SOCKOAEG TTEQITITATEIG. TN ADCN £PXETAI VA UAG §WTEl TO
epyaAeio Quick Mask (Q) , ToL PpickeTal OTNV EpyaAeioBnkn.

APXIKG, emAEyovTag To Quick Mask yia pia eikova & PAETTOLUE KApia alkayn,
KAl auTo YIaT yia va §0Vue aAAayES Ba TTeéTel va {WYPAPICOLUE TNV EIKOVA LE
EVEQYOTTOINUEVO aLTO TO epyaAeio. Apa, ot SeLTEPN PACN ETTIAEYOLUE TO
TVENO. I& ALTO TO onueio va dievkpivicovpe OTI {WYPAPI(OVTAG HUE TO TIIVEAO
yIa TTAPASEIyUa TN TTEQIOXA TV MOANIQYV, ¢ BAPOovVTAl Ta PAANA JE Eva VEO
XPUA, ATTAC YiveTal eTmIAOY TTEPIOXNS. MOAIC TeAeldooLe avTnh TN Siadikaoia,
amevepyoTTolobe To Quick Mask. Me TNV ATTEVEQYOTTOINGN TOL €PYTALIOL
EXOLV E€TTINEXOEl OAEC OI TTIEPIOXEG TNG €KOVAG €KTOG ATTO  €KEIVEC TTOUL
{wypapicape. Na va KpATHOOLUE TP POVO TNV TTEPIoX TToL {wypPaPicAE

emAéyoLUE atTd TO pevoDL Select < Inverse.

MNa va amo@LYOLUE TNV TTAPATIAVGK SlIadikacia, oTe OTAV ETAEYOLUE PE TO
Quick Mask pia Trepioxr) va emAéyeTal avtn n idia amd TNV apxr Kai Oxl va givail
aLTA TTOL APAIPEITAl ATTO TNV €MAOYr, OTNV EpyaAeioBrkn kdvouue SITTAO
aploTepd KAIK TTAV® OTO epyaAeio Quick Mask. ToTe euaviletal To TTACIoIO
Slahoyou TG Eikovag 30. Ito TAQIcIO auTo, N TTPWTN PLBUICN TTOL &ival KAl N

TTpoemAeyuévn eival To Masked Areas, TTOL onuaivel OTI Ol TIEPIOXEC TTOL
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EMAEYOLUE Pe TO TIVEAO Oa eival ‘masked’, SNAadn KPLUUEVES, eKeiveS TTOL Ba
apaipeboLy aTmod Tnyv emAoyn). H ebTepn pLBUIoN cival To Selected Areas, TTov
onuaivel o1l ol TTEPIOXES TTOL {WYPAPICOLUE PE TO TIIVEAO €ival ALTEC TTOL TEAIKA
Ba emAeyoLV. AKPIPWC aTTd KATW €ival TO XPWUA HE TO OTTOIO ETTIAEYOULUE, TO
TTOOKABOPIOUEVO €ival TO KOKKIVO. AVAAOYA PE TNV EKOVA I0WG XOEIAOTE va TO
aAAAEoupe, €bIKA OTNV TTEPITITON TTOL N EIKOVA HPAG TTEPIEXEI TTOAD KOKKIVO
Xpopa €€ apxNg Kal KAT TéTolo &6 Ba pa PonBoloe va epyacToLPE ELKOAQ.
EmmAéov, vmapxel kal n emAoyn Ttou Opacity, dnAadry n Siapadaveia, e
TTEoeTAOYN TO 50% WOTE VA UTTOPOUVUE VA EXOLHE ETTAPKNA EAEYXO KATA TO

XPWUATIOUO HE TO TTIVEAO.

Edv katd TNV €mMAOYR TNG TTEPIOXNS TV UAANIGYV KAVOLPE KATTOIO AABOG Kal
XPWUATIOOLUE YIa TTAPASElyUa KAl PEQLOG TOL TIPOCMTIOL, UTTOPOLME VA
S510pBCOoLPE TO AABOG UaAC TTATWVTAG TO TTANKTEO X. To TTANKTPO X aLTO TTOL
Kavel gival va aAladel Ta xpwuata Tou foreground pe Tou background. Etol
PTTOPOLE VA oPACOoLE TN AABOC emAoyr {YyEa®ilovTag Kal TTAA TTAV® TNG
Kal  OTav  TEAEIOOLME  ETTAVEQXOUAOTE OTNV  TTEONYOLUEVN KATAOTAON

TTATOVTAG AAAN PIA POPA TO TTARKTPO X.

‘Exoupe TTAEOV OAOKANPGTEI TNV ETTIAOYI TNG TTEPIOXAC TV HAANIGY, AAAG TG
Ba aANd€ovpe To XpwUa; 'Evag TpOTToG gival va TO KAVOLUE WE TIG pHeEBOSoLS
Hue / Saturation mrou €ibape A6n oTnv TMponyoLuevn evotTnTa. ‘Evag &ebTEPOG
Kl TTOAD TTIO €DKOAOC TPOTTOG gival va S0LAEWoLUE Ye Ta Adjustment Layers.

Layer Type Select Filter

Mew

Duplicate Laver. .. —
Delete 4 New Layer
Fename Layer, .. -
Layer Style v Marne: | Calar Fill 1
[Use Prewious Layer to Create Clioping Mask Cancel
Mew Fill Laver »  sold Color... ior: |
Mewy Adjustment Layer ¥ Gradent... Color: | Mone [v]
Pattern... - : _
Mode: |;Soft Light [V] Opacity: %
Layer Mask L4
Yector Mask 4

Create Clpping Mask. Alt+Ctri+G Eikova 32: To mapdBupo Slaloyou Tou Solid Color.

Smart Objects L4

Mew Laver Based Slice
Layers

SKnd =+ & T O O

Group Layers kG

Show Lavers

Soft Light +  Opacity:

Arrange L4

Lock:

Y
L Background

Flatten Image

Eikova 33: To véo Adjustment Layer otnyv
TTEPIOXN TNG KAPTEAQG TaV Layers.

Eikova 31: Ta Adjustment Layers.
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Ta Adjustment Layers cival Layers OT®WG KAl TA OTTOAOITIA TTOL EXOLME
XPNOIUOTIOINTEl WEXP! TEA, EUPAVICOVTAl KAVOVIKA OTNV TTEPIOXN TNG KAPTEAQCS
Layers, pe TN povN Slapopd OTI eV TTEPIEXOLY UECTA TOLG KATTOIA EIKOVA, AAAG
TTEQIEXOLY TTANPOPOPIES YIA TO TI Ba KAVOLV TA pixels TTov PpickovTal oTa Ao
kaTw Layers. Ta Ppiokovpe péca oTo Baoikd Mevold Twv Layers O1mou
vTTapxoLy dLO KLPIEC KATNyopieg, Ta Fill Layers kar Ta Adjustment Layers
(Ekova 31). Ta Fill Layers yepiCouv e &va Xpwua TNV TIEQIOXN TTOL EXOLME

emAEEel, evad Ta Adjustment Layers TooTToTToIolY TO XPWUA TTOL EXOLME ETTIAEEEL.

MNa TNV TIEQITITON TTOL BEAOLIE VA YEUICOLUE TNV TTEQIOXN HE £Va VEO XPWUA
péow TV Fill Layers, emAéyovpe 1o Solid Color. Ito véo TapdBupo SIaAdyouL
(Ekdva 32) mapartnpoLue TNV Tepiox Modes. To onueio autd avagépeTal Kal
TTAAl oTa Blending Modes o6Trwg Ta €idape oe TTponyoLUevn evoTnta. To TTo
KaTAaAANAo Blending Mode via Tnv emeepyacia TV ANV, ekeivo SnAadn
TTOoL Sivel TO MO aAnBogavieg amoTtéeoua, eivarl To Soft Light. EmAéyovtag To,
euaviceral kal TTAAl o ETmAoyEéac XpuaTog, arr’ OTToL JTTOPOUVUE VA OQICOULUE

TO VEO XPWMHA HOAAIGV.

ITNV TIEQIOXN TNG KAPTEAAG TV Layers eupaviletal Topa éva véo Layer Tave
amo TNV ekova pag (Eikova 33). Auto eivarl éva Adjustment Layer oto omoio
paivetal kKaBapd N TTEQIOXN TV LAANIV TTOL EXOLME ETTIAEEEI KAl AKPIPWS SITTAC
TO Xpwpa. Exovpe TN SuvaTOTNTA va TO  ATIEVEQYOTTOINOOLME, VA

TPOTTOTTOINCOLE TO XPWHA ) AKOPN KAl VA TO SIaypAYPOULLE.

I AOCKNOEIG:
I
(1) Avoifte TNV ekova ‘Hairjpg’. Opiote oto Quick Mask Tnv emAoyn

Selected Areas Kal Ue XPNON TOL TIIVEAOL ETTIAEETE TNV TTEPIOXN TGV UAAAIGV.
MNpooBioTe oTnv eikdva éva New Fill Layer totToL Solid Color pe Mode 10 Soft
Light kal opioTe éva véo xp@Pa yia Ta JAAAIA TNG £IKoVICOPEVNG.

(2] Kavovtag xprion Tou History eAate PAuata miow oTo onueio OTTou eixaTte
ETMAEEEl TNV TTEQIOX TV HAANDYV. AOKIUAOTE VA OAAAEETE TO XPWUA TWV
HMAAAIV XPNOIUOTTIOIVTAG TNV TEXVIKN ToL Hue / Saturate.

© Me omoia amo TIC pEBOEOLG BEAETE AMAETE TO XOWUATIOUO TGV HATICV KAl
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Y& ALTO TO pABNua:

Healing Tools

Stamp Tools

MNMpocapuoyEg

XpwuaTog

Healing Tools

Ta Healing Tools eival cuvoAika Téooepa kal Ppickovial oTnv EpyaAeioBnkn
(EkOva 34), kal n Aoyikn TNC opadotroinong Toug cival S10TI XoNOIUOTTIOIoDY
TOLG I610LG AAYOPIBUOLS. Me Ta gpyaAeid ALTA PTTOPOUVLE VA PETOLOAUPOLLE
EIKOVEG, VO aAQaIpéooLUE onUAdia oTo TTPOCWTTO, PLTISES N KAl OAOKANPA
Tatovdl, kal va SlIoPOWOOLUE TA KOKKIVA HATIA. AKOPN, WTTOPOULUE va
APAIPOLE AOYOTLTIA ATTO EIKOVEG N onpEia TTov &€ BEAOLUE VA LTTAPXOLY OTNV
€IKOVA Pag.

= {# Spot Healing Brush Tool

& Healing Brush Toal
&
#% Patch Tool

;\; Content-Aware Maove Tool
iz Red Eye Tool

Eikova 34: Ta Healing Tools.

Spot Healing Brush Tool (J)

EmAéyoupue To Spot Healing Brush Tool (J) kal kAvovupe apioTePd KAK TTAVG
oTNV €KOVA OTO oNuEio TToL BEAOLUE VA SIOEBWOOLUE, AUECWS ETTEPXETAI N
aAAayr). Xpnoigotrolobpe 1o Spot Healing Brush Tool yia emblopBwoeg o€
HIKPEC TTEQIOXEC. ANAG TTAOC AKPIPWS SOLAELEI TO CLYKEKPIUEVO epyaAeio; To
Photoshop kdvel 10 Aeyopevo Sampling, waxver SnAadn pixels mov éxouv
TTAPOUOIO XPWHA PE ALTO TTOL EXOLUE OpiceEl PEoa OTO TTESIO TOL TTIVEAOUL. To
EPYaAEio auTd Exel TPEIC KATAOTAOEIG AeiTovpyiag (Eikova 35). H mpatn eival o
Proximity Match, paxvel va Bpel Tapoduoia pixels yOpw amd Tn TTEPIPETRO TOL
KOKAOUL TOUL TTIVEAOL. H 8e0TEEN cival To Create Texture, Snuiovpyei pia ven e
véa pixels Tov PpickovTal péoa oTtov KOkAo. H Tpitn cival To Content-Aware,
TTOL €ival KAl N TTIPOETTIAEYUEVN, KAl CLVABWG TO APAVOLUE €KEN YIaTI Pag Sivel
éva TTOAD KaAO TeAkG armotédeopua. To Content-Aware mepigxel évav o
€EEAIYUEVO AAYOPIOUO TTOL XPEEIAZETAl TTEQICTOTEQO XPOVO YIA VA ETTECEQYAOTEI
TA KOVTIVG pixels, aAAa Sivel TeAikG éva TTOAD KAAOTEPO aTtroTéAeocpa. H
TTapdueTpog Sample All Layers otav cival evepyomoinuévn ©a wagel va
EVTOTTIOEl OAQ TA TTApPOUOoIa pixels OAwV Twv Layers Tov PpickovTal KATw amod

EKEIVO TTOL epyalopaaTe TN Sedopévn OTIyun.

.& - 1.9 ~ Mode: Normal *  Type: [ Proximity Match " Creste Texture *' Content-Aware

Eikova 35: H umrapa mapapétpwy Tou Spot Healing Tool.

Healing Brush Tool

‘Otav  B¢éAovpe va  emMOIOPOOOOLUE PE MIAC Mia  peyaGAn TEQIOXN  TO
TIOONYOULUEVO EQYAAEIO &€ Pag KAALTITEL yI' auTod TO Healing Brush Tool €ival n

MO KATAAANAN emAoyA. To epyaieio avtd & wayvel avTopaTta va Bpel Ta pixels,
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Preview

Eikova 37: TomrAciolo
Silaloyou Fade.
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OAAG TOUL SivoLpE EUEIC TNV TTEPIOXN TTOL BEAoLUE VA TTEQINAPREI OTNV TTEPIOXN
OTTOL Ba £pyacToLPE. AULTO YIVETAI TTATOVTAC TO TTANKTPO Alt. Tote 0 S¢iKTNG
TOUL TTOVTIKIOD TTQIQVEI TN HOP®N evOG OTOXOUL KAl KAVOLME KAIK Of€ ekeivn TNV
eploxn. Aprvooupue 1o Alt kal Eekivape va {wypaPicoLPE TNV TIEQIOXN TTOL
BeéAovpe va emEIoPOBWOOLE. XTO SEIKTN TOL TTOVTIKIOL guPavileTal TTAPAAANAQ
KAl £évag oTaLPOG, O OTALPOG LTTOSEIKVLEN TA ONUEia ATTO OTTOL TO EPYAAEIO
Traipvel Ta pixels. Eivar onuavTikd kdBe @opd 1oL TTAPE va £mMSIoPBTOLE
éva onueio va EavacemAEyoLue KOVTIVA pixels oTe To epyaAeio va Epel ammod
TOL Ba TA TTAPEI YIA VA TA PETAPERE TNV TTEPIOXN TTROG £MSIOPOWON, WOTE VA

EXOLUE OCO TO SLVATOV TTIO PLOIKA ATTOTEAECUATA.
Patch Tool

To Patch Tool poiadel mapa oAb pe 1o Lasso Tool doov apopd TNV €mmAOYn
TNG TTEPIOXNG TTOL BéAoLE va embIoPBTOoLUE. MOAIG OAOKANPWOOLUE TNV
ETMAOYN TNC TTIEPIOXNG, PEPVOLIE TO SEIKTN TOL TTOVTIKIOL UECT OTO ETTIAEYUEVO
onueio -auTopaTa AAAAlEl N pOPE®N TOL- KAl PE APICTEPO KAIK TTATNUEVO
oépvoupe To TTOVTIKI. MapartnpoLue OT TwEa aAAdalouv Ta pixels , Sivouue
SNAadn TNV TEPIOXN TV pixels pe Ta otroia BEAOLUE VA AVTIKATACTACEN TNV
TPoG emdidpBwon TEPIOXN, KAl A@AVOLUE TO TIOVTIKI. ITNV UTTAPA TWV
TAPAUETPWY TOL gpyaAeioL (EikOva 36) TTapatnEoLuE OTI OTIG ETMAOYEG eival
evepyoTTOINUEVN N Source, TToOL onuaivel OTI N TTEPIOXN TTOL BAa eTTIAEEOLE Eivall
auvTA N omroia Ba AVTIKATACTABE PETA e TNV TTEPIOXA TToL Ba &eifovue e TO
S€IKTN TOL TTOVTIKIOL. MTTOPOVHE OPWS VA KAVOLUE KAI TO AVTIOETO, ETTIAEYOVTAC
10 Destination, ommov n mepioxr) Tov Ba emAéEovue Ba eival ekeivn TTouv Ba
pETAKIVNOE kal ekel TToL Ba TNV apnoovue Ba kavel blend pe Ta pixels Tov

TTPEOUBTTAPXOLV.

Transparent Use Pattern

Eikova 36: H urrdpa mapauétpwy Tou Patch Tool.

MNa &va apkeTd aANBOPAVEC ATTOTEAECUA KATA TO PETOLCAPICUA HIAC EKOVAC,

xpnolgotrolvtag 1o Patch Tool, €ival onuavtikd agol KAvoLPE TNV

| em&I6pBwoN va maue oTto hevoL Edit & Fade Patch Selection... ugavileral

éva véo mapdBupo SiaAdyouv (Eikova 37), oTo ommoio LTIAPEXE N YVWOTNH

Tapduetpog Opacity mou opilel TN Slagaveia. ‘Otav eival oto 100% &xel

QAVTIKATAOTACEI TANPWGS TA pixels TTov éxouue daael, otav eival oto 0% cival n
APXIKA Pop®n TV pixels. MNa va PydAovue éva ammoTéAeoua TToL va poladel
aAnBIvO, N KATAAANAOTEPN emmAoyn Slapdveag eival pia péon Tiur, oTe TO
blending va kpathoel pixels kar amd 1ig SVO KATAOTACEG TV pixels TNg

ETTIAEYUEVNG TTEPIOXNC.
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. l Clone Stamp Taool S

_L Pattern Stamp Tool S

Eikova 38: Ta Stamp Tools.
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Content-Aware Move Tool

To Content-Aware Move Tool poiddel mapa 1ToAb Pe 10 Patch Tool 6cov
apopd TNV EMAOYN TNC TEPIOXNG. Me TO €pyaAeio auTd pmopoLuE va
METAKIVACOLUE TNV ETTIAEYUEVN TTEQIOXN WECT OTO XWPEO TNG €IKOVAC KAl TO
Photoshop avaAaupdvel avtopata va dnuioLeyNoEl vEéa pixels yia va yeuioel
TNV TIEQIOXN TTOL £XEl ATTOKOTIE AdUPAvovVTAg TTAnpogopia amod Ta Pixels NG
YOPW TTEQIOXNG.

Red Eye Tool

To TPORANUA TWV KOKKIVGV HATIOV E&ival yvwoTd TPORANUA Ot QPKETEC
PpwTOoypAPicg. EmAEyovTag 1o Red Eye Tool kAvouue amAd KAIK TTAVG OTO

KOKKIVO PEQOG TGV HATIV Kal To Photoshop avaAaupdavel autouaTta va KAvel

TNV €mMdIOPOBWOoN TWV XPWUATWY KOATOVTAC OAEC TIC AVTIOTOIXEC ATTOXPWOTEIG.

AOCKNOEIG:

O Avoicte TV eikdva ‘Girljpg’ Kal KAVTE Zoom in WOTE VA E0TIACETE AOXIKA
oTo TPOCWTTO. EMAEETE ammO TNV EpyaAeioBnkn 1o epyaieio Spot Healing
Brush Tool kai SokiudoTe va emdIopOoEeTe TNV €IKOVA.

(2] Avoi€te TNV eikova 'Oldman.jpg’ kal pye 10 gpyaieio Healing Brush Tool
SOKIUAOTE VA £TTISIOPOWOETE TIG PITISEG TOL TIPOTWTTOL TOL EIKOVI{OUEVOUD.

(3] AvoitTe TNV eikova 'Bikinijpg' kal pe o epyakeio Patch Tool SokiudoTe va
EMSEIOPOWOETE TNV TTEPIOXN TNG WEONG TNG €IKoVICOUEVNG. M EexATETE KAl TNV
emAoyn Fade Patch Selection cooTe va meTOXETE Eva QPKETA aANBo@aveg
amoTtéAecual

O Avoitre TV eikdvVa 'Animals.jpg’ kai pe To gpyaieio Content-Aware Move
Tool HETAKIVAOTE TO EATTAWUEVO KAYKOLPO OTO KATW Se&i UELOG TNG EIKOVAG.
(5] Avoifte Tnv ekova 'RedEyes.jpg' kal pe 10 gpyaieio Red Eye Tool

S0KIUGOTE va emMEIOPOWMOTETE TA KOKKIVA LATIA OTNV €IKOVA.

Stamp Tools

Ta Stamp Tools (S) mouv Ppickovral oTnv EpyaAeioBrnkn (Ekova 38) 6a
UTTOPOVLOAUE VA TA BEWPENOCOLUE KAI WG Wid IO eEEAIYUEVN EKSOXT TOL TTIVEAOU,
TTOL JAG EMTEETTOLY VA TIAIPVOLWE ONUeEia pIag ekdvag kal va Ta

Eavalwypagilovue oe AANa onueia TNG.

Eotw, yia mapdbdeyua, OT emeepyalOPacTe pia eKOVA TTOL TTEQIEXEl Evav
ovpavd pe obvvepad. Me 1o Clone Stamp Tool (S) 6a umopovoaue va

emMAEEOLUE Eva KOUPATI obpavoL oav seiyua, kal va 1o “Eavalwypapicovue”
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TTAVG OTO ONUEio OTTOL O CLPAVOG éxel TLVVEPA, e€apavi(ovTag Ta cLVVEPA
Kal KAALTITOVTAG Ta pe ovpavo!l ruvenmwg, 1o Clone Stamp Tool avtikaBioTd
pEPN TNG EKOVAG XPNOIUOTIOIVTAC TTPOKABOPICUEVN TINYR €IKOVOOTOIXEIWY
ammo AAAN TTEPIOXN TNG EIKOVAG. Mg TO TTANKTPO Alf TTATNUEVO KAl PE apIoTERO
KAIK ETTIAEYOLUE &va ONPEIO WS TTNYN, €META PE ATTAG KAIK KAl COPOCIUO TOL
TTOVTIKIOL TO Photoshop “Eavalwypapilel” Tnv TTNyN TTAVEK ATTO TO ONUEIO TTOL

BplokopaoTe Kal BEAOLUE VA §10pOBWTOLLE.

To Pattern Stamp Tool (S) lwypagilel xpNCIUOTIOIVTAG TUAUA TNS &KOVaCg

oav porTipo.

I

I

* I
@ Avoite TV eikOVa ‘CoupleOnBeach.jpg’ kal kavovTag xpnon tou Clone I

|

I

Stamp Tool apaipéoTe To Jet Ski amd Tnv eikova.

MpoocappoyEg Xpwpatog

Levels - Curves -Brightness/Contrast

Ye auTh TNV evoTNTa €EeTAlOLUE TTIWG MTTOPOLUE VA TIPOCAPUOCOLUE TNV
TOVIKOTNTA  MIAG  €KOVAG, &NAadn TS SoLAELEl N avTiBeon KAl TTWG

SlopBcovoLpe To contrast oe pia eikova, Pe Ta epyaicia Levels kal Curves.

= 1
Histogram v o= | T———

AvVOiyovTag uia eikova oTo Photoshop ummopoLue va ehéyEoupe Ta emimeda

v Compact View

Al Channets Vew PWTEVOTNTAG TNG ETTIAEYOVTAG TNV KAPTEAQ Histogram amAO 1o BAoIKO Mevou

B v Show Statistics

pevcmecncde Window. ATTO TO KOLUTT TTAv® 6e§iA NG KAPTEAQG ETIAEyoLpe ATTO TO

Close
Close Tab Group

avaduopevo pevoL Expand View kal ammd 1n puBuicn Channels emAéyoupe
e L:.ﬂ:@m Luminosity, SnAaér Tnv évraon tou ewTog (Eikova 39). Me To ypAdgpnua TTou
eupaviletal, otov Afova TV X UETPAPE TNV £VTAoN TOL PWTOG, OCO TIO
apIoTEPS PPICKOUACTE TOCO XAUNAOTEPN eival n éviacon, evad 000 TTo Se§i1d
HETAKIVOLPAOTE ALEAvel N EvTAoh TOL PWTOC. To onueio TeAeiwg apioTepA cival

- Bl 70 LAbPO XPOUA VG TO TEAEIWG SE€Id TO ACTIPO. ITOV AoVa TWV Y UETPAUE

Count:
Parcentile:
Cache Level: 1

TOV apIBuo TV pixels.

Eikova 393&:35:;’& Edv BéAovpe va KAvoLE emMSIOPBMTEIC OTNV £VTACN TOL PWTOG TNG EIKOVAG
pyag Ba yetapovpue amod 1o PevoL oTo Image 2 Adjustments 2 Levels... 01100
Ba eupavioTel To TAdioclo Siahdyouv TnNG Ekovag 40. Ito mAdiclo autd
TTapatnEoLue Tpeg Seikteg. O apioTepog beiktng (0) Seixvel TIC OKIEG, TOLG
XOUNAOLG TOVOLG, O HECTIOG &EKTNG TOLG PECAIOLS TOVOULG, KAl O &eENC
8€iKTNG (255) TOLG LWNAOLG TOVOLC, TA CNUEIa PE TIC AVIAVAKAACEIC KAl
YEVIKOTEQQ TIG TIEPIOXES TTOL €ival TTAPA TTOAL doTpes. KaBe eikova éxel To SIKO

NG 10TOYPAUUC, OTAV OUWC TAPATNEOUVUE TTEPIOXEC HE TTOAD  LWNAR
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[¥] preview

Levels -

Preset:  Default -

Channel: RGB M

Input Levels:

Eikova 40: TorrAaicio
Slahoyou Levels.

Photoshop CS6 - EmiuéAcia: KeAétoou EuTuxia m

ez Ny ==
Presat: Custom - =
Channel: RGB -
(ile Smpoot
[/ Preview
QOutput:
62
—
& a
Input:
£l 104 # # # [show dipping

%) Curve Display Options

Eikova 41: To TTAgicio
Sialoyou Curves.

TIEPIEKTIKOTNTA T LYPNAOLGS ) AVTIOETA T€ XAUNAOLG TOVOLG, TOTE ONUdivel OTI
KATI TTPETTEl va SlopBwaoovpe. Na mapddeyua, otnv Ekova 36 mapatnooLuE
OTa APIOTEPA OTI LTTAPXEN MIA LUEYAAN TTEQIOXN OTTOL TA PIXels EXoLY PNSEVIKN
TIUN, €ival TEAEIG OkoTelva Kal Sev £xovv KABOAoOL TTAnpogopia. Emiong,
BAETTOLUE OTA SeCIA Exel APKETA pixels e oxedOV PEYIOTN TIUF, ALTO CNUAivel OTI
Sev EXOLUE KOBOAOL AETITOUEPEIEC OTNV elkova. EGv obpoLuE TOLS AKPIVOOLG
5€iKTEG, OPICOLUE KAIVOLPIO PALPO, ) avTiBeTa KavoLPIo ACTIPO, KAl
AvaAoyYIKG Bd TTPOCAPHUOOTOLVE OAC TA LTTOAOITTA XPWHATA. ApA OAA ekeiva
Ta pixels ota apioTePd TTOL TIPIV EiXav UNSeVIKA TIUR Kal Sev eixav Kapia
TTANEOPOPIA, THOEA TTALOV £XOLV TTAPEI KATTOIA TIUM, £XOLV KATTOIO APIBUO YIa
PTEVOTNTA. MTTOPOLUE TO i8I0 VA KAVOLWE KAl YIA TOLG PECTIOLS TOVOULG,

otépvovTag Tov &eiktn aploTepd N Segid.

‘Evac AAANOG TPOTTOC YIa va aAAAEoLUE TNV TOVIKOTNTA TNG EIKOVAG, PE aKOUN

MO KAAO TENIKO aTToTéAeoua, Ppioketal oto PevoL Image = Adjustments =2
Curves. Eugaviletal kal AN éva véo mAgicio Siahdyou (Ekdva 41). MaN
apIoTePA KAl &e€1IA TOL I0TOYPAUMATOS eugavilovTal ol Vo SeikTeg TTOL
S€iXVOULV TIC OKIEC KAl TA TTIO PWTEVA ONUEid, avTioTOIXd, TTOL PTTOPOLE KAl
TTAAI VO COPOLPE YIA VA OPICOLE TO KAIVOLPIO PABEO 1) TO KAIVOLPIO ACTIPO.
AKOUN ePgavietal Pia diayovia ypauur, kKaBwc kal 0o Tiuég To Output kal To
Input. Av KAVOLUE KAIK PJECA OTNV €IKOVA KAl COPOLUE TO TTOVTIKI, Ba SoLuE
TOLG SVO APIBUOVLS ALTOLGS vVa AAAAloLY, E TIHEC ATTO TO 0 £C TO 255 -OTTWC
Nén yvwpilovpe 0 gival To pavpo kal 255 To AoTIPO- KAl TTAPATNPOLE KAl £vVa
onueio TAvw oTn SIayVvia ypauur TTou Jag Seixvel TN pwTevoTNTa TOL pixel
TTOUL €Keivn TN OTIYUN Seixvel o SeikTNG TTOL TTOVTIKIOL PAg. MNATWVTAG TTAVE OTN
SlayVvIa YPAUU PTTOPOLPE va SnuiovbpyhooLue &va control point, onueio
eAEYXOUL, OTISATTOTE PpicKeTal TTAVG ATTO TN SlAaywvio Ba éxel oav ATTOTEAeCUA
va avénbei N PwTavOTNTA TOL KAl OTISATIOTE PpPicKeTAl KATW ATTO TN SIAYWVIO
Ba xapunAwaoe N PTEVOTNTA ToL. ETOI, AOITTOV, AV COPOLUE TTPOG TA TTAVE TO
onueio eAEyXoL SNUIOLPEPYOLUE pia véa KAUTIOAN, KAl OAa Ta pixels 1oL
BpiokovTal oTNV TEPIOXN AVAUECA ATTO TN VEA KAUTIOAN Kal TN Siaywvio 6a
avénbei N EWTEVOTNTA TOLS AVAAOYd PE TNV ATTOCTACN TIOL £XOLY ATTO TN
Slayvio. MTTopoLUE PLOIKA VA TIPOCOECOLIE TTEQICCOTEQA TOL EVOG ONUEia
EAEYXOL. ILVABWG, ALTO TTOL BEAOLUE VA KAVOULUE YIA VA TTETOXOLPE KAAN

avtiBeon oe pia eikdva eival Pia KauttoAn Touv va poladel ye 1o ypduua S.

TeNog, ammo 1o pevoL Image = Adjustments vtdpyxouy o1 emAoyEg Auto Levels,

Auto Contrast kai Auto Color 1Tou éxel To Photoshop yia va mpoomabnoel
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Preview

[[] use Legacy

Brightness:

Contrast: 0

Eikova 42: To TAcicio
SlaAoyou Brightness /
Contrast.

agenty  — e

Color Baance
Color Levels: |0 0 0
QN ——— R
M
Yelow = e Ble

© Highlights

Tone Bakance
©) Shadows @ Migtones
Preserve Luminosity
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Eikdva 43: To TAdioio
Slahoyou Color Balance.

Preset: Default - = I

| Output Channel: Red -
Source Channels Flproview
Red: %
Green: 0 %
Blue: 0 %
Total: +100 %
Constant: 0 %

[ Monachrome

Eikova 44: To TTAgicio
Slaroyouv Channel Mixer.

ALTOPATA POVO TOL HE TOLC AAYOPIBUOLS TTOL éxel va Pag Slopbwoel Ta

XPWUATA TNG EIKOVAG.

TéENog, n emAoyn Brightness/Contrast mpooapudlel TN eTevOTNTA KAl TNV
avTiBeon pe £va PAPA HOVOo xwEig SuvaTtdTNTA £MAOYNG OKOLPWY, PECAIWY Kal
avoixTv TOvwv (Ekova 42). Xphowo civar 10 contrast 16icog o€
TTAAECPWTOYPAPIES ) O€ HOLVTEG, OTTOL &gV €ival TAPN TA AELKA KAl TA PALPA

Kar avfavel Tn YeTaLb ToLg avTiBeon.

AOCKNOEIG:

(1) Avoi€te TNV eikova ‘Deer.jpg’ kal gupaviote Tnv kapTtéda Histogram tng
eIKOVAG. EmAEETe amo TN pLBUIon Channels To Luminosity. Ti mapartnpeital
OTO IOTOYPAUMA OXETIKA E TIC OKOVPES KAI PWTEIVES TTEQIOXES; MoL LTTAPXEI N
HEYAADTEQN CLYKEVTOPWON XPWUATWY;

@ Kavoviac xpnon TV Levels alAETe TNV £vIaon ToL PWTOC TNG €IKOVAG
KaBopilovTag TAPAAANAC VEQ ONUEIa YIA TO UALEO KAl TO ACTIPO, KABWC KAl
yid Ta evOIAUECA XPWUATA. ATOONKELOTE TNV €KOVA He VEO OvVoud
‘DeerlLevels.jpg’.

© Avoifte kal TAN TV ekOva ‘Deerjog’ Kal KAvovTac xpnon Tev Curves
KAVTE TIG KATAAANAEG pLOPICEIC WOTe va AANGETE TNV EvTACON TOL PWTOC TNG

€IKOVAG. ATTOBNKELOTE TNV €IKOVA LE VEO Ovoua ‘DeerCurves.jpg’.

Color Balance- Channel Mixer- Photo Filter

H mpooapuoyn xpwuaTikhg icoppoTtriag (Color Balance) Acitovpyei Baoel TG
avTiBeoNg TV XpwUaTWV (EKOva 43). ITo XpwuaTKO KOKAO (EikOva 29) kaBe
XpwHa PAETToLPE OTI €xel TO avTiBetd TOL. To avTiBeTo TOL KLAVOL ¢€ival TO
KOKKIVO, TOL P TO TTOACIVO KAl TOL KITPIVOL TO UTTAE. OTAV ALEAVOLUE TO €va,
pelVETal To AANo. Tia Trapddelyua, av pia ekova éxel TToAL uwp Palovpue
TTEACIVO KAl N €KOVA ETTAVEQXETAI OTA PLOIOAOYIKA TNC XPWHATA XWPEIG va
ETTNEEACTOLY TA LTTOAOITIA XPWHATA. Exovue duvaTdTNTA TTPOCAPUOYNS Of
OKOLPOLG, HECTIOLS KAl AVOIXTOLC TOVOULC KAl KAAO gival va eival eTTIAEYUEVO
10 Preserve Luminosity yia va pnv €xoude avemBLuNTEC AANAYEG OTN
PTEVOTNTA KABWC alalovpe Ta xpwuaTta. Or TIuEG slopBwaong tival amo -
100 £wg +100.

Me Tnv emAoyn Channel Mixer urtopoLUE VA TOOTTOTTOINCOULUE TO XPWHA VOGS
KAVAAIOL avAuElyvOOVTAG Ta TPEXOVTA Xpwuatd Tou (Eikova 44). 'Etol,
UTTOPOULUE VA SNUIOLEPYNCOLPE CWOTOLS ACTIPOUALEOLS KAl sepia TOVOULG.
Y10 Output Channel gmAéyouue TO XpwUA TTOL BEAOLUE VA AVAUEIEOLUE Kal

oAANAloLUE e TO KOLUTT eAéyxouv TIC TIWEC oTa Source Channels. H
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Preview
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@ Fiter: .
@ Color: I:‘

Density: 25 %

Preserve Luminosity

Eikova 46: To TTAgicIio
Slahoyou Photo Filter.

Photoshop CS6 - EmiuéAeia: KaAéroou EuTuxia m

OULYKEKPIYEVN €TTIAOYN €ival XPNOIUN IO TTOAD OTn dnulovpyia TTeEpiepywV
XPWHATWY TTAPA O XPWHATIKES SI0pBWTEIS.
To Photo Filter 8ia6étel OAa Ta PACIKA XPWUATIKA QIATOA TNS TTAPASOCIAKAC

PWTOYPAPIAC aAAG Kal EMAOYNC XpwHaToC (Eikova 45).

O Avoicte v eikdva ‘Butterflyjog’ kai pe Ty emAoyr) Color Balance aAGETe
TN XPWHATIKA IcoppoTia divovTiag TiuéG Color Levels: -35 -89 +66.
© Kavre avaipeon NG TTEONYOLUEVNG EVEOYEIAS KAl SOKIUACTE OTNV €KOVA

TNV emAoyn Channel Mixer yia Ta xpwuaTikd kavaiia Red-Green-Blue.

| Invert - Posterize - Threshold -Gradient Map -Selective Color

oK bl
Reset

(VI preview

Eikova 47: To TTAcicio
Sialoyou Posterize.

-
Threshol
—

= |
([ Reset | M

Preview

Threshold Level:

b

_—

Eikova 48: To TTAdicio
Slahoyou Threshold.

Gradient Map

lfsmment Used for Grayscale Mapping

Gradient Options I
[Clipither:
[C]Reverse

Eikova 49: To TTAcicio
Sialoyou Gradient Map.

‘

Preset:  Defauft . =
colors: [llReds
Cyan: a | [¥] preview
= L
Magenta: 0 %
=
Yellow: 0 %
_
Black: 0 %
=

Method: @ Relative (©) Absolute

Eikova 50: To TAgicio
Slaroyovu Selective Color.

H emAoyr Invert kAvel avTioTeoPr TV XPWHATWY ATTO apvNTIKO a¢ BeTIKO KAl

TO AVTIBeTO.

H emAoyr) Posterize kaBopilel TIG TIUEC PWTEVOTNTAC YIA KABE KAVAN IOG

ekOvag kal Ta Taipialel oto TANCIEcTepo  emimedo  (Eikova  47). 'Etol

SNUIOLEYOLVTAI ETTITTESEC ETTIPAVEIEC OTNV EIKOVA XWPEIC TTOANEG AETTTOUEQEIES.

H emAoyn Threshold mapdyel eikdveg bwnAoL contrast 0oL xAvovTal ol YKEI

Siapabuiceic kal N eikdvaoxnuaTidetal ammd pavPo Kal AcLKO povo (Eikova 48).

H emAoyn Gradient Map emixpwuarilel TNV eikova PACE TOL VTEYKOAVTE TTOL

| ©a emAe€ovpe (EikOva 49). Eival n evToAn yia SNUIOLEYIA XPWUATIKWY EQE TTOL

€ival OPWCS ELKOAQ AVAYVWPEICIUN KAl CLVNOICUEVN.

H emAoyn Selective Color gival ammod TIG MO ONUAVTIKEG EVTOAEG TTOOCAPPOYNASG
XPpwpaTwY (ElkOva 50). MTTOpOoLPE VA ETIPELOLUE HIKQOXQWUATIKES AANAYEC
o€ KGO Eva Ao TA TTPOCOETIKA KAl APAIPETIKA XPWHATA, AAAG UTTOPOLE VA
SOLAEWOLE KAl O€ PALPOLS, ALLKOLSG KAl OLSEETEPOLG TOVOLS. H PLOUIoN
yivetal emeppaivovtag oe kABe XpwUa XWPEIOTA TTOOCOETOVTAG ) APAIPWVTAC
OTO XPWMHA TTOL EXOLME ETTIAEEEI TA XPWHATA TNG TETPAXPWMIAG. ETTIAéyovTag TO
Red, yia mapddeiyud, PmmopoLuE va TTpooBécovue N va agaipéoovue Cyan,
Magenta, Yellow kai Black povo ota kOkkiva onueia. 'ETol, oty eikova pag a
AAAGEOLY POVO TA KOKKIVA XWPEIC va €mnEeacTolY Ta AAAA xpouata. To
Selective Color gival pia evTioAn TToL Ba CLVAVTACOLWE KAl O€ TTOAG Scanners
KOANG TTOI0TNTAG, YIATI QLEAVEl 1| PEIVEL TNV TTOCOTNTA TWV XPWUATWY
XPNOIUOTIOIVTAG TA XOWHATATNG TETPAXPWUIAS. MTTopoLUE va SOLAEWOLE
pe 80O peBodSoLC: 1) Relative: aAlalel TNV TTOCOTNTA TWV XPwUATWY CMYK ot
TTOCOOTA €T TOL CLVOAOL, SnNAadr av aAld€ovpe éva pixel ye 50% Magenta
kal mpooBécovpe 10%, N aAAayn TToL KAvoLpE gival va TTpocBiécouue 5% emi

TOL XPWHATOC, APA CLVOAIKA 55%. ALTN N €TTIAOYN &€V UTTOPEI VA £TTNPEACEN TO
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Eikova 51: To mAaicio
Silahoyou Shadow /
Highlight.

KaBapd AeLKO TO OTTOIO Sev TTEPIEXEI AAAA XPWUATA. ITNV TUTTOYPAPIA TO AELKO
avTioTolxel 0TO 5% CMY evi TO PALEO YIA VA EXEl AETITOUEPEID TTRETTEN va gival
KATw ammod 95% kal yia acpaieia katw amd 90%, 2)Absolute: oe avty TNV

TEPIMTOonN av mpooBéoovpe 10% ot 50% Magenta Ba éxovpue 60%.

Shadow/ Highlight - Variations

To Shadow/Highlight eival n e€eAiypyévn evioAr pLBUIONG TV OKOLPWY,
MECAIWY KAl AVoIXTQV TOVQV (Elkova 51). MTTOPOLUE VA ETTITOXOLUE HIA OXETIKA
KaAr 810pBwon Tou contrast NG ekOvag Xwpic emAoyég. TMpéme va
XPNOIUOTTOIEITAI TIPOCEKTIKA KLUPIWCS OTIC OKIES YIA VA N XOB0LY AETITOUEPEIES
péoca ota okoLPA Xpwuata. To Amount eival o Oykog s16pBwaong, To Tonal

Width gival To ebpog ToviIKOTNTAG Kal TO Radius n éktaon Tng S16pBwong.

Eival évag yprnyopog TpOTToC XPWUATIKAS SI0p0waoNng -OXI HeyAANG akpipelag-
eival Ta Variations (Eikova 52). Me ta Variations éxovue tn SuvatodtnTa
EMEPPAONG O€ AVOIXTOLG, OKOLPOLE KAl HECTIOLS TOVOLG, OTOV KOPECHO Kal
N PWTEVOTNTA TNG EKOVAG. ITNV TTAV® PEPIA gival N apXIKn eikova kal Sittha

BAETTOLE TIG €TTEUPACEIC PAG. MTTOPOLWE VA TIPOCBECOLUE TIPACIVO, KITPIVO,

KOKKIVO, KLAVO, JATLEVTA KAl UTTAE.

Desaturate - Match Color - Replace Color - Equalize

H emAoyn Desaturate agaipe 1a xpouata piag EyXpwpng PpwToypagpiag kal

TNV KAVE AoTTPOPALEN EVE TO LOVTEAO TTAPAUEVE EYXPWHO. ADOTLUXWS OUWG
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e 1] ATTO600N TV YKPI TOVGV ival KATIWG TIECHEVN KAl HOLVTH, gival XPNOoIPO

[ a— C= 1 61av BEAOLUE VO KAVOLHE AOTIPOPALEA KATIOIA TUAUATA TNG pwTOYPAPIag. O
I _ Dji:‘z\; Selection when Applying Adjustment __‘/ o , , , , , ,

e IO OWOTOG TEOTIOG METATPOTING €ival va KAvoLpe Tnvekova Grayscale

fomrmensy (Image = Mode = Grayscale).

Fade m |

- Itnv emAoyn Match Color (Eikova 53) 1o Luminance puBuilel TN pwTevoTnTa.
i R — ALTO TTOL HAG evOIAPEPE KLPIWG eival ooubvdvLacoposg Tou Color Intensity
- (KopeoUOG XpwuaTtog) pe To Fade (opaAd oOPACIUO TNG EvTAONG TOUL

Er—= XpwuaTtog) kai 1o Neutralize Tov kdAvel TO ATIOTEAECUA XPWUATIKA  TTIO

Eikéva 53: To mhaiolo  OLSETEPO.
Slaroyou Match Color.

H emAoyn Replace Color dnuiovpyei pia HAoka o€ XOWUATIKEG TTEQIOXEG TTOL

e oo &S] empéyovpe pe To Eyedropper Tool kal TIG QVTIKABIOTA HE XOMUATA TTOUL
— Selection
[T] Localized Color Clusters

i

0K

SnuiovpyoLUE atod emAoyég Hue-Saturation-Lightness mou Siabétel (Eikova 54).

{ B2 2 o || . Lo : : : : : :
_— Eival apkerd §V0XEPNOTO KAl AVAKPIRES YIATI N uAOKA gival SIoSIAKPITN TTapa TO

Preview

Fuziness:

ot diaBéTel Fuzziness, yiaTi N emAoyn Yivetal BACEl XOWUATIKWY TTEQIOXWY, OTTOTE

ETTIAEYEI KAI TTEPIOXEG TTOL PTTOPEI VA N BEAoLE va AAAAEOLE.

H emAoyn Equalize emavadiavéuel TIC TIWEG pWTEVOTNTAC TWV piXels TNG eIKOVAG

R BpiokovTag TNV TTIO PWTEIVH KAl TIIO OKOLEA TIUA TTPocapuolovTag TeC TNV
Tf’“em W kKAiyaka Grayscale. To TopTelvVO avTIoTOIxEl OTO AELKO KAl TO TTIO OKOVPO OTO
SEPEE i st || MAVPEO. OLOIACTIKA PLOWILEI TN PWTEIVOTNTA TNG EIKOVAG.

Lightness: o i i ——————————————————————————— —————— — —————— —————— —

1
1
Eikova 54: To mhdicio |
Sialdyou Replace Color. :

o o e e S e e e S S S e S S S S S S S S S S S S S S S S S —— —

Apply Image - Calculations

H evtoAn Apply Image Aeitovpyel wg e€RG: SnuiovpyoLue éva véo Layer 1o
TOTTOBETOLUE KATW aATTO TO TPEXOV KAl emmAéyovue Image = Apply Image. H
EVTOAN aLTH @wToypailel OAa Ta Layers 1Tou Ppickovral amd AV Kal

SnuIoLPYEI £va eviaio avTiypaPO TOLS OTO ASEI0 XWPIG va yivouy Flatten.

H evioAn Calculations vmmoAoyilel e pabnuatikd TeOTIO TNV AVTICTOIXIA TWV

pixels 600 KavaAi®V kal cLVSLALEI TO ATTOTEAEOUA O€ Eva KAVAAL

i O Avoicre TV ekdva ‘Wedding.jog’, emAEETe TN yuvaika amo TN pEon Kal
Tave Pe To Rectangular Marquee Tool kAvTe avTiypagn- EMKOANNCN OTE
va dnuiovpynBei Eva véo Layer povo pe auTo TO KOPUATI TNG £KOVAG. ExovTiag
EMAEYUEVO TO VEO Layer mnyaivrial amd 1o pevod Image = Apply Image. Ti

TTAPATNPEEITE;



Y€ ALTO TO PABNUA:

APQipean POVTOL.......

Keipevo
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A@aipeon govtou

H apaipeon ToL EOVTOL PWTOYPAPIGV TTOL £TTeEEPYAlOPACTE Eival Wia TTOAD
ouvnBiouévn Siadikaoia. Ymapxouv Sid@opes UEBodol agaipeons POvVToOL
ammo ekOveG. 'HON &xovue &gl TNV TIIO ATTAR TTEQITITGON OTTOL TO XPWHA TOL
POVTOL gival eviqio Kal £To1 he To Magic Wand Tool urmopoLpe va emAEEOLE TO
POVTO Kal de TNV emAoyn Select = Inverse va emAé€ovhe TO LTTOAOITIO
TTEQIEXOMEVO TNG €IKOVAG KAl VA TO PETAKIVACOLUE PECA o€ KATTOIA GAAN yId

TTEQAITEQ W ETTEEEQLYATIA.

Kamoleg @opég, BOEAOLUE va ETTECEPYACTOVHE EIKOVEG TTOL £XOLV (POVTO ME
XPWUATA TTOL AVAKOLY OTNV iSIa XPWUATIK opada aANa e SiaPabuiocelg
PTEVOTNTAC. L& ALTEC TIC TTEQITITOOEIS TO Magic Wand Tool &¢ pag Pondadcel
OTO VA APAIPECOLUE YPHYOPA TO POVTO TNG EKOVAG. H oudda Twv epyaieicyv
oL pag divouv €5 Tn Abon eival Ta Eraser Tools (E) Touv Ppickovral oTnv

EpyaAeioBnkn (Eikova 55).

Eraser Tool

FikAva RR: Ta Fracer Tanl

Eival n o atrAr ekdoxn TV epyaitiov opnoiyaTtoc, eival n koivr oPHoTea.

Backaround Eraser Tools

To egpyaieio auTd cival To O €EEISIKELUEVO YIA SlAypapr TOL POVTOL HIAC
eikovag. O TpoTTog Aeitovpyiag Tov Background Eraser Tool eival o €EAG: TN
OTIYUN TTOL KAVOLWE KAIK JE TO TTOVTIKI UAC O€ £va pixel ToL pOVTOL TNG EIKOVAC,
TO gpYaAEio evToTidel TN XOWUATIKY OUAda OTNV OTTOIA AVAKEI TO CLYKEKPIUEVO
pixel, oTnV TTEPIOXNA TTOL TTEPIKAEIEI TO TTIVEAO WAXVEl va Ppel TTola pixels avAkouy
oTnV i8I XpWUATIKA opdada kal Ta apaipe. ITn Umded TTAPAUETOWY TOL
Background Eraser Tool ummdpxouy Tpia siapopeTikd €idn Eyedropper Tools, n
emAoyn Limits kal n emAoyn Tolerance (Eikova 56). H mpwTtn pvBuion Tou
Limits, To Discontinuous agaipei 10 1510 Xpwua pe To pixel TTou emAéxOnke Péoa
oTNV TIEPIYETPO TOL TTIVEAOL. To Continuous agalpei To 610 XpPwua TNS YLPW
TTEQIOXNG HE TO pixel TTouv emAéEXONKe, €AV PECQA OTNV TIEQIUETOO TOUL TTIVEAOL
egaviletal Eava To i8I0 XPWUA & AANO ONUEIO TTIO ATTOUAKPLOUEVO, ALTO Sev
aaipeital. To Find Edges, cival pia mmo 1oxvpn ékdoon Tou Continuous,
evtoTiel Kal agalpei pixels Tou Ox1 Ovo gival To éva SiTAa oTo AANO, AAAG
TTEPIKAgiovTal Kal attd T0 810 onueio. H emopevn TTApAPETPOC TG UTTAPAG Eival
170 Tolerance (avoxn). To moocootd Touv Tolerance avagéperal oTo TTOCO

OXETIKA O€ XPWUATIKO €TTiTTeS0 €ival Ta pixels TTov eMAEYOLUE TTPOG ApaipeTn,
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o€ Oxéon Ue Ta pixels Tou TEPIKALIOVTAl YECT OTO TTEQIYPAUUA TOL TTIVEAOUL.
MNpoo@avwg, OCO PEYAALTEQO €ival To TTOoooTO TOoL Tolerance, TOCO

HEYAALTEPN N avoxn, SNAAdH Ta pixels TTov Ba agalpeBoLV.

Limits:  Conbiguous +  Tolerance: 5% | - Protect Foreground Color .Tf

Eikdva 56: H ummapa e€elbikeLpevmv epyaeicov Tou Background Eraser Tool.

H Bacikr Slapopd Twv Tpiedv Eyedropper Tools éxel va Kavel hye Tov TpoTTo
XEIPIoPOL ToL TIVEAOL. H TPpTN emAoyn, 1o Sampling: Continuous kavel
OLVEXWG SelypatoAnyia kabwce cépvouue 1o mIVEAO. H emAoyr) Sampling:
Once onuaivel 011 Ba TTapel dciypa ammd To TTEWTO pixel pia popd povo, amo
eKeEl Kal TTEPA OCEC POPEC KAl va CLPOLWE TO TTOVTIKI Ba éxel KPATACE TNV
TTEWTN PLOUIoON, TO TIPWTO XPWWa ToL emAé€aue. H emAoyn Sampling:
Background Swatch avti va kdvel SeiypatoAnyia xpouaTtog KATolou pixel
AV OTNV €koOva, AauPdvel vTTown TNC CAV XPWHUA TO TPEXOV TOL POVTOL
OTIWC ALTO eguavifetal oTNV  TTEPIOX ) ToL  EmAovéa Xpouatog NG

EpyaAeioBnkng.

Magic Eraser Tool

TO CLYKEKPIUEVO EPYAAEio cival évag ouvdLAoUOS TV Magic Wand Tool kal
Background Eraser Tool. Kavovtag apioTtepd KAIK Ot éva onueio Tou pOVToL
NG €IKOVAC TToL SoLAeLOoLUE, Pe PATel TO pixel TToL KAvaue KAIK TTPOOoTIAOE KAl
Bpiokel OAQ TA TTAEOPOIA XPWUATA KAl TA APAIPE. INUAVTIKA TTAPAUETPOG
gival, OTTWG KAl OTO TTPONYOLPEVO epyaAcio, To Tolerance, n avoxn. To Magic
Eraser Tool ummopoLue va TO XPNOIUOTIOIOVUE YIA VA APAIPOLUE TO POVTO OF
HEYAAEG TTEPIOXEC TNG EIKOVAC, KAl og cLVSLACUO We To Background Eraser Tool
yId TNV AQaiPESn TWV AETITOPEQEIY TTOL ATTOPEVOLY, VA EXOULWE TEAIKA éva

TTOAD YPNYOPO QTTOTEAECUA.

AOCKNOEIG:

(1 Avoitte TIC eikoveg ‘ltaliajpg’ kal 'Pizza.jpg' emAE€Te TOV MO YypPryopO
TEOTIO WOTE VA AVTIYPAWETE TOV PAYEPa TNG ekovag 'Pizza.jpg' péoca otnv
eikova ‘ltalia.jpg’ apaip@vTag Tov AoTIPOo POVTO.

(2] Avoi€te TNV ekdova ‘Caretta.jpg’ kal pe xpnon tov Background Eraser
Tools apxioTe va apaipeite To POVIO TNG EKOVAG. AOKIUAOTE VA APAIPETETE
KOMUMATI TOL POVTOL YOPW ATTO TN XeAWVva pe Tolerance TmpTa 1% Kal EmeTa

100%. T TOPATNPEITE;
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= 4" Pen Tod
; ’\ Fresform Pen Tool
+’\ Add Anchor Point Tool

—"\ Deleta Anchor Paint Tool
I\ Convert Paint Tool

Eikova 57: To epyaheio
Pen Tool.
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H texvikr TNG Quick Mask, TTou TNV éxoupue RGN Sl avaALTIKA O€ TTPONYOLLEVN
evoTnTa, €ival AAAOG £vag TPOTTOG TTOL UAC PonBdel va a@aipoLUE TO POVTO
amo  elkoveg Tou  eme€epyalopacTe. EAv Bédovue  yia TTapddelypya  va
APaIPECOLE TOV oLPAVO aTd pia eKOva, PTTOPOLHPE TTOAD aTAd va
{WYPAPICOLE UE TO TIIVEAO TNV TTEQIOXA TOL OLPAVOL, EXOVTAG ETTIAEYHEVO TO
Quick Mask. ATTO 1O pevoL emAéyoupe Select = Inverse kal TTATOVTAG TO
TIANKTPO Delete pmmopovue va Siaypdyouue Tov ovpavo. Eav dev cixaue kAvel
TNV TEAELTAIA Kivnon, To Quick Mask -Ue TIC TTOOETTIAEYUEVEG PLOUICEIC TOL- Ba
€iXE ETTINECEl ONEC TIC TIEQIOXEG TIC €IKOVAC €KTOC aAmd TOV 0LPAVO, ETOI
TTNyaivovTag amod 1o Baoikd Mevob oto Layer = New = Layer Via Copy 6a
PUTTOPOLOAME VA SNUIoLPYACOLUE &va VEO Layer TToL va TTEPIEiXe OAEG TIG

TTEPIOXEC TNC EIKOVAG EKTOG TOL OLPAVOU.

To gpyaieio Pen Tool (P) cival To TTP®TO TNG opAdacg Tou kal Ppiockeral oTny
EpyaAeioBnkn (Ekova 57). Ma va egpyacTobue o€ €mMimedo  €mAOYr HIAG
TEQIOXNG MECA oTnv eKkOva Ba mpémel va eiéyfovue OTI oTnv  Pmtapa
TTapapétpwy 1oL Pen Tool (Ekdva 58) civar emAeypévn n pvBuion Path

(uovoTttdT), kal Ox Shapes (oxhuata) n Pixels.

ﬁ ¥ Buto Add/Delete Align Edges

Eikova 58: H umrdpa mapapéTpwy Tou Pen Tool.
H Aoyikr) Tou Pen Tool eival 611 Ba TTpémel eueic va KaBopiooLE TO TTEPIYPAUUA
TOL QVTIKEIPEVOL TTOL BEAoLUE va emAé€ovpe péoca amd TNV ekodva. Eav 1o
QVTIKEIUEVO aLTO €XEl KAUTTOAEG, MTTOPOLME VA KPATACOULWE TIATNUEVO TO
apIoTEPO KAIK TTAV® O€ KATTOIO ONUEio eAéyxoL TToL opilel TO gpyaAEio Kal va
TIEQICTPEWOLE TO TTOVTIKI, £€TOT SNUIOLEYOLVTAI ALTOPATA KAUTIOAEG (eival ol
AeyOueveg Bézier curves). AQolL opicouue TO TTEPiyPAUUA, KAvoLpe Se€i KAIK
péoa OE ALTO KAl ALTOUATA euPavileTal éva VvEo pevoL aTd TO OTIOIO
emAéyovue Make Selection..., dnAadn Sivovpe evioAn OAN n oploBeTnuEvN
TIEQIOXA VA UETATOATTEN O€ €TMAOY. ITO TTACQioIO SIGAOYOL TTOL euaviletal, TO
Farther Radius éxel va kavel pye TNV amooTacon oL ©a £xel TO TTEPIYPAUUA, TTOL
oXeSIACAUE, e TNV TEAIKN €TIAOYH. MTTOopOoLWE Kal TTAAI AT TO Baoikd Mevobd
oTo Layer = New = Layer Via Copy va dnuiovpynooupe éva véo Layer TTou
va TIEPIEIXE TNV ETTIAEYHEVN HOVO TTEPIOXN. EAQv éxoupe kAvel Pia TTOAD SLOKOAN

ETTIAOYN, UTTOPOVPE VA TN CWOOLME YIA PEANOVTIKY XpHon péca armod TO PeEVODL
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Refine Edge

Q View Mode
i verr: | ] [] show Radius (1)
= | []show original (P}

Edge Detection
[] Smart Radius

Radius: (= | px

Adjust Edge
Smocth: (P
Feather: (= 0,0 Bx

Contrast: (=

&

Shift Edge: =y g %

Output
[F] pecantaminate Colars

Output To:  Selection -

[ Remember Settings

Photoshop CS6 - EmiuéAeia: KaAéroou EuTuxia m

Select = Save Selection... Tnv emouevn @opd oL Ba avoifovpe TNV &KOVa

pyag, Ba kavouue Select =& Load Selection... yia va TNV avakTOOLLE.

O Avoicte TNV eikOVa ‘Cakesjpg’ kal pe To Pen Tool amd v EpyaeioOnkn

I
I
I
SOKIUAOTE va ETTIAEEETE TO TTEQIYPAUUA EVOG KEK EXOVTAG TTPWTA OPICEl N I
I
pLBUIoN Path yia 1o gpyaAcio. Emera, dSnuiovpynoTe éva véo Layer Touv Ba :

I

I

TIEPIEXEI UOVO ALTO TO KEIK.

AVEEQPTATWC TOL EPYAAEIOL €MAOYNG TTOL Ba XENOIUOTTOINCOULUE YIA vda
OPIOBETACOLUE WG ETMAEYUEVN [dia TTepIoX pEoa OTnV  eKkOva Pag, o
ouvbLACWOG e TN AcTovpyia Refine Edges cival kaBoplioTikdg! H Aeirovpyia
aLTA TTPOCPEPEN KAADTEPN TeXVOAOYia SigpebvNoNGg TV OpiwV PETAED KLPIOL
OEUATOC KAl POVIOL KABWC KAl TOL ATTOTEAEOUATOC PAPKAPIOUATOS Of
AYOTEQO XPOVO. APOUL £XOLUE ETTIAEEEI TNV TTEPIOXN TTOL ETMOLPOLUE ATTO TO
Baoikd Mevou emAéyoupue Select = Refine Edges... kal eggpaviletal To TTACICIO
Slahoyou NG Eikdvag 59. Méoa amo TG pLOUICES TTOL TTAPEXEl ALTO TO
TTAQiCIO  SIGAOYOL, UTTOPOLUE va PLOPICoLUE ETTAKPIPOC TO TIAXOG, OF
OTTOIOSNTIOTE  ONUEIO  KATA  UAKOC  TOL  TTEQIYPAUUATOC  TTOL  £XOLWE
SNUIOLPYNACEI, KAl AKOPN va KAvoLpe slopBroelc TAve ot avtd. Me To Refine
Edge ummopolue va SNUIoLEPYNCOLUE ETTIAOYEG TTOL VA €ival KOPTEG AAAG Kal
OTTAAEG, eKel TTOL XpPelAdeTal, SIATNEWVTAG OAEC, OXedOV, TIG AeTTopépEleg. To
mTAQiclo Siahoyou Tou Refine Edge xwpiletal ot 4 mepioxéc: [1] View Mode:
pag Sivovtal TEPICCOTEPES ETTIAOYEC TTPOETIOKOTTNONG (Marching Ants, On

Layers, Reveal Layer), [2] Edge Detection: 16avikd yia SOCKOAEC €TTIAOVEG,

OTTWC YIa TTaPAselypua Ta PAAAG. EmAéyoviag 1o Smart Radius, n emAoyn
yivetal Aiyo KaAOTEON AANG AV LTTAPXOLY  TTOAAEC  AETTTOUEPEIEC  TOTE
xpelalouaoTe To Refine Radius Tool (To kouuTi oTNV ApPIoTEEN TTALLEA). MNa
TTaPAdEIYUa, £0TW OTI Sev eMAEEQE KABOAOL TTPOCEXTIKG e TO Quick Selection
Tool 1o TTEPIYPAUPA TOL TTPOTWTTOL-CWUATOS KAl £VEQYOTTOINCAUE TO Refine
Edge. Toekdpovpe 10 Refine Radius Tool 10 omoio eival pia Povptoa Tou
XPNOIUOTTOIOVHE YIA VA OPICOLUE TNV TTEPIOX TNV oTToia Ba wdatel va Bpel TIC
AETITOPEPEIEC TTOL  XPEIalOuaoTe. Me OXETIKA peyAAo HEyeBog PoLpToag,
OPICOLKE TNV TTEPIOXM ALTH, KAI TA ATTOTEAECUATA Eival TIOAYUATIKA TTOAD KAAd!

[3] Adjust Edge: MapdueTpol yia TN pLBUICN TV AKUWY TNG ETTIAOYAC HAg YIa

Reset oK

Eikova 59: TotrAcioio
Slaloyou Refine Edges.

uikpodiopBbwoeig. [4] Output: To amoTéAeoua, eKTOC ATTO ETMIAOYR UTTOPEN va
e€axOei PeTalL ANV WG pdoKa, VEO €miTTedS0 N KAl VEo Eyypago. H emAoyn
Decontaminate Colors, agopd Tnv amoxpwon ToL PTopel va éxouv ol

TIEPIOXEC OTNV AKPEN TNG €MAOYNG, AOYW TOL POVIOL OTO OTToIO PpPicCKOVTAl.
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EvepyottoicvTag autr) Tn SuvaTOTNTA ATTAAEIPOLE TO QAIVOUEVO ALTO KAl Ol
TIEPIOXEC QLTEG TTAIPVOLV ATTOXPWOCN CLUPWVA PE TO BEUA £0WTEQIKA TNG
ETTAOYNC.

- 1
@ Avoitte TV eikdva ‘Santorinijog’ KAl SOLAEYTE UE OTTOIOSHTTOTE EQYTAEIO |

I

I
EMAOYNG amto TNV EpyaAeioBnkn yia va agaipécere Tn 6AAacoa kal To vnai :
NG PWTOYPAPIAG. EpyaoTeite TapAAANAa e TN Aeitovpyia Refine Edges. I

Keipevo

H opdda Ttwv epyaieiov ToL Kelpévoyw PpiokeTal oTnv EpyaAeioBnkn kai
epINappavel TEcoepa €idn Type Tools (T), Lo yia opilovTia ypagr Kal 800 Yia
KABeTN (Eikdva 60). Ta VO TPWTA ePYAALIA €ival yia ypa®r, eved Ta SLO
S5e0TEPA AeiITOLPYOLY Ccav Masks. Tl TN Pop@OTIoINCON €VOG  KEIUEVOUD,
XPNOIUOTIOIVTAC &va ammo Ta S0LO TTPWTA £OYAAEIQ, PAG eival TTOAD olkeia
T+ T Horintl Type Too KABOTI JAC TTAPATTEUTIEl 0 OAOLC TOULG ETTEEEQYAOTEC KEIUEVOL. LUVETTQG,

lT Vertical Type Tool , . , . s
orizontal Type Mask Tool UTTOPOLPE va AAAGlOLUE YPAUUATOOEIPEG, OTOUA, PEYEDBOS YOAUUATWY Kal TO

i Vertical Type Mask Tool

Antializing (Eikdova 61). To Photoshop yia va énuiovpynoce éva ypduua

Edva 40: Ta Type Took. xpnoluoTtrolei Yia celipd amo pixels. Ta pixels Ouwg cival TETPAYWVICUEVA KAl JE
TN oLVOECT) TOLG YIA TN SNUICLEYIA YEAUUATWY SNUIOLEYOLY AKUES TTOL
KAVOLYV TA YPAUUATA PN €LavAYVWOTA. MECw TNG TEXVIKAC Antializing 10
Photoshop mpoomabei va aAAAOICEl ALTEG TIC OKUEG TTOOOPEPOVTAC Eva
KOAOTEQO QTTOTEAECUA YIA TNV avAyveOoNn ToL Keluévou. XItnv Eikdova 62
TTAPOLOIALETAl APXIKA TO KEIUEVO HE PEYAAO zoom in Xwpic Antializing, kai
ETTEITA TO ATTOTEAECUA TOL KEIUEVOL KAVOVTAG XPNoN TWV TECOAPWY HeBOSwYV

Antializing TToL TTPOCPEPOVTAI UECEK TOL TTPOYPAUUATOG.

Myriad Pro

Eikova 61: H urapa mapauétpwy Tou Horizontal Type Tool.

H'H.'ltﬂil'l]p m KABe (popd 1oL YPAPOLUE Eva Keihevo, To Photoshop Snuiovpyel auTopaTa

éva kalvovplo Layer otnv kapTéAa Twv Layers ota 6e§id TNg oBovng. Q¢

Fl'l-lﬂﬂil'lﬂp ':5& OvVoUa TOL VEOoL Layer kaBopileTal ALTOUATA TO TTEPIEXOMEVO TOL KEIUEVOL TTOL

Flh I]"|."[I'5-|'II.’.IFI {SE EOWKAEIEl. AeSOUEVOL OTI TO KelUEVO PAG avhkel oTo véo Layer, umopsi va
LTTOCTE OAEC TIGC AAAAYEC TTOL EXOLME SEI UEXPI OTIYUNCS KAl APOPOLY YeVIKA TA

Fhﬂtﬂ!h!pm Layers. MTTOPOLUE VA TO HETAKIVACOULPE, VA TO TIEQIOTREWOLUE N VA TOL

Ph I}t{li.hl:lﬂ {SE aANGEoLUE PEYEOOC. Evag €DKOAOG KAl YPRYOPOC TOOTTOC YIA VA TO KAVOULLE

Eikova 62: Htexviky  QLTO gival va mrathioovpe 1o TTANKTPo Ctrl oTav eival Aén evepyoTToiNuéVo TO

Antializing. , _ , . . \ .
nHang Type Tool. Eugaviletal TOTe £va TTAGIOIO YOPO ATTO TO KEIPUEVO PAG TTOL TTEPIEXE

TA YVWOTA onueia eAéyxou.
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Myriad Pro Bold Co...

[l 12pt

VA Metrics

IT 100%
A2 ppt
T T TT Tr

fi

English: USA

Eikova 63: O KapTEAEG
Paragraph kar Character.
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B 10 va KAvVoLE PLBUICEIC TTAPAYPAPOL T€ EVA KEIPEVO PAG ETTIAEYOLE ATTO TO

Baoikd Mevod Window = Paragraph... omrou eugaviletal véo panel ota 6e§id
NG 00dévng pag (Ekdova 63). Itnv kapTéha Paragraph, otn mpotn ocpd
avagépetal N oToixion TNG TTapaypPdA@oL, OTn Se0TEPN CElPA O E0OXEC, KAl
oTnV TPITN Ol ATTOCTACEIS TIPIV KAl WETA Ao TIC TTAPAYPAPOLS TTOL
emeepyadouacTe. ITNV KapTtéha Character, otnv TE®OTN OPAdA £XOLUE TIC
EMAOYEC YIO AAAQYN YPAUPATOOEIPAG KAl OTUA. XTn SebTepNn opdda eival ol
ETMAOYEC VIO pEyeBog, SIAOTIXO (ATTOCTACN YPAUU®Y PHECT OTNV TTAPAYQAPO),
Kal VO ETMAOYEC yIO TNV ATTOCTACN TWV XOPOKTAPWY PECA OTIC AEEEIC, N
TTOWTN APOPA CLYKEKPIUEVN ETTIAEYUEVN AEEN, evao n &ebTepn Ba Kkavel TNV
OAAQYE YIO OANeC TIC AEEEIC TOL KEIYEVOL. ITNV TEITN OpAdA UTTOPOULUE VA
aAANAEoLUE TO PEYEDOG TWV YPAUUATWY OTOV KATAKOPLPO N OToV OPICOVTIO
aova, avtioTolxa, va UETAKIVACOLMWE TA YPAUUATA TTIAVMD N KATW atmo TN
YPAUUA TIOL YPAPOLUE SNUIOLEYWVTAG SEKTEG 1 €kBETEG, KAl TEAOG va
OAANAEOLUE TO XPOUA TWV YPAUUATWY OTIC TTEQIOXEG TOL KEIPEVOL TTOL EXOULLE
EMAEEEL. ITNV TETAPTN KAl TTIEPTITN OUASA EXOLME va KAVOLUE TTAON PE pia oelpd
HOPPOTIOINCEWY TOL KEIUEVOL, Ol OTTOIEC €ival TIPOKABOPIOUEVES. AKPIRDS ATTO

KATGW PTTOPOLE VA OPICOLWE TN YAWOTA kal To Antializing.

‘Otav BEAOLUE VA YPAWOLPE PECA O€ Eva OLYKEKPIUEVO TTAQICIO o€ pia elkova,
XWPIG TO KEIPEVO PAG va EEPLYEl TTPOC TA APICTERS N TTPOG TA Se€IA, ETTIAEYOLUE
10 Horizontal Type Tool | 1o Vertical Type Tool -avaloya oe molov aova
BEAoLUE VA YPAWOLE - KAI UE APICTEPO KAIK TTATNUEVO TEPVOLE KAl 0piloLlE
TNV TTEQIOXA WECT OTNV OTToIa Ba PPICKETAI TO KEIUEVO TTOL £TOINAlOUACTE VA
YPAWOULME. ME QLT TNV EVEPYEIQ SNUIOLPYOLUE EVA TTAQICIO KEIPEVOL, OTTOL TO
Photoshop ©a mpoomabroel O,TI Keipevo Kal va eicAYOLUE VA TO XWPEETE EVTOG
TOL TTAQICioL. Me Tatnuévo To TANKTPO Cirl utmopoLue va aAAGfouue TIC
81aTACEIC TOL TTAQICIOL, VA TO TIEPICTPEWOLHE N VA TO HETAKIVACOULE. 'ETOI
EXOLUE TOV TIAAPN €AeyXO vyIA TO Keipevo pag. O allayéc amoBnkebovTal

TTATVTAG TO TTANKTOO Enter.

Mia EELTTVN TEXVIKN YIQ VO OPICOLWE EUEIC AKPIPWS TN YOAUUM OTToL Bd YpapEi
TO KEIPEVO, AKOMN Kal av avTh &ev gival evBeia, gival va kKavoue xprnon Tou Pen
Tool (P). Apob opicovue TNV YPauun déca otnv ekova pe 1o Pen Tool,
emAéyouLpe kal TTAAI To Horizontal Type Tool ) To Vertical Type Tool kai Eekivaue
va ypA@ouLue TO Keigevod pag. MapatnpoLue OTI TO KEPEVO aKoAoLOE TN
YOQUUr TOL €ueEic xapdfaue 1AV OTnV €Kova. DLOIKA, PTTOPOLUE VA
KAvOULUE O,TI AAANAYEG €TTIOLUOLUE TTAV® OTO KEIPEVO ALTO, OTTWS AVAPEQAE

MO TTAV®.
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Warp Text

B

stvie: BTN ~

@ Horizontal ) Vertical

Bend: +50 %
—_—
Horizontal Distortion: 0 %
————
Vertical Distortion: 0 %

E——

Eikova é4: ToAcicio
Silaroyou Warp Text.

Fill

Contents

Use: Pattemn -

Custom Pattern: l

Blending
Mode: Mormal -
Opacity: [ %
Preserve Transparency
[C] Seripted Patterns
Brick Fill

iHe

Cancel

Eikova 65: TotrAaioio
Sialoyov Fill.

Stroke...

Inner Shadow...
Inner Glow...
Satin...

Color Overlay...

Pattern Overlay...
Outer Glow...

Drop Shadow...

Bevel & Emboss...

Gradient Cverlay...

Blending Options...

Eikova 66: To pevol 1wV
Layer Styles.

MNapatnpwvtag kal TaAl Ty Eikova 61 6a obue 1o gpyaAeio (Create
warped text). To epyaAeio LTTAPXEl O OAEG TIC MTTAPES ECEISIKELUEVV
epyaAeiwv TV Type Tools, Kal TO XpNOIUOTIOIoLHE OTAV BEAOLUE VA KAVOULUE
TAPAPOPPWON TWV YOAUUATWY. MNATOVTAG ETTAVKD TOL £UPAVIleETal TO TTACICIO
SlaAoyoL TNG Eikovag é4. H emAoyn Style mepiéxel pia oeipd ammd SIa@opETIKA
OTOA  TTAPAPOPPWONG  KEIPEVOL. AKPIPOG atmmod  KATW LTTAPXOLY  TPEIG
mapapetpol. Eival n kAion (Bend), n opifovtia kal n kABeTn kaTtebOLVON TNG
KAUTTOANG TTAVG OTNV OTToid ypdgovTal Ta ypduuata (Horizontal kar Vertical

Destination).

Ta epyaieia Horizontal kar Vertical Type Mask Tool xpnoigotoiobvTal yia va
SNUIOLPYACOLY UACKEG HE HOPPN YRAUUATWY, SNAASA ETTAOYEC ONUEiY TNG
EIKOVAG HE TN HOPON YPAUUATWY. ALTA TA €OYAALIA eival TTOAD XxpNoIUa oTav

BEAOLUE VO SNUIOLEYNOCOLUE KEIPEVO UE YEUIOUA aTTO KATTOIA AAAN elkOva N

v Ao karmolo Pattern. Tia va yepiocovpe TNV TTEQIOXT TTOL ETTIAEXONKE e POPPN

YPOUUATWY, ammd aLTA TA €PYAAEid, e TNV LEN KatTolov Pattern amd 10
Baoikd Mevol emAéyoope Edit = Fill... To mAaicio SilaAdyou Tmou eugaviletal
HOG ETTEETTEl VA YEPICOLUE TNV ETMAeypéEvn TTEPIOX HWEe To Foreground n
Background xpwpua, pe éva AANO OTTOIOSATTIOTE XPWMa f ue éva amd Ta

TTpokabopiouéva Patterns mou pacg mapéxel 7o Photoshop (Eikova 65).

Ta Layer Styles mpoo@épouy oTa Layers TV YPAUUATWY VEES ISI0TNTES KAl VEQ

EPE, SNUIOLEPYWVTAC TEAKG TIOAD  eVILTIWOIAKG  ATToTeEAéopaTa. Ma  va

eupaviocovpe Ta Layer Styles, éxoviag emAeyhévo 1O Layer Tou KeEvou TToL
BEAOLUE VA EPYACTOVUE, EiTE KAVOLUE KAIK TTAVE OTO CLUPOAO ! (Exdva 66)
TToL PpiokeTal OTO KATW PEPLOG TNG KAPTEAQC Layers, cite TTNyaivovpe ammod 1o
Baoikd MevoL Layers = Layer Style kal eugavietal 1o i810 pevou. EmmAéyovTag,
yia mapdadeyua 1o Blending Options eugavidetal 1o TAdiolo SIaAdyoL Twv
Layer Styles, omwg paivetal otnv Ekdva 67. Ao 1o iSlo TAdicio SiaAoyou
uTTOPEN VA Yivel N pLOWICN OAWY TWV eTMIAOYWV TV Layer Styles. MTTopoLuE va
emAECoLUE TTOAATIAG Layer Styles yia 1o Layer mou éxouue €mAECel va

ETTECEPYAOTOVLE.

Edv éxovue epapudoel éva ocuvdvacoud amo Layers Styles Tave oTto Layer Tov
epyalopaoTav kal BEAOLUE AKPIPGOG TA iSIA va TA EQAPPOTOLE KAl € KATTOIO
AANO Layer TNG €KOVAG PAG 1| KATTOIA AAANG EIKOVAG TTOL £XOLPE NEN AVOIXTN
uéoa oto Photoshop, kavoupue §ei KAIK TTAvVe OTo Layer, TTou &xel TIC AAANaYEG,
puéoa oTnv KapTeAa Layers, kal emAéyovue Copy Layer Style, ue 8e€i KAIK Topa

TAvw oTo Layer mou BéAoLE va epapUOCOLUE TNV AAAaY emmIAéyoLuEe Paste
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Layer Style. EVOANQKTIKG, TTATGOVTAC TO TIANKTPO Alt Cépvoupue Ta epé TOL

TOOTTIOTTOINUEVOL Layer TTav oTo Layer TTov BEAOLLE.

e
General Blending
Blend Mode: Normal -
[Tl Bevel & Emb ) -
e Opacity: ==y [l Y% New Style...
[7] contour :
Advanced Blending Preview
Fll opacity: =3 100 %
[T stroke
Channek: [J|R  [(]G B
[7] 1nner Shadow

Knockout: None -

D Blend Interior Effects as Group
[T satin [¥] Blend Clipped Layers as Group

[7] Texture

[T tnner Glow

[T Color Cverlay [] Transparency Shapes Layer
[T Layer Mask Hides Effects
[T vector Mask Hides Effects

[E] Gradient Overlay
[F] patiern overlay
[7] outer Glow

[7] Drop Shadow This Layer: 0

i
Underhying Layer: 0

i

Bend If: Gray v

Eikova 67: To TAaioio Siahdyou Tawv Layer Styles.

I AOCKNOEIG:
I O AnpiovPYAOTE pia vEa ekOva pe avaluon 1024 x 768 pixels Kal eMAEETE VA
éxel aompo Background. Mpdwte 10 Ovoud 0AG KAl KAVTE PJeyAAo zoom in
oTnv ekova. ANAETe TIC puvBuiceic Tov Antializihg kal TTapaTNENOCTE TIG
OANQYEC TGV YPAUUAT®YV. MNa KABe yia pOOUIoN TTOL £PAPUOLETE KAVTE ZOOM
out yIa va UTTOPEITE VA EXETE KAADTEQN ATTOWN YIA TO TEAIKO ATTOTEAECA.
@ Avoicte v ekova 'Invitation.png' kal opioTE WG YPAUHA E0AYYAS
KEIUEVOL TN  KAUTIOAN TOL KAvEl TO TIAVW MEPOC amd TG PEPEGC.
XpnoiyotroiNoTe yI' auTtd To okoTd To Pen Tool. TpdwTe oTN ypauurh auTrh 1O
keiyevo 'Na Cnoetel' kal POPEOTIOINCTE TO KATAAANAG COUQ®VA HE TIG
| TTPOTIUNCEIC COAG.
(3] Avoifte Tnv eikdva 'CoralFish.jpg' kal ypdwTte pye dompa ypduuaTta To
Keipevo 'O kopaAAéviog PLBOOG' pe péyeBog ypaupdtwy Ta 100 pt. Opiote
OTOA TTAPAPOPPWONG Kelpévou To Fish kal Tmeipdre TIG TTapapéTpouvg Bend,
Horizontal kai Vertical Destination yia va éxete 170 KAAOTEQO SLVATO
ATTOTENECUA.
O Avoicte v ekdva 'Partyjog’ Kal ypawTte TN ppdon 'Let's Partyl' oe éva
Layer kal o€ éva &e0TEPO Layer ypdwTte TN ppdon 'Fill free to dance!'. AANGETe
TA XPWUATA KAl TO PEYEDOC TWV YPAUUATOOEIPWY. ETeepyaoTeite EexwplioTd

TIC VO PPACEIC KAVOVTAG XPNon Ty Layer Styles.




\ Shapes

Ye ALTA TNV evoTNTa Ba eetoovue To gpyaAeio Shapes (oxAuarta) kal Ba

o pdBovpe TN Sla@opd PETAEL SIAVLOUATIKWV (vector) kal XapToypAPIKWV

(rasterized) eikOvv.

Ta epyaieia Tdv Shapes Ppiokovial oty EpyaAeioBrikn Kkal €xouv ¢
ouvTopevon 1o Yeduua U (Eikova 68). Ta TévTe TTPWTA €ival Ta TIPOETTIAEYUEVA
OXAUATA TTOL UTTOPOUVLE VA SNUIOLPYACOLUE (0PBOYGVIO TTAPAAANAOYPAUUO
KAl TETOAYWVO HE I XWPIC YWVIES, EANEIWN 1 KOKAO, TTOADYWVO N TPiywVo,
YPAUUN), eV TO TEAELTAIO €ival N ETTAOYA YIA VA SNUIOLPYAOCOLIE TA SIKA UAC

oxnuata (Custom Shape Tool).

KaBwg dnuiovpyoLue éva oxAUa PEca o€ pia ekova, [EENEREEL
@ Rounded Rectangle Tool

TTaPATNEOLHE  OTI  OTNV  KAPTEAG  Twv  Layers -
. . , . , a {T) Polygon Toal
SNUIOLPYEITAI ALTOUATA VA KAIVOLPIO Layer TO OTTOIO [EHRINPAFREN

mepIAapPAvEl TO OXAWA pag. Edv yia mapddeyua .‘ & Custom shape oo
emAéCovue To Polygon Tool 8a énuiovpyrcovue Eva Eikova 68: Ta Shape Tools.
TTOADY@VO TO OTToI0 ©a éxel TOOEC TTALLPESG OCEC dnNAWvEl O APIBUOC OTN
pLBUIoN Sides oTnV PUTTAPA TTAPAPETEWY ToL Polygon Tool. AAAGlovTag, yia

TapAdelyua 1OV TIPOETAEYUEVO apiBud TV Sides oe 3 pmmooLUe va

SnuioLpyoLUE TPiywva. To gpyaicio Line Tool Snuiovpyel YPAUUES, TO TTAXOG
TV Ypauuoyv kabopiletal amd Tnv Trapduetpo Weight oe pixels. Na va
oxedladooupe €LBeieg pe 7o Line Tool kpatdpe Kal TTAAI TTATNUEVO TO TTARKTOO

Shift kar oxedialovpe. Av JAAIOTA KOATOVTAG TTATNUEVO TO Shift kal pe apioTepd

KAIK TTATNPEVO TTEQICTREWOLE TNV €LOEIA TTOL OXeSIAZOLE, ALTN TTEPICTPEPETAI

€ QLTS TO PABNUA: He 45° kaBe popa.
SF - [Shape  z Al - Stroke: 28,06 - = W oopx @ H: opx I:Iv |E'. *‘v ﬁv Shape: —» » W Align Edges
ShAPES..ccvieieiecne 43 , ] ]
Eikova 69: H umapa mapauerpwy Tou Custom Shape Tool.
Paths..ceeeeee e 46

Me 1o Custom Shape Tool ummopolue va SnuioLEYoLUE TA SIKA PAG OXAUATA.

To ev NOYW epyaleio £xel TTAPA TTOAAEC eTTIAOYEG (EikOVa 69). Ag EeKivACOLUE E
TIC PLOUICES OTTWS @aivovial otnv Exkdva 70. H mmptn €mAoyn €ival 10
Unconstrained 1mou onuaivel 0TI YrmopoLPE va AaAAGEoLUE TIC SIA0TACEIC TOL
oXNUATOC TTOL Ba SNUIoLEPYNCOLWE OTIWC EuEic BENoLUE. H SebTEPN eTTIAOYN
eivar To Define Proportions 1mou onuaivel o1l pmmopoLue va aAANAEovpe TIG
S1a0TACEIG PEV, AANG O avaAoyieg TTAATOC TTPOoC LYWOG Ba TTapaueivouy idiec. H
TRITN €mAoyn eival To Define Size TTov onuaivel 6T &€ PTTopoLE KABOAOL va
AAAGEOLUE TIC SIAOTACEIC TOL OXAMUATOC ATTO TIC TTPOETIAEYUEVES, UTTOPOVUE
pOVO va TO PETAKIVACOLUE. H TéETapTn emAoyn eival To Fixed Size, otnv otroia

kaBopilovue eueic amd TPV TIG SIACTACEIC TOL TTAATOLS KAl TOL LYOLC TOUL



B &
‘' Unconstrained
" Defined Proportions
" Defined Size
" Foed Size
Fronn Cantar

Eikéva 70: O1 puBuicelg Tov
Custom Shape Tool.

1‘. {l- Shape: —» - # Align Edges

—nd g
f M)
'—-;-p_p>9 -
‘—h-)-b.—}.ﬁ»

-

Eikova 71: O €mMAOYEG

OoXNUATWY aTro TN PLOUIoN
Shape.

v O MNew Layer
[ Combine Shapes
[7'] Subtract Front Shape
H] Intersect Shape Areas
[ Exclude Owverlapping Shapes

[5] Merge Shape Components

Eikova 72: POOUION OXETIKA e
Ta Layers twv Shapes.

Photoshop CS6 - EmiuéAeia: KaAéroou EuTuxia m

¥ Shape: —s - v A

oxnUaTtoc. TEAog, n emAoyr) From Center, n otroia éxel va KAvel e Tov TROTTO He
TOV OTTOIO HETAKIVOLWE TO oXAUA. ‘OTav auth n emmAoyn €ival TOEKAPIOUEVN,
onuaivel OTI YETAKIVOLUE TO OXAUA peE PAon To KEVIPO Tou, Evw OTAvV Eival
ATTEVEQYOTTOINUEVN ALTA N ETTIAOYI, METAKIVOOUE TO OXAUA PE PAoN TNV TTAVG

APIoTERN YWVia TOL.

ATIO TN Pmmdpa Tapapétpwy Tou Custom Shape Tool kavouue KAIK oTnVv

emAoynn  Shape  (oxAua). Eugaviletar pia  avadvopevn  ANiota e
TTpokaBopiouéva oxhuata (Ekova 71). Matoviag mave OTo €KoVidlo pe To
ypavad PYTTOPOLUE VA ETTIAEEOLUE ATTO TO UEVOD TTOL EPPAVIETAl TNV ETTIAOYN
All ©ooTe va PAETTOLHE CLVOAIKG OAD TA ETOIUC OXAWATA TTOL UAC TTAPEXEN TO

Photoshop.

Ytnv Eikova 72 qaivetral n emAoyrn OTTOL UTTOPOLUE va KABopIiooLuE OE TTIO

Layer 6a eugaviletal kBe popd To VEO Shape TToL SNUIoLPYOUVLE.

To PacIkO TIAEOVEKTNUA TwV Shapes, auvtd mou Ta Kdvel va
SlapEPOLY TOOO TTOAD O€ OXECN HE TIG TTAPASOCIAKES EIKOVEC, Eival

o1l Ta Shapes cival Vectors (SlavoouaTtika ypagika). OTiaxvovTal he

HABNUATIKO TPOTTO KAl ALTO TOLG Sivel KATTOIES I8IOTNTEC KAl TA KAVE

va LTTEPTEPOLVE TTAPA TTOAD O€ OXECN HE TIC LTTOAOITTEG EIKOVEC TIG

Rasterized (xapToypa®ikig). I1o Photoshop pmmopolue va £xovue

Kal Ta Vo ¢€ibn ekovwy, TOoo TIC Vectors 6co kal TG Rasterized, aA\a &¢
UTTOPOLUE VA TIG SOLAEWOLE KATW aATTO TO i610 Layer. Av TTAUE va KAVOLUE pid
TETOIQ EVEQYEID, TO TIPOYPAUUA Bd HAG PWTACE €AV BEAOLUE VA PETATPEWE TA
Vectors o€ Rasterized (mavra n uetatporn eival amd Vectors oe Rasterized
YPAPIKA) Kal Ba Ta YeTATPEWE ALTOPATA. ALTO YiveTal €mAEyovTag To Vector

Layer kal ammd 10 Baoikd Mevoo emAéyoupe Layer = Rasterize & Shape.

AOCKNOEIG:

@ AnuiovpynoTE pia véa eikOva pe avaivon 500 x 500 pixels. IXESIAOTE Eva
TETPAYWVO UE XPWUA YEUIOUATOG UTTAE, TTEPIYPAUUA pol TTaxoLg 10 pixels kal
opioTe TN pLOUIoCN TV Layers: Exclude Overlapping Shapes. AnuiovpynoTe
Eva VEO TETPAYWVO £Va LEOPOG TOL OTTOIOL VA ETTIKAADTITEI TO TTOONYOLUEVO. Ti
TTAPATNPEEITE;

@ AnpiovpynoTe pia véa ekdva pe avaluon 500 x 500 pixels kai pe Siapavo
@ovTo (Background: Transparent). Méoa oTnv ekdova oOxedIAOTE UE TN
BonBeia Tov Custom Shape Tool pia yata. ATToBnkeLOTE TO APXEIO e TNV
emAoyr Save as... wg Vector.psd kal GAAn pia popd wg Rasterized.png.

AVOIETE KAl TTAAI TIC SVO EIKOVEC KAl SNUIOLPYAOTE KAl Wia VEQ pe avaAvon

I ——
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I 1000 x 1000 pixels KAl He AOTTEO POVTO, KAl GOPTE EKEN TIC SO TIPONYOVEVES
eIkoveg. Na 1o kabéva veo Layer TNG elkOvag -kBeva amd 1a SLO CXAUATA-
EMAEETE aTTO TO Baoikd Mevol Edit = Free Transform kal peyaAwote T1a. Ti
TIAPATNPEITE OXETIKA UE TNV TTOIOTNTA TV SVO EIKOVWV;

© Me xonon Tou Custom Shape Tool TOTOL GIAU KAl TG EKOVAG
'‘Couple.jpg’, pmiagte TNV eikova 'FinalCouple.jpg'

- ANUIOLPEYNOTE Hia VEQ EIKOVA pE avAALoN 864 x 864 pixels.

- NepioTe TNV eikdva pe To Pattern 'Washed Watercolor' amd 1nv opdda tawv
Artistic Surfaces (Edit = Fill... kai emAEETe Pattern).

- ANPIOLPYAOTE AKPIPWGS ATTO TTAV® £va VEO Layer Xo@UATOC JAbLEOL KAl e
Opacity 78%.

- Kavovtag xpnon tov Custom Shape Tool oxedidoTe éva oxfua TOTTOL QiAU
TTOL VA KAALTITEI OAN TNV £IKOVA.

- Avoifte Tnv ekova 'Couple.jpg’, kavie Tn acmpouaven (Image =
Adjustments = Desaturate), avriotpéwTte 1N otov opilovTio dfova (Image 2>
‘3 Image Rotation = Flip Canvas Horizontal) kal kpatAoTe TO KOUUATI TTOL
BENETE KOPOVTAG TNV LTTOAOITTN €IKOVA KAVOVTAG XPNon Tou epyaieiov Crop
Tool amo TNV EpyaAeio®nkn.

- ®épTe TNV elkova 'Couple.jpg’ wg véo Layer AV OTNV APXIKA EKOVA TTOL
| SOLAEVETE.

- ANGETE TN oeipd TV Layers av xpelddeTal Kal TTPOoAPUOOTE TNV EIKOVA TOL
CevyaploL Péoa oTo Shape Tou PIA (Edit = Free Transform).

- EmAéyovtag to Layer tng eikdvacg tou {evyapioL dnuiovpynoTe éva véo Fill
Layer tomrov Gradient (Layer & New Fill Layer = Gradient.

- IT0 TMACiclo Slahoyouv opioTe Gradient: Neutral Density, Style: Linear kai
Angle: 152,50.

- EmMAEETE TO PATIA TNG YLVAIKAC PE OTTOIO TPOTTO BEAETE KAl KAVTE TA VA EXOLV
UTTAE XpOa.

- Ndave 6e§d oty akova ypdwte To  Keipevo 'Our Wedding' e
ypaupaTtooepd Palace Script MT, péyeBog ypapudtwv 100 pt kar oTOA
TTAPAPOPPWONG KEIPEVOL TNG ETTIAOYNG CAG.

- EpapudoTte Layer Styles oT1O Keipevo TTOL POANIG ypAwaTte pe TIC €ENG
pLOUICEIC evepyoTToINUEVES: Bevel & Emboss, Coutour, Gradient (mpoTiunoTe
TNV oudda Neutral Density), Drop Shadow.

O AnpiovpynoTe pia vEa ekova pe avaivon 500 x 500 pixels. ATTO T pmapa

TapauéTpwy ToL Custom Shape Tool €mAEETE TO oxXNUA spiral kal KAvTe TO

SIkO cag oxédlo uéoa oTtnv ekova. EmAEETe ammd TNV EpyaAeio®nkn 1o
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» [ PathSelection Tool A

* Direct Selection Tool A

Eikova 73: Ta Selection Tools.

Eikova 74: H kapTéAa Paths.

Photoshop CS6 - EmiuéAeia: KaAéroou EuTuxia m

I Horizontal Type Tool kai TANCIACTE Tov kEpoOoPa OTO spiral, Ba &eite ot |

AUECWG AANACEl N UOP® TOL, EKel KAVTE £va KAIK KAl YOAWTE TO KEIUEVO TAG

i810 pe ottolodnTTOTE OXNUa oxedialaTel).

i i
I I
I I
| |
: TO OTT0I0 Ba AKOAOLOEI TN YpPAUUr ToL spiral. (©a PTTopoLCATE VA KAVETE TO :
i I
I I
I I

Ta Paths (uovortaTa) Ta dnuiovpyovue cLVNBWS e To Pen Tool ) To Freedom
Pen Tool (Eikova 57). Me 1o TpwTO, TO Pen Tool, ammAd KAvoLuE KAIK OTO XWEO
TNG €KOVAG KAl ALTO eV@VEl e €LOLYPAUUA TUAUATA TA CNUEA TTOL TOL
Sivovpe. Eav BéAovpe va KAgioel TO POVOTIATI PAG, OTTAG TTNYQiVOLPE OTO
TTPWTO ONUEIO, OTO S€KTN TOL TTOVTIKIOL EUPAVIZETAl EVAG KOKAOG TTOL LTTOVOEI
TO KAEICIUO TOL HOVOTIATIOV, KAl KAVOLUE KAl TTAOA KAIK TTAVG OTO dpXIKO
onueio. To 8ebTEPO epyaicio, To Freedom Pen Tool, xpnoiyotolsital cav va
nTav Tvéro. Kavouue aploTepd KAIK KAl OEPVOLUE UECA OTO XWEO KAl AvTo
SnNUIoLEYEI Eva POVOTIATI TTOL Sev ATTOTEAEITAI ATTO ELOVLYPAUMA TUAUATA, AAAG

aTTO KAUTTOAEG.

EmAéyoviag 1o Pen Tool mapatnooLue OTI N PTTAPa TTAPAPETPWY  TOL
epyaheiov (Eikdva 58) éxel Tapouoleg pvBuicelg ue ekeivn Touv Custom Shape
Tool (Eikova 69). Autd cuupaivel yiati Ta Shapes gival kal auTd PovoTtaTa,
éTolya amd 1o Photoshop mou 10 610 1O TTPOYPAUUA éxel 1SN TTPOKABOoPICE!.

Apa O,1 Exovue &¢l va IoxLel oTa Shapes, IoxLel kal ota Paths.

ANUIOLPYWVTAG POVOTTATIA PTTOPOLUE Va Ta eTTeCepyalOUAOTE UE TA EQYAAEIa
Selection Tools (A) Touv PpickovTtal oTny EpyaieioBnkn (Eikova 73). Me o Path
Selection Tool pymmopoLuE va emAEEOLE Eva JOVOTTATI KAI VA TO LETOKIVIOOULIE.
Me 10 Direct Selection Tool pmopovue va eme€epyacToVUE TO POVOTIATI,

KAVOVTAG KAIK TTAVG O€ ONUEIQ eEAEyXOL TOL UOVOTTATIO.

Ta povotraTia &¢ yivovTal pépog TG oLVBEONG TNG EIKOVAG €AV SeV EPAPUOOTEI
TAvw ToLG TO Stroke | To Fill. EmAéyovTag Tnv kapTtéha Paths ammd 1o panel
KATw 8¢8I TNG 0BovNnG uag (Eikova 74), ummopoLue va SoLuE Ta PovoTtaTia
TTOL EXOLHE OXESIATE!, TA OTTOIA OUWS PPICKOVTAI TTPOCWEIVA OTN PVAPN TOL

OTTOAOYIOTH) MAG KAl €Kl UOVO!

Na va kavooue Fill éva yovottdT, emMAEYOLUE €iTE TO TTPWTO EIKOVISIO OTO KATW
MEPOG TNG KAPTEAQG Paths gite kGvoupe Se€i KAIK TTAV®W OTO UOVOPATI e OVOUa
Work Path mou eugaviletal otny kapTéAa kal emAéyovpe Fill Path... Eugpaviletal
Kal TTAN TO TTAdiolo diaAoyou Tou Fill (Eikdva 65). Na va kavouue Stroke éva

HMOVOTIATI, ETMAEYOLUE €iTE TO SELTEPO EIKOVISIO OTO KATW WEOLOG TNG KAPTEAAG
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I
I
I Took # Pencil -
il
| [7] Simulate Pressure
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Eikova 75: To mAaicio
Sialovouo Stroke.

Eikova 76: H kapTéAa Brush.

Paths eite kGvoupe 6e€i KAIK TTAV@W OTO PovoudT e ovoua Work Path trou
euaviletal otTnv KapTéAa kal emAeyovpe Fill Stroke... Eugaviletal To TTAQioIo
Slaldyou Tou Stroke (Eikdva 75) Touv pag pwTdel Pe o gpyaieio BEAovue va
EQYAOTOVWE -CLVABWCS XPNTIPOTIOIOVLHE TO TTIVEAO. TO OVOTTATI YeUIlel Xpoua,
KAl JE TIG TTAPAPETOOLG TTOL EXEI EKEIVN TN OTIYUN TO TIVEAO. AANANAZOVTAG AULTEG
TIC TTAPAUETOOLES, UTTOPOLUE VA akoAovBroovue TTAON TNV idia Siadikaaoia yia
va KAvoupe stroke OTO POVOTIATI KAl VA TTAPOLUE Eva TEAEIWS SIAPOPETIKO

ATTOTEANEC Q.

Na va aAAAEOLE TIC TTAPAPETPOLG TOL TTIIVEAOL TTATAUE TTAVG OTO €IKOVISIO E
ammo TN UTTAPA TTAPAUETPWY TOL £pYaAEiov (EikOva 8). AuEcwg, eugavidetal n
KapTéAa Brush ota 6e€id TNG 0BovNng pag (Eikova 76). Le auth TNV KAPTEAd
omapxel Eva TARBOG Ao  SIAPOPEC TIAPAUETOOLS TIOL UTTOPOLUE VA

aAAAEoLUE, WOTE VA TTPOCAPUOTOLE TO TTIVEAO OTIG TREXOLOEC AVAYKEC UAG.

O AnpIcLEYAOTE pia VEQ eKOVA pe avaluon 1024 x 768 pixels. IXeSIAOTE éva

KAEIOTO UovoTTaT Pe To Pen Tool kal dANo éva e To Freedom Pen Tool. Kavte
Fil TO TTPWTO POVOTIAT PE €va XPWUA TNG APECKEIAC oag, kal Stroke 1o
SEVTEPLO XPNTILOTTOIVTAG TO TTIVEAO.

@O AMAGETE TIC TTAPAPETPOLE TOL TIIVEAOL (XPWHA Kal TIAXOC) Kal EavakAvTe

I Stroke yia 1o 6ebTEPO povoTtaTl. Ti TTapaATNEEITE;

(3] Avoifte TIG ekoveg 'Flowers2.jpg' kal 'Butterflyjpg’, amopovoote tnv
TIETAAOLSA KAl CLPTE TN PECA OTNV €KOVA PE TA AoLAoLSIa. Me To Freedom
Pen Tool oxediaoTe éva povottat. EMAEETE TO TMIVENO, SWOTE Eva XpwPa TNG

€mMAOYNG cag kal amd TG Special Effect Brushes emAe€te Tnv meTaAovda.

KavTe Stroke yia 1o povotrat TTov oxeSidoaTe, XoNOIPOTIOIVTAG TO TTIVEAO.




Y€ ALTO TO PABNUA:

Clipping Mask.............. 48

Anuiovpyia Brush kai
Pattern......c.cceveeecens 48

AI6PODOoN SOVTIQV......49

EmmTAéoV XpuaTika

EPYOAEID . ooveererrcerennnnne 50
GoA®vVoVTag
TTEQIOKEG eveevereererrerrereanes 50

EpyaAcia yia 810p0waon
POTEVOTNTAG. . vrevennee 51

Clipping Mask

To Clipping Mask eival éva gpyaleio TToL KpLPEI OpIoUEVa onueia evog Layer
Kal agrvel va @avouv oplouéva alla. OQuolaoTika pe 10 Clipping Mask
KoLPOLUE N agrivovpe va gavel To Layer TTov PPiCKeTAl AKPIPWDC ATTO KATW
amo 1o Layer mmou emeepyalOuacTe. Me Aiya AOyIQ, XPNCIUOTTOIOVUE TO OXUA
(Vector ) Type Layers) 1| Tn diagpaveia (Mask) evog Layer, yia va mreplopicouue
TNV €UPAVION EVOG AAAOL. LLVETTIQG, YIA va xpnolyotonoouue éva Clipping
Mask xpeialduaoTe SVO Layers. To TTPWTO, TTOL Oa TEPIEXEI TO OXAUA (Base
Layer) kal To §e0TEPO TTOL Ba TTEPIEXE! TNV EIKOVA TTOL TO OXAUA Ba TTEPIoPITEl
(Clipping Mask). H emAoyn via Tnv epappoyn Tou Clipping Mask ot éva Layer

Bpioketal oTo pevoLd Layer = Create Clipping Mask.

ACKNOEIG: I
O Avoicte v exova 'OldWindow.jog' Kkai emA(ETE pe TO Rec’rongulorl
I
I
I

Marquee Tool T0 €0WTEPIKO OAWV TWV TTAPABLEWY, SNUIOLPYWVTAG &va

New Layer Via Cut.
- ATTO 1O pevoD File = Place... elcdyetal oTnV TpEXOLOA EIKOVA TNV b
eikOva 'Marriage.jpg', B6a TpéTel To VEo Layer Tou Ba dnuiovpyn-
B¢i va PpiokeTal akpIP@G Attd TTAVK ATTO TO Layer pe To e0WTEPIKO
TTAPABLPWYV.

- 'ExovTtag emAeypévo 1o Layer e Tnyv eikova Tou (eLyapioL TTNYai-
vTeE OTO PevoL Layer = Create Clipping Mask. e
@ AnuiovpynoTe pia via eikdva pe avaioon 500 x 500 pixels kal he AoTTEO |
PovTo. Kavovrtag xpnon tou Ellipse Tool kal mmatviag 1o TANKTPO Shift
oxedlAoTE Eva KOKAO.

- Avoifte TNV ekova ‘Fruits.jog' kal cOPEETE TN OTNV €KOVA TOL KOKAOL -

I
I
I
I
I
i
I
I
|
mP0oot€Te TO Layer Twv ppoLTwY va gival TTave atod 1o Layer Tou oxAPATog. |
I
- 'ExovTag emAeyuévo 1O Layer pe Ta gpovTa TINyaiveTe 0TO Pevoyw Layer = :
Create Clipping Mask. i
- EmA&ETE TO Layer Tv gppoLTwY Kal pe €€ KAIK TTAve Tou kavTe Duplicate I
I

I

Layer. Mg oTTolo8ATTOTE £pYTAEIO €TIAOYNG, €MAEETE ATTO ALTO TO Layer kai

KOATAOTE OVO TA ONUEIA TTOL BEAETE VA TTPOEEEXOLY ATTO TOV KOKAO.

Anpioupyia Brush kat Pattern

ITo Photoshop éxouue Tn SuvaATOTNTA VA SNUIOLEYOLWE TA SIKA PAG
(Brushes) kai bpég (Patterns) kal va Ta ammoBnkebovue TA AEN LTTAPEXOVTA, YIA

HEAANOVTIKN XpNon.
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ACKNOEIG:

O Anpiovpyia Brush: AvoI€Te TNV eKOva 'Robot.png' amd 1o hevoL Image >
Adjustments = Desaturate kavre Tnv ekOva acTipouavpn. Ao To UEVOL
Image = Adjustments = Brightness/ Contrast §coTe akpaqieg TIEG OTE OTNV
EIKOVA VA KLPIAPXOLY TEAIKA TO ACTIPO KAl TO PALEO XPWHUA. Me To Magic
Wand Tool emAéETe Kal SlaypdyTte 6CA onUeid TNG EIKOVAG EXOLY YEUIOUQ,
KQQATNOTE POVO TO PALPO TTEQIYOAUPA TNG €KOVAG. ANAAETE TO EyeBog TNG
€IKOVAG aTmod 1o PevoL Image = Image Size... oTe ALTO VA AVTATIOKPIVETAI
OTO TIPOKABOOPIOUEVO PEYEDOC TOL TIVEAOL Cag. EmAEETE TO Brush Tool kal
ETMAEETE G TPEXOLOA TNV OPASA TTIVEAWY TTOL BEAETE VA ATTOBNKELTETE TO VEO
mvéNo. MetaPeite oTto pevoL Edit = Define Brush Preset... kal dowoTte éva
OVOopa OTO VEO 0ag TIVEAO. To TIVEAO TTIAEOV PPICKETAI HECA OTNV TPEXOLOA
OpAdA TV TMVEA®Y CAG. ANUIOLPEYNOTE Yia VEQ €KOVA e ACTIPO POVTO,
EMAEETE TO VEO OAC TTIVEAO KAl SNUIOLPYNOTE OTAUTTIEG AANGlovTag TOL KABE
POPA UEYEBOG KAl XPUA.

(2] Anuiovpyia Pattern: Avoite Tnv eikova TreeTexture. jpg’ kKal TTPOCAPUOOTE

TO UEYEDOC TNC CLPPWVA HE TO pEyEBOG TTOL Ba BEAATE va &xel TO VEO OAG
Pattern. Metapeite oto pevoyw Edit = Define Pattern... kal éwote éva dvopa
oTn véa 0ag Len. ANPIOLEYNOTE Wid VEa eIKOVA Kal ATTO TO pevoL Edit = Fill...

EMAEETE VA TN YepioeTe Pe To véo oag Pattern.

OLUTTANPGOCOLE TO SOVTI TTOL AEITTEI, KAl OTN CLVEXEID VA KAVOULUE AeLKAVON
OAWV TRV SOVTIQV.

- Emeibn vmmdpyel copueTpia oTOV AVOPWTTO, £TC1 LTTAPXEI OTA APICTEQA OF
HEYAAO PaBUO vTTAPXE Kal TO 610 oTa §¢€1A. 'ETOI, e OTTOIO EPYAAEIO ETTIAOYNG

BENeTE €MIAEETE TO aPIOTEPO SOVTI. ATO TO pevoL Select = Refine Edge

- Kavre Edit & Copy, Edit & Paste kai Edit & Transform = Flip Horizontal woTte
va AQvTIYPAWETE, VA ETTIKOANNCETE KAl VA AVTIOTREWETE TO VEO SOVTI TTOL
Bpioketal TTAéOV O€ éva EexwpIoTO Layer. MeTagepeTte Avtd TO SOVTI OTA Se€Id,
TTAVE aTTd TO OTTACUEVO SOVTI.

- IKOTTOG €ival va TpooBécete oTa €€ HOVO TO KOUUATI TOL SOVTIOL TTOL
AEITTEl KAl OXI OAOKANPO TO VEO SOVT, OTE va &ival 1o aAnBo@avic n

aAAayn). ' autd emAéETe Ao TO PevoLw Layer = Layer Mask = Hide All

-
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

TEAEIOTTOIEIOTE TNV ETTIAOYN CAG. I
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
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- Mg xpnon TOL TIVEAOL EUPAVIOTE HOVO TO KOPUATI TOL SOVTIO TTOL AEITTEl.
- EmA&€Te Ta 800 Layers amd Tnv kapTeAa Layers kal kavTe Se€i KAIK TTAvVE Toug
eMAEYOVTAG Merge Layers.

- EmA&ETe TO Clone Stamp Tool kal kavTe PIKpES emblopBwaec Kal oTa SLO

i 1
I I
I I
I I
I I
I I
I I
I I
I I
I I
I SOVTIa WOTE va paivovTal SIAPOPETIKA PETAEL TOULG. I
I I
: - Mg xpnon touv Quick Mask Tool eTmAEETE OAN TNV 0SOVTOOTOIXIA KAl ATTO TO :
i pevoL Image = Adjustments = Hue / Saturation emAé€te va aAAd&ete TN i
| Xooparikr opada Yellows yia T Aedkavon Twv SOVTIGYV. AGCTE KATd |
I I
I I
I I

TTpootyylon TIWEG Saturation -76 kai Lightness +67. Ti TapaTnEeEiTe;

EmmAéov XpwHatika epyalsia

M = [ GradientTool M To Gradient Tool (G) kal 1o Paint Bucket Tool (G) éxouv va Kavouv de TO
" &, PaintBucket Todl G

Eikdéva 77: To Gradient Tool  kal og cLVSLACHO We TA £pyaAeia {WYPAPIKNG KAl TA QIATPA -TToL Ba SoLE
Kai 1o Paint Bucket Tool. ) ) , , , , .
O KATW- UTTOPOULE VA £XOLUE TTOAD evlagpEépovTa amoTeAéouaTa. To Paint

XPpa. Mg auTd pmmopoLpE va Payoupe, va pridEovus povTa pe Slapabuioelg

Bucket Tool (kovPAG) eival oLCIACTIKA pIa eEeEAIYUEVN POP®N TNG £vTOANG Edit

Presets

h
4 FEPFrg»F = Fill... Tov &iaBetel Blending, Opacity, diathpnon Slagaveag kal RAe
AV Vir ' —

xpnoidotmroivTtag Default dompo, pyavpo, 50% ykpl, Patterns kal Tig TTAAETEG
e Foregound o ackound w | Foreground kal Background Color. O kouvPag kavel Fill pe Sduvvarotnta
el pLBUIoNS Tou Tolerance kal Contiguous wWoTe va PAPEl ETTIAEKTIKA KAl e Oon
Z _Z Teon BéAoLpe. TIOAD onuavTikd gival To Gradient Tool pe To OTToIo PTIAXVOLUE

Stops

vTeEYKpavTE povta (Eikova 78). AiaBétel Default mdpa moAAG og Sidgpopa

XPWUATA KAl OXNUATIOPOVLS TA OTTOIA CLMTTANPWVOVTAI pe PLBUiIcES Opacity

Eikdva 78: To Gradient Tool  kal Blending (Eikova 79). To TTAeovEKTNUA gival OTI UTTOPOLUE va PTIAEOLUE SIKA
kai To Paint Bucket Tool. ) ) ) ,
JAG POVTA UE OTI XPWHATA BEAOLE.

ERMEI B E s M ® Mode:  MNormal s+ Opacity: 100% |~ Reverse W Dither + Transparency

Eikova 79: To Gradient Tool kai To Paint Bucket Tool.

©oAwvovTag MEPIOXEG

Ta Blur Tool, Sharpen Tool kai Smudge Tool (Eikdva 80) pag ponbovve otav

. ‘ Blur Tool
‘ Sharpen Tool

Bélovpe va OOA®OOLUE TEQIOXEC WECA OTnV  €KOvVA, OLOIAoTKA  va

P Smudge Tod UETAKIVAOOLUE TO XPWUA aTmo Wia Tepioxn o€ pia AAAn. Kar ta tpia autd

epyaAeia xpnoiyomoloby TvEAA. To Blur Tool BoAwvel Tnv eikdva, To Sharpen

Eikova 80: Ta Blur Tool, , . , , . ,
Sharpen Tool Tool 6ivel ofuTnTa KAl To Smudge Tool cépvovTag ypnyopa oTa AKPA €vOg

karsmudgeTool  qyrkeuévon  Sivel TV @ioBnong  TNG  Kivnong, AEYETal Kal  EPYaAEio
POLT{OLPWUATOG, OLCIACTIKG TTAIPVEl TO XPWHA KAl TO PETAKIVEL. Me Ta SvO

TTOWTA EPYAAEIQ UTTOPOUVUE VA KAVOULUE HIKOOSIOPOMWOEIG TE KATIOIEG TTEQIOXEG.



-Q. Burn Tool

Q!E, Sponge Tool

Eikova 81: Ta Dodge
Tool, Burn Tool kal
Sponge Tool.
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YTTdpxoLy Kal QIATPA TToL KAVOLY AVTIOTOIXN epyaoia, omwg 1o Blur (ue 6

emAoyEg) kal To Sharpen (ue To Unsharp mask), 01rwg Ba 6o0pE oTn CLVEXEID.

(1) Avoi€te TNV eikova 'Cookies.jpg’, ue To Blur Tool BoAwoTe OAA Ta péPN TNG

EIKOVAG €KTOG ATTO TA WPTMOKOTA. EQv BéAeTe va 6woeTe TNV aicBnon Tng
Kivnong PEoa oTnV €KkOVA OAG UTTOPEITE VA XPNOIWOTIOINOTE Kal TO Smudge

Tool.

Epyalsia yia d10pOwon @wtelvotntag

Ta gpyakeia Dodge Tool (O), Burn Tool (O), Sponge Tool (O) éxouvv va kAvouv
pE TN S10pBwoN NG PWTEIVOTNTAG (Eikova 81). AoLAebOLY e POLPTOES KAl
uTTOoPOLUE Va pwTiocovpe Pe To Dodge, va okoLPLVOLUE Pe TO Burn kal va
ALENCOLPE ) VA PEICOLPE TOV KOPEOHO TWV XPWUATWY We To Sponge. O
KOPEOUOG £xel VO KAVEI PE TNV TTOKVOTNTA TOL XPWUATOC (TTOCO KABAPO eival)

KQl Apalp@VvTaG ToV N eKkova yiveral oxedov actipouavpn.

(1) Avoi€te TNV eikOva 'Deer.jpg’ kal he Ta gpyaleia Burn Tool kal Sponge Tool

S10pBWOTE TNV TOVIKOTNTA TNG EIKOVAG.

ol



Y€ ALTO TO PABNUA:

LiqQuify..ooeeeieieien 52
Filters. .o 52
Frames......coevveeecveeeennns 57

i EKTOG Q11O TIC TEXVIKEG "€TméPPaAONG” O€ PWTOYPAPIEC ATOPWY TTOL £xoLUE &el

£EWGC TOPA HE XPNON TV epyaAeicy TG opadac Healing Tools (Eikova 34) kal
Tou Clone Stamp Tool (Ekova 38), vmdpxel kAl n Texvikh TNG "agaipeong”
KIN@V! H apaipeon kKIA@V ptmmopel eOKOAQ Kal ypriyopd va TTpaypaTottoindei
amo 70 gpyaicio Liquify To omoio evepyoTroieital ammd 1o pevoL Filter = Liquify.
AUECW®C ePavideTal éva vEo TTAPABLPO TO OTToIo cival TO TTEPIRAANOV
emeepyaoiag mou Sivel To ev AOYW epyaAeio, kal TrepIAappavel TARBoG amd

EMTTPOCHOETEG SLVATOTNTES KAl EpyaAcia (Eikova 82).

T
=
=
f=% Load Last Mesh |
e [7] Advanced Mode
D) Tool Options
& BrushSize: [0 [+
Brush Pressure: 100 ||
Pressure

Reconstruct Options

JH| 100%  [v] K

Eikova 82: Ta mapaBupo Tou Liquify.
Me 10 Forward Warp Tool (mavw-apioTepd) eVEQYOTIOINUEVO KAl HE TIC
pLvBuicec TTov PaivovTal SiTAa epyaloPaoTe WS €ENC: Me TO APIOTERO KAIK
TTATNUEVO "OTTEWXVOLUE" ATTO TO POVTO TIPOC TO ECWTEPIKO TOL TWUATOC TTOL
BEAOLUE VA PEIOOLPE TOV OYKO TOL. BAua-PAUa, oTadiakd Kal Pe TTPOCOoXN
oTe va £€A0PAAIfoLUE CLVEXWDG Eva AANBOPAVEC ATTOTEAECUA, HEIVOULLE
oT1adiakd Tov OYKO.

(1) AvoitTe TNV eikdva 'QueenLatifah.jog’ kal pe 1o gpyaAcio Liquify peicoTe

TOV OYKO TOL OWUATOC TNC YVWOTAG TPAYoLSICTPIAG KAl NOOTToIoL.

Filters

Ta TTePIcCOTERA PIATOA XPNTIUOTTIOIOLVTAI YIA TN SNUICLEYIA £PE KAl YOAPIKOV.

Na va 1a xpnoluotroinooupe & xpeidlovTal €SIKES YVOOEIC, XPeAleTal aTAd
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F”’"’ Window _Fielp — XOOVOC YIA TTEIPAUATIONO KAl PTTOPOVHE VA £XoLuE alloTTPETTH amoteAéouaral
PSS To TPORANUA pE TA PIATOA gival OTI TA ATTOTEAECHATA TOLG O€ YEVIKEG YOOAUMES
Filter Gallery... gival avayvwpioiua kail koiva Adyw TnG TTOAAAGS xpnong. QoToco, KATTOIA UAG
Adaptive Wide Angle... Shift+ Ctrl+ A
Lens Correction... shift+Ctrl+R | SIELKOADVOLY OTO VA KAVOLWE YPNYOPA OKIEG, KOLUTTIA, obvvepa, KTA. OAa Ta
Liquify... Shift+ Ctrl+ X
Oil Paint... PiATPa PpickovTal KATw aTod 1o Yevoy Filter (Eikova 83).

Vanishing Point... Alt+ Ctrl+V

Blur | Ao TNV emAoyn Filter = Filter Gallery... petapaivovpe 010 MApABLEO TNG
Distort L4

Noise » | EkOvag 84. ESw umdpxel éva TANBoG amod @iATpa opadotoinuéva o€
Pixelate L4

Render v | kaTnyopiec. EmAéyovrag orolodnmoTte amd autd oto &gl pépog TOoL
Sharpen 4

Stylize » | mapaBopouv  eugavifovial  of  TTAPAUETPOI  TOL  TTOL  PTTOPOLWE VA
Video 4

Other v | ToOTTOTTOINCOLUE TTEPAITEPW. TEVIKA, TA PIATPA TTOL AVAKOLV OTIG KATNYOPIES
Digimare * | Artistic, Brush Strokes, Distort, Pixelate, Sketch, Stylize kai Texture eivar xprjolua
Erowse Filters Online...

oTn SnuIoLPYIa POVTWY KAl EPE.

Eikova 83: To pevoo Filter. SEEEE——————,—,—8,—,,
Dry Brush (100
+ |¥ [ Artistic = 2 —OK
- Reset
Dry Brush -
) | Brush Size 2
3
Brush Detail 8
&
Texture 1
&
Sponge. Underpainting Watercolor
D (3 Brush Strokes ® [oryBrusn
> (3 Distort
D (3 Sketch
> (3 stylize
D (3 Texture
D 1% [ < ) il 8 &

Eikova 84: To mapaBupo Tou Filter Gallery.

YTn ouvéxela Tou PevoL Filter, Ta @iATpa Blur xpnoiuebouy yia va BAuTTOOoLY
TNV €IKOVA 1) hia reploxn. Ta giATpa Noise eival TToAD XpNoIUa O€ TTEPIOXES TTOL
Exouv xaBei ol TOPOI KAl paivovTal WedTIKEG. O BOPLPOC AVTIOTOIXEI OTOV KOKKO
TOL QIAU. Tla TTapdadeyua, 7o eiATpo Dust & Scratches agaipei KOKKOLS Kal
YOQTOOLVIEG, GAAG BEAel TTPOCOXN YIATI AV TO TIAPAKAVOLUE TO TEAIKO
amoTéAeCUa Ba aiveTal YeLTIKO. ITA PIATOA Render pmmopoLue va §OOLUE
wevToTPISIACTATN CioBNON, va PTIAEoLHE COVVEPQ, EPE PAKWDV HE KNAIGEG TOL
Newton pe 10 Lens Flare, kal va aAAd€ovpe 10 @ws e To Lighting Effects. To
PiATpo Unsharp Mask, Tng oudadac @iATpwy Sharpen, 1o xpnoIUoTToIoLUE O€
OAEC TIG EIKOVEC PAC YIA VA ToLG Scooupe 0ELTNTA. ToWC gival TO TTIO XPNTIUO

PIANTPO Kal €xel TPIG puLBuiceg: 1) Amount: Tmoocotnta 6fuvong, 2) Radius:
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kaBopilel To TTANBOG TV pixels, kal 3) Threshold: kaBopilel TNV opoIOTNTA TV
pixels. H xpnon Twv puBbuicewy TToIKIAAEL. [ToANOI LTTOCTNEICOLY OTI TTPETTEl TO
Amount va @Tdvel peydAa vovuepa (Edg 170) kal To Radius éwg 2. To
Threshold kvpaivetal otaBepd amd 0 €wg 1. AANoI vmmooTnpilovy OTI TO
Amount Ba mpémel va ¢Tavel ¢wg 50 kal To Radius £ég 4. O Mo CwWoTOC
TPOTOC ¢eival va koimdue TO Preview Tng  ekOvVAC ©OTE va NV

TTAPAUOPPWVOVTAl TA OPIA TWV AVTIKEIWEVWVY PAC KAl N eKOVA yivel okAnpen,

KAAO gival va Pdalovpue epiocodTePo Amount kail AiyoTepo Radius.

(1) Avoifte TNV elkOva '‘Moto.jpg' kal dnuiovpynoTe &va avriypago Layer
(Duplicate Layer). ANAETe TO Blending Mode Tou véou Layer oe Vivid Light
kal TathoTe Ctrl+l (Invert). Ao 1o pevou Filter = Blur = Surface Blur opioTe
Radius 50 kai Threshold 40. MatAoTe Ctri+Alt+Shift+E yia va dnuiovpynoete
éva véo Layer pe evoopaTtopéiva OAa Ta amo KATw Layers. ATievepyoTToINoTeE
TO Layer mou o@mAEate IO TIPIV, KAl ETMAEETE TO TEAELTAIO Layer TTOL
Snuiovpynoate. AANAGETe 1o Blending Mode Touv oe Overlay. ATTO TO HevoL

Images 2 Adjustments 2 Shadows/Highlights puBuioTe:

=
Shadows/Highlights

— Shadows

OK.
a ance!
Tonal Width: 50 |% | (Lloadw.] |f

2

Radius: 30
[preview @\

>
&

Highiights
Amount:

Tonal Width:

Radius:

 §

Adjustments

Color Correction:

Midtone Contrast:

Biack Clip:

White Clip:

TéNOG, xaunAooTe To Opacity Tou Layer mepimmov oto 80-70%.
@ Avoitte v ekova Nightjog' kal dnuiovpynoTe éva aviiypago Layer.

EmAEETE TO VEO Layer kal Tnyaivete oto pevoyL Filter = Blur = Gaussian Blur,
pLvBuioTe To Radius ota 18 pixels kal xapnAwoTte To Opacity Touv Layer oto
Bl 55%. AVOIETe TNV eikdvVa 'Drops.jpg’ Kal TOTTOOETAOTE T €MAVR aATTd OAA Ta
Layers. AAGETe 1O Blending Mode autob T1ouv Layer oe Hart Light.
ANUIOLEYAOTE Eva VEO KevO Layer TOTTOBETAOTE TO €AV ATTO OAA TA Layers.
EmAEETE €va palakd TmvéAo oTta 250 pixel ue Aompo xpoua kal PawTte

TIEPILETPIKA KAl OXI OTO KEVTPO TOL TO KevO Layer. Mnyaivere oTo pevoL Filter =

|

54
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I Blur & Gaussian Blur kai pvBuioTe To Radius ota 10 pixels. AAGETE TO

Blending Mode Tou Layer o¢ Soft light kal xaunAcwoTte To Opacity oto 70%.
© Avoifte v ekova 'Bridge.jog' kai TNydiveTe amo To pevod Image >

Adjustments = Shadows/Highlights puBuilovtag Shadows kai Highlights oto
3 A 50%/ NatnoTte Ctrl+J yia va avTiypAweTe TNV eikOva oe eva véo Layer. EmAe€Te
o | To veo Layer kail TTnyaiveTe ammo 1o PevoL Image = Adjustments = Black and
: White emAéyovriag Auto. AMNAETe To Blend Mode Tou Layer oe Hard Light.
EmAé€Te To Background Layer matnote Ctrl+J yia va SnUIoLEYNOETE Eva VEO
avriypa@o Layer. TomoBet\oTte 1O Vvéo Background Copy Layer tou
SNUIOLEPYACATE WC TTIPWTO £MAV® aATTO OAA Ta Layers. Me emAeyUévo TO

Background Copy Layer minyaivere amod 1o pevouw Filter = Blur & Gaussian

Blur puBuioTte 10 Radius ota 40 pixels. TEAOG, aAAaTe TO Blend Mode Tou

Layer oe Soft Light.

Layers
Dind | = o T O 8

- % O Avoicte TV eikOVa 'Alps.jog' Kal SNUIOLPYATTE TEIA AVTIYPAPA
h / i Layers kal Ta ovoudaoTe 1a Overlay, Color kal Relief. TorroBetroTe
Ta Layers pe TN oeipd Omwg Seixvel n SITTAAv eikova. ETTAEETE TO
| Layer Overlay kai TTnyaivere oto pevou Filter = Filter Gallery -
| Artistic & Cutout kai puBuioTe: Number of Levels: 8 Edge Simplici- [

ty: 5 Edge Fidelity: 1. EmAe€Te TO Layer Relief kal amd tov EmAoyea

XPUATOG YIa TO TpEXoV Layer emAEETe padpPo Xpwua yia To Foreground
Color kal acmpo yia 1o Background Color. MNMnyaivere oto yevoo Filter = Filter
Gallery & Sketch 2 Bas Relief kal puBuioTe: Detail: 12 Smoothness:4 Light:
Left. EmAEETe TO Layer Color kal aAAd€te To Blending Mode oe Color. Mg
mmaTnuevo 1o Cirl emAéETe Ta Layers Color kail Relief, kal pe e€i kKAIK TGV TOLG
emAEETe Merge Down (7 evaAllakTikd Tathote  Ctrl+E), yia va Ta
ovyxwvevoete. EmAEETe TO Layer Color mou Snuiovpyndnke amod TNV
OLYXWVELON KAl TINyadiveTe oTO WevoyL Filter = Filter Gallery = Artistic =
Cutout kal puBuioTe: Number of Levels: 8 Edge Simplicity: 6 Edge Fidelity: 1.
EmAEETe TO Layer Overlay kal aA\aETe To Blending Mode oe Overlay.

O Avoitte v ekova HotEffectjog’ kal Tnyaivere oto pevod Image >

Adjustments = Hue / Saturation kai emAé€Te Colorized, émmeita puBuioTe Hue:
+205 Saturation: +40 Lightness: +10. (a) AnuioLPYNOTE Eva AVTiYPAPO TOL
Layer, emAEETE TO VEO Layer, TTnyaivete oTo pevo Filter = Blur = Gaussian Blur
kal opioTe Radius 3,5 pixels. ANAETe TO Blending Mode Tou Layer oe Overlay
kai rathoTe Ctrl+E yia va cuyxwveboete Ta Lo Layers. (B) AnUIoLPYAOTE Eva
avtiypa@o Tou Layer, emAEETE TO VEO Layer, TTnyaivete oTo Pevoy Filter = Blur

- Motion Blur kai opicTe Angle: -90 kai Distance: 40 pixels. AAMGETE TO

SN}



Layers
Prd 2 O T O 5

Darken &+ Opacty:  100%

lock: B o & @& All:  100%

O - Layer 3
] :;gi Layer 1

o |
’h‘ Background copy
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'Blending Mode Ttouv Layer oe Overlay kai mathote Ctrl+E yia va

ouyxwveLoeTe TA SLO Layers. (Y) ANUIOLPYNOTE £va VEO KeVO Layer kal yeuioTe
TO Ue AOTIPO XPWHA, aAAdETe TO Blending Mode tou Layer oe Overlay. (8)
AnUIoLPYNOTE Eva VEO KeVO Layer Kal YeuioTe TO Ue Xpwua 000099. PuBuicTe
woTe 010 Foreground Color va éxete xpwua 000099 kar oto Background
Color xpwua acmpo yia 1o Tpéxov Layer. MNnyaivere oto pevoyw Filter >
Render = Clouds. AAGETE TO Blending Mode T1ou Layer oe Overlay. (g)
ANUIOLPYAOTE £va VEO KeVO Layer Kal YEUIoTE TO e ACTIPO XPWHA, AANAGETE TO
Blending Mode Ttou Layer ot Difference. ({) AnuiovpynoTe éva avTiypago
TOL Background Layer kal TOTTOBeTACTE TO OTN CelPda TToL Seixvel N SiITAavn
elkOva. ANAETe To Blending Mode Tou Background Copy Layer og Darken.

O AnuiovpyNoTE pia véa ekova pe avaloon 500 x 300 pixels KAl YEIOTE T pie

dompo xpwud. Ito Foreground Color PdaAte xpdopa 0095DA kal OTO
Background Color xpwua FFFFFF. Mnyaivere oto pevoyw Filter = Render >
Clouds. AnuIoLPYAOTE £va VEO KeVO Layer kal ovoudoTe To wave. EmAEETe To
Rectangular Marquee Tool kal pe emAeypévo 1o Layer wave emAEETe TNV
EIKOVA amo TN péEon kal KAatw. EmAEETe To Gradient Tool, apnoTte 1a S0

xpwuata yia Foreground kal oto Background Color 6T1e¢ 1a puBuicaTe 1o

,‘ PRIV KAl epapuodoTe Gradient otny €mAoyr cag kal ammoemAéCTe (Select =

Diselect). Me emAeypévo 1o Layer wave tinyaivete oto Pevou Filter = Distor =
Ripple, pvBuiote Amount: 999 kai Size: Large. Itn CLVEXEID, ATTO TO HEVOL
Filter = Distort = Rippler puBuiote Amount: 999 kai Size: Medium. TEAOG, OTO
pevoy Filter & Distort 2 Twirl emAé€te Angle: 226. Mmopeite va e€ehifete TNV
EIKOVA Oag SNUIOLPYWVTAG £&va VEO Kevo Layer kal Pe AOTIPO XPWHA OTO
Foreground Color emAéETE KATAAANAG oxnuaTta ammo To Custom Shape Tool
KAl oXeSIAOTE.

O Avoitte v eikdva 'WomanFace.jpg' kai aAdETe 1o Color Mode oe Lab

amd 10 Image = Mode = Lab Color. AnuiovpynoTe éva avriypago Layer
Sivovtdg Tou TNV ovopaoia retouch kal aAAaETe To Blend Mode oe Soft Light.
EmAéETe TO Layer retouch kal amd 10 pevod Image = Apply Image...
pLBuioTe Layer: Background Channel: a Invert: ox emAeyuévo Blending: Soft
Light. Mnyaivete TTaAl oto pevoL Image = Apply Image... kal puBuioTe Layer:
Background Channel: b Invert: oxi emAeyuévo Blending: Soft Light. Mnyaiverte
oT1o pevoL Image 2 Adjust & Hue/Saturation kal opiote 010 Hue pia Tiun
amo -10 éwg -20. EmAEETe TO Layer TNG apXIKNG eikovag (Background Layer)
kai rathote Ctrl + Alt + ~ émmeira Ctrl + J yia va RAAete TNV emAoyn o€ SIKO TNG

Layer. EmAEETE TO Layer TnG emAoyng aAlalovtacg 1o Blend Mode oe Screen,

56
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I xaunAcoTe To Opacity HETafd 20-40% kai oo 10 pevoL Filter & Blur > |

Gaussian Blur puBuioTe To Radius oe 4. ALDTA N TEXVIKA AEITOLEYE KAALTERA

TTOAAG PWTEIVA CNUEia OTO §EPUA.

i i
I I
I I
| |
: OTA TTOPTEETA, AAAA KAl Ot OAOCWUEC PWTOYPAPIEC O OTToiEG Sev EXOLYV :
i I
I I
I I

Filter Frames

AvoIifTe TNV ekOva 'Leopard.jpg'. ZekAeS@OTE TNV €IKOVA Pe SIMTAO KAIK OTO
Layer TnG. AnuiovpynoTe £va vEo Kevo Layer kal YepioTe TO e ACTIPO XPWHA N
OTTOI0 ANNO OEAETE KAl TOTTOBETAOTE TO KATW atTd TO Layer Tng elkOVAG. Me TO
epyaAeio Rectangular Marquee emAEETE TNV TTEQIOXN TNG €IKOVAG TTOL Bd
TTapapeivel TEAKA eviog ToL TAAIciov (Frame) T1Touv B6a SNUIoLEYNOOULLE.
ANUIOLPYNAOTE Pia PUAOKA e KAK oTo Add Layer Mask oT1o KATW PEPOC TNG
KAPTEAQC TV Layers. Me emAeypévn TNV JACKA ToL Layer TTNyaiveTe OTO peEVODL
Filter = Filter Gallery = Artistic = Brush Strokes = Sprayed Strokes kal puBuioTe
Stroke Length: 20 Spray Radius: 25. EmA&ETe Tnv ekdva ToL Layer «ai
epappooTe Blending Options Inner Shadow yia va &coete TNV dicBnon Tov

TPICSIACTATOL XWPEOUL.
Polaroid

AvoI€Te TNV eikdva 'SummerFruits.jog' emAé€Te TO Rectangle Tool kal ye dompo
YEUIOUA SNUIOLEYNOTE Eva 0POOYWVIO OXNHA. ANUIOLEYNOTE Eva AVTiYPAPO
Layer tov Background Layer kal petagépate 1o AV amd To Layer Tou
OXAUATOC TTOL SnuIoLPYAHCATE. ATTO TO PevoL Edit = Free Transform pikpOveTe
QPKETA TO VEO Layer Kal UETAKIVAOTE TO £TO1 WOTE VA €ival TTAVGR atrd TO OXHUa.
ATTEVEQYOTTOINOTE TIPOCWPEIVA ALTO TO Layer (kAeioTe To paT), emAEETe TO Layer
TOL OXAUATOG KAl hye TO Rectangular Marquee emAEETe pia TTEpIOXN TTAVG OTO
oxnuUa. EvepyotroinoTe kal TTAAI TO TTponyoLHEVO Layer kal dnuiovpynoTe pia
pAoKa pe KAIK oTo Add Layer Mask oTo KATW PEPOG TNG KAPTEAAG TwV Layers.
EmAEETE TOOO TO TPEXOV Layer 6Co kal TO Layer Tou OXAUATOS KAl TTNYCIiVETE
oTo hevoL Layer = Smart Objects & Convert to Smart Object. EpapudoTe yia
1a Layers Blending Options Drop Shadow kaAvoviag TG ELBJICEIC TToL
meoTiudTe. Ta Vo Layers Twpa eival cuvdedepeva, SOKINAOTE Va TA UIKQUVETE,
va TA TTEPICTPEWETE KAI VA TA KIVAOETE OTO XWPO. KAvTe KAIK TTAV® OTNV EIKOVA
ToL Layer avtiypdgou ToL Background kal amd TO HevoL Image

> Adjustments 2 Variations aAAGETE TOLS XPWHATIKOLS TOVOLGS TNG EKOVAG.
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Warp Frames

Avoifte Tnv ekova 'WeddingCouple.jog' kal e 1O gpyaieio Rectangular
Marguee emAEETE pia TTEQIOXA TNG EIKOVAG. ATTO TO pEVOL Layer = New... 2
Layer Via Copy &nuiovpynoTte éva véo Layer. Me emAeypévo 10 vEo Layer
Tnyaivete oto pevoL Edit = Stoke kal puvBuioTte Width: 8 px Color: aompo
Location: Inside Mode: Normal Opaciry: 100%. EpapuooTe oo Layer 1o Layer
Style Drop Shadow pe puvBuiceic Blend Mode: Multiply Opacity: 89 Angle: 120
Distance: 5 px Spread: 0% Size: 8 px. Ao 10 Yevouw Edit = Transform = Warp
SwoTe pia okéPpwon oTto Layer. AKOAOLOWVTAG TA TIPONYOLUEVA PAUATA
ETMAEETE OOEC TTEPIOXEG OEAETE. APOU EXETE SNUIOLPYNOEI OAEG TIG ETTIAOYEG TTOL
O¢AeTe, TTNYQiveTe EMAEETE TO Layer TNG APXIKAC EIKOVAG Kal TTNydiveTe Images =
Adjustments = Desaturate, oTn ouvéxela Images =  Adjustments =

Brightness/Contrast kai yeicooTe 1o Confrast -50.
Broken Image

AvoifTte TNV eikOva ‘Santorinijpg’. ZeKAEISWOTE TNV €KOVA e SITTAO KAIK OTO
Layer TNG. AnuIoLPYNOTE £va vEO Kevo Layer kal yepioTe To Je AOTIPO XOWHA N
OTTOI0 AAAO BEAETE KAl TOTTOBETAOTE TO KATW ATTO TO Layer TNG elkOvag. EmAEETe
1O Layer TG eikdvag kal amo 1o pevoL Layer Style = Drop Shadow puBuioTe
| Blend Mode: Multiply Opacity: 76 Angle: 30 Distance: 4 px Spread: 0% Size: 4
px. Emiong, amo 1o hevoL kal atrd 1o hevoL Layer Style = Stroke puBuioTe Size:
3 px Position: Inside Blending Mode: Normal Opacity: 100%. AnuiovpynoTe pia
pAokKa Je KAIK oto Add Layer Mask oTo kAT PELOG TNG KAPTEADG TV Layers
KAl YEUIOTE TN PE HAVPO XPWHA. Mg eTTAEYUEVN TNV UAOKA eTTAEETE TO Brush Tool
HE TETPAYWVO TIIVEAO peyEéBoug Trepittov 300 pixels kal AOTIPO XPWUA OTO
Foreground Color. EugavioTe TNV KapTéAa Brush (Eikdva 76) kal KAvTe TIG SIKEG
oag PLOUIoES YIa TO TIIVEAD. AQOU &xeTe PLOWICEN TO TTIVEAO WTTOPEITE va

apxioete va PApeTe TNV HACKA.
Create puzzles

ITO TTapddelypa Ta oxAUata (puzzles) eival TeTpdywva, €0€ic PTTopeite va
Swoete OTOI0 OXAUA BéAeTe. Avoilte TNV eikdva 'Squirrel.jpg’, amd 10 pevouw
Image =2 Image Size... eAéyEte TIC SlIaocTACEIC TNG £KOVAC. ATTO TO Hevou File =
New... SnuiovpynoTe Wia veéa eikova pe 50 pixels TeplocoTepa o€ KAOE TTAELPA
amd 11¢ SlaoTAoEg TNG ekovag 'Squirrel.jpg’ kal ye dompo eovTo. Me To Move
Tool oVpeTe TNV elkOva 'Squirrel.jog' TAVW OTNY VEA €KOVA TTOL SNUICLEYNOTE,
TTAEoV LTTAPYoLv SVvo Layers. Eugaviote 10 Xdpaka View => Rulers kai

SnuiovpynoTte odnyoLg View > New Guide... TommoBethote TO SeikTn TOL
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TTOVTIKIOD OTOULG XAPAKEG KAl UE TTATNUEVO TO APICTELO TIANKTPO CLPETE KAl
TOTTOOETNOTE €Kei TTOL BEAETE TOLSC 06NYOoLGS. ETAEETE TO Rectalngular Selection
Tool kal pe emAeypyévo 10 Layer TNG ekOvVAC SNUIOLPYNOTE ETTIAOYEG HE TN
ponBeia Tv obénywv. TMNa To kABe TETPAYWVO 1 0OpPBOYWVIO TIoL
SNUIOLPYNOCATE PE TOLG OSNYOLC SNUIOLPYNOTE KAl ATTd £va véo Layer amd 1o
pevoL Layer = New... = Layer Via Copy. EmAé€Te TO TPTO Layer amd 10
TeTPAYWvVA Kal armd 1o hevoL Layer Style =& Drop Shadow puBuioTe Blend
Mode: Multiply Opacity: 69 Angle: 120 Distance: 7 px Spread: 16% Size: 5 px.
Emmiong, amo 10 pevoL kal amd 1o pevoL Layer Style = Stroke puBuioTe Size: 3
px Position: Inside Blending Mode: Normal Opacity: 100% Fill Type: Color:
aompo. Me 8¢ kAKK émmeita oTo Tpéxov Layer emAé€Te Copy Layer Stylekal pe
5¢e€i KANIK oTa LTTOAOITTA Layers e Ta TeTpaywva emAEETe Paste Layer Style.
KAeioTe TO pdm SimAa amd 1o Layer TnG apXIKAG £KOVAG (QTTEVEQYOTTOINCTE TN),
EMAEETE va U gaivovTtal Rulers kal Guides kal ye Edit & Transform = Rotate
TTEPIOTPEWTE TA Layers. EAv BEAETE UTTOPEITE VA TTAPEUPETE AKOUN TTEQICTOTEPO
OTO ATTOTEAEOUA AAAAZoVTAG Kal TTAAI TIG pLvBuicelg ota Blanding Options Tawv

Layers.
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MEPOG TOL LAIKOV TTOL XENCILOTTOINGNKE YIA TNV TTAPAYWY ALTWY TWV
ONUEIDTEIC TIDOEPXETAI ATTO TIC AKOAOLOEC SIASIKTOAKES TTNYEC KAl eVEEXETAI va
DTTOKEITAI O€ TTEQLIOPICUEVA SIKAIOHATA XPNoNG. H xonon Tou v Aoy LAIKOD

EMTOETTETAI UOVO YIA EKTTAISELTIKOVG TKOTTOUG.

- KaAétoou Evtuyia
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